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Declaration of Conformity

Manufacturer’s Name: Fractal Audio Systems, LLC
Manufacturer's Address: 4 Wilder Drive, Plaistow, NH 03865 USA

Declares that the product:
Product name: Axe-Fx Il Product option: None

Conforms to the following Product Specifications:

Safety: EN60065:2014
EMC: EN55013:2013
EN55020:2007+A11:2011
EN55024:2010
EN61000-3-2:2014
EN61000-3-3:2013

Supplementary Information:
The product herewith complies with the requirements of
the Low Voltage Directive 2006/95/EC
and the EMC Directive 2004/108/EC.

Clifford Chase
President / CEQ
January 22, 2018

EMC/EMI

This equipment has been tested and found to comply with the limits for a Class B Digital device, pursuant
to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in residential installations. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. There is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

4
4
4

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.
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Legal Notices

Fractal Audio Systems Axe-Fx Ill Owner’s Manual. Contents Copyright © 2021. All Rights Reserved.
No part of this publication may be reproduced in any form without the express written permission of Fractal Audio Systems.

Fractal Audio, the Fractal Audio Systems logo, Axe-Fx, Humbuster, UltraRes, FullRes, FASLINK are trademarks of Fractal Audio
Systems. Manufacturer names and product names mentioned herein are trademarks or registered trademarks of their respective
owners, which are in no way associated with or affiliated with Fractal Audio Systems, LLC. The names are used only to illustrate sonic
and performance characteristics.

mportant Safety Instructions

WARNING: To reduce the risk of fire or electric shock, do not expose this
appliance to rain or moisture.

CAUTION: To reduce the risk of fire or electric shock, do not remove screws.
There are no user serviceable parts inside. Refer servicing to qualified service
personnel.

Obey all warnings on the Axe-Fx Il chassis and in this User Guide.

Keep away from sources of heat such as ducts, registers or appliances that produce heat.
Connect only to a standard grounded AC outlet of 100-240V, 47-63 Hz.

Keep the power cord in good condition. Do not kink, bend, or pinch.

If the cord becomes damaged, discard and replace it.

If not using your Axe-Fx Ill for extended periods of time, disconnect from AC power.
Protect the unit from rain and excessive moisture.

Refer servicing to qualified personnel only.

Stop operation of the unit and obtain service if:

- Liquids or excessive moisture enter the unit.

- The unit operates incorrectly or performance is inconsistent or erratic.

- The unit has been dropped and/or the enclosure damaged.

10. Prolonged exposure to high volume levels can cause hearing damage and/or loss. The use of
hearing protection in high volume situations is recommended.

WO NoaRrwN =

A Manual for Online and Print Use

This manual is intended for use in desktop, tablet, and smart phone readers. It includes clickable links and bookmarks to make
navigation and cross-reference easy. We generally recommend against printing, because firmware updates tend to make older
manual versions out of date. That said, considerations have been taken for those who prefer paper. You are granted permission
to print this PDF for personal use only. A copy center or online printer can print and bind a book for you from the PDF file.
Hopefully those with screen readers can forgive the changes made herein to accommodate the print version: all links also
include a page or section numbers, page spreads have extra margins towards the binding edge, and blank pages have been
included to preserve page and chapter flow.



1 INTRODUCTION

1 INTRODUCTION
WELCOME TO THE AXE-FX III

The Axe-Fx Il is the current flagship product in our long line of industry-leading guitar processors, and the world’s
most powerful unit of its kind, with significantly more raw power than anything we've offered before. Our vision for
this platform was to create a product that sounds better, does more, and is easier to use than ever before, with all
of the best and room for more. It features our newest “Cygnus” amp modeling technology, UltraRes™ and FullRes™
speaker cab simulations, our legendary effect algorithms, and much more.

Fractal Audio Systems is known for accurate amp models with the sound and feel of real tube amps. The

Axe-Fx Ill carries this torch high. “Cygnus” picks up where “Ares” left off, with improvements and upgrades to the
accuracy, sound, and feel. Some may ask: “how can it still be getting better after all these years?” We maintain
that there is always room for improvement and innovation and submit the Axe-Fx Ill as proof.

The hardware has been completely re-designed around a streamlined workflow. The centerpiece is a dazzling
high-contrast full-color display with 30x the resolution of previous products. This display works alongside five
endless-rotary push encoders (“push-knobs”). These do different things on different pages, with labels to show
dynamic functions. The end result is a user experience that's immediately more intuitive. The display also excels
at animation for meters, modifiers, and more.

Power and resources are vastly expanded. Two 1-GHz “Keystone” DSPs benchmark at 2.8x the power of the Axe-
Fx II, and there are two additional processors dedicated to graphics and USB. Peripherals include 4Gb of blazing
fast PC1600 DDR3 memory, hundreds of Mb of FLASH memory, a proprietary FPGA and more. The number of
inputs and outputs has more than doubled in comparison to previous products. Routing capabilities have also
been upgraded with dedicated blocks for each Input and Output allowing for highly flexible preset and rig design.
All 1/4" outputs feature our Humbuster™ technology to help reduce the noise caused by ground loops.

Better sound quality has been achieved through an audiophile-grade signal path. The difference is heard as a
lower noise floor, pristine clarity, and USB audio performance that’s even better than most dedicated pro audio
interfaces. As a 24-bit/48k 8x8 interface, the Axe-Fx Il allows you to record multiple tracks of processed audio
at the same time, plus a DI. You can playback computer backing tracks or process incoming signals from the
computer. The re-amping workflow is improved with independent monitoring of backing tracks and re-processed
guitar tones while you dial in a sound.

Physically, the Axe-Fx Ill combines extraordinary design with manufacturing quality rugged enough to withstand
the rigors of life on the road. The unit is housed in a steel enclosure with a one-piece anodized aluminum
faceplate/bezel featuring a glowing Axe-Fx Il logo.

Axe-Edit™ Il1, a fully re-tooled version of our editor for Mac or PC, is packed with great new features including
Quickbuild mode, a Scene Manager, and window scaling on monitors up to 5k and beyond.

Of course the unit features upgradeable firmware, meaning we can offer new features and fixes through free
firmware updates—something that our customers greatly enjoy.

This manual also covers the “Mark 11" version of the Axe-Fx Ill, introduced in 2020.

We hope you will enjoy using the Axe-Fx Il as much as we've enjoyed creating (and playing) it.
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FEATURE SUMMARY

=  Rugged 3U steel chassis with a sleek anodized
aluminum front panel and illuminated “Axe-Fx llI”
logo. On the Axe-Fx Il Mark 11, the logo can color
cycle, or you can choose your own color.

= Two 1.25 GHz (“Turbo”) or two 1.0 GHz
(“Standard”) Keystone DSPs benchmark
at 2.8x the power of the Axe-Fx II.

= 4Gb blazing fast PC1600 DDR3 memory, hundreds
of Mb of FLASH memory, proprietary FPGA.

= Dedicated processors for graphics and USB.

=  VALUE knob optical encoder lifespan
rated for 1,000,000+ rotations.

= Audiophile-quality signal path yields superior sound quality

and a far lower noise floor and THD than previous products.

= Auto-switching front/rear instrument
inputs, both with “Secret Sauce IV".

= Three stereo inputs: 1 with XLR/1/4" combo
jacks, two with balanced 1/4" inputs.

=  Four stereo outputs: one pair with XLR outs, one pair with
both XLR and 1/4" outs, and two pairs with 1/4" outs.

= Humbuster technology on all 1/4" outputs
helps reduce ground loop noise.

= Front panel headphones output.
=  Front panel LED meter bridge for instant visibility of levels.
=  Easy-to-use interface allows intuitive and efficient editing.

= Stunning color display with 30x the resolution of previous
products. On the Axe-Fx Il Mark Il the display is improved
even further, with enhanced clarity, color, and contrast.

=  Animated on-screen metering for every
block, input, output, and more.

= 5 soft-knobs with on-screen labels
for turn and push functions.

= 512 Preset memories (1024 on the Mark I1), each
an entire rig with amp(s), cab(s) and effects.

= 14x6 grid layout allows larger presets
than Axe-Fx I, AX8, FX8, and FM3.

=  New “Zoom" view shows the entire grid on one page.

= 8 nameable “Scenes” per preset store
settings like “presets within a preset”.

= Revolutionary new “Channels” concept for fast,
seamless switching of up to four channels per block.

=  Built-in tools to copy Channels and Scenes within a preset.

=  Hundreds of accurate amp models with real tube
amp sound and equally-important feel.

= New Cabinet block features a “Cab-Lab” style
multichannel mixer to load up to four IRs at once.

= 2,048 Factory cabs, 189 “Legacy” Cabs (from Axe-Fx
1), 2,048 User Cabs and 16 Scratchpad memories.

Factory IRs by Fractal Audio and the
best of 3rd party creators.

Presets can now contain up to four instances
of Compressor, Drive, and Delay blocks.

New blocks: Plex Delay, Ten-Tap Delay,
Multiplexer, Realtime Analyzer and more.

Effect “Types” create classic sounds at the
turn of a knob. Types include 40+ drives, 50+
reverbs, 30+ delays, and many more.

New effect models include analog Tri-stereo Chorus,
deep modeled Phaser and Flanger blocks.

Improved Reverb is even richer and smoother than ever.
Improved Pitch block with faster detection and tracking.
New fully parametric “Input EQ” in Amp block.

Fully revamped 5.8 minute stereo Looper with undo.
Tone Matching to clone any tone, now in UltraRes.

Built-in IR Capture Utility allows you to
create your own speaker cab IRs.

New Input and Output blocks make
routing more flexible than ever.

Improved and faster Tuner featuring a new interface.

8x8 USB Audio with better audio performance
than most dedicated pro audio interfaces.

Dedicated USB Input block for reamping/processing tracks.

MIDI-over-USB between Axe-Fx Ill and a computer is
10x faster than the same connection on Axe-Fx II.

MIDI IN, OUT and THRU ports.
Rich MIDI implementation allows extensive remote control.

The new “Scene MIDI” block enables each scene to
transmit up to 8 PC/CC messages when loaded.

Optional MIDI PC/Bank transmission
when a new preset is loaded.

Two on-board PEDAL jacks for expression
pedals like the Fractal Audio EV-1 and EV-2.

FASLINK 2 connector for connecting up to four of
our next-gen Foot Controllers, FC-6 and FC-12.

Daisy-chain FC series foot controllers for more pedal
board “real estate” or to allow player and tech to share
switching responsibilities on “cloned” systems.

Future proof: as ever, fully upgradeable firmware means
the Axe-Fx Il has the capability for free updates.

Built-in backup firmware allows recovery in the
event of complications during update.

And much more.
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THE SETUP MENU

Throughout this manual, you will be directed to the Setup menu, which includes the following sections:

= The FC Controllers menu includes all settings for a connected FC Series controller.
= The Global Settings menu includes options which govern the overall behavior of the Axe-Fx Il

= The I/0 menu contains settings for inputs and outputs, levels, audio, USB, and switches or expression
pedals connected directly to the Axe-Fx lII.

= The IR Capture utility can be used to create your own “User Cab” impulse responses.

= The MIDI/Remote menu contains MIDI settings, plus several pages of assignments for the many
remote-controllable functions of the Axe-Fx Ill.

= The Utilities menu contains informative readouts plus a control to adjust screen brightness, and
tools to reset or erase the Axe-Fx lII.

To access the Setup menu:

»
»
»
»
»
»

Press HOME.

Push the “E” knob for the SETUP main menu.

Use the NAV buttons or “A” knob to select a sub-menu and press ENTER to make a selection.

Use PAGE and NAV buttons to get around the menus. Use VALUE and knobs A-E to make changes.
Press HOME at any time to return home.

NOTE: Changes in the SETUP take effect immediately and never need to be stored

Use these links for instant access to the Setup menu topics in this manual:

SETUP
FC Controllers Section 13
—— Global Settings Page 69
—— 1/0 Page 71
— IR Capture Section 14
—— MIDI/Remote Page 75
— Utilities Page 80
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QUICK CONNECT GUIDE

The most popular and flexible way to enjoy the Axe-Fx Il is through a full-range system such as studio monitors,
a high-quality PA, or full-range cabinets designed specifically for guitar. All of the factory presets are designed
for this type of setup.

Of course you can use the unit in many other types of setups, including those which integrate with tube amps,
USB recording, guitar speakers, 3rd-party outboard equipment, and more. You can find over ten examples in
Section 4 of this manual.

Basic setup instructions for a typical direct/full-range rig appear below:

0 Begin with all level knobs turned down.
Connect your guitar to the front or
rear Instrument input (Input 1).

OuUTPUT 1

3L IO

BALANCED

The Axe-Fx Ill is also perfect for
bass and other instruments.

—— HUMBUSTER™ ——

OUTPUT
1

0 Connect Output 1 to your mixer, studio
monitors, audio interface, PA system, full-
range speakers, power amp inputs, etc.

« Foramono rig, use Out 1 Left.

Use Add

*  For stereo, also connect Out 1 Right. Out1L l l Out1R
for for

+  Use XLR outputs to connect to balanced Mono Stereo

inputs, or use the 1/4" outputs when

connecting to unbalanced inputs.
*  Use Humbuster cables with 1/4" outputs
to reduce hum from ground loops.

9 Turn up the front panel OUT 1 knob and adjust the
level on your monitors as desired.

Explore factory presets by turning the VALUE wheel.

Select Scenes within a preset by using NAV Up/Down. FRFR speakers, Studio Monitors
Audio Interface or Mixer

FAQ: WHY FULL RANGE?

A Full-Range Flat Response (“FRFR”) system aims to reproduce the entire audio spectrum without any tonal
coloration. In comparison, most traditional guitar speakers are sonically limited, with tonal coloration and
limited low and high response. Each speaker cabinet has its own effect on your sound, and a 1x12 open-back
combo is never going to sound like a 4x12 stack. In comparison, full-range flat-response studio monitors,
PA speakers, and FRFR speakers designed specifically for guitar are designed to reproduce anything you play
through them. The output of a fully modeled signal path is in fact closer to what you'd hear in a finished mix
or recording, so it sounds best when played through a system that is designed for full range. Of course, many
other setup types exist, as demonstrated in the many examples shown in Section 4 of this manual.

4
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SETTING LEVELS

Setting proper levels is critical but easy, with many meters to help you while you work.

INPUT LEVELS

The Axe-Fx Il comes ready-to-use for the typical guitar or bass, but you
should check that your guitar is not clipping the inputs.

Connect a guitar to the Instrument input. Choose your loudest pickup setting and set all the guitar
controls to “wide open.” Play loudly to push the levels as you watch the front panel INPUT 1 meter
LEDs. A red LED on the input meter indicates a level of -6dB, which is still safely below clipping. Adjust
the input trim so your loudest playing “tickles the red.” It is of course also fine if a lower output guitar
never hits the red. In general, you should set input levels as high as possible without clipping:

» Open SETUP : 1/0 : Input page.
» Adjust Input 1/Instrument input levels using the A knob.

Inputs 2, 3 and 4 can be adjusted using the same method. Each has its own Input trim parameter on the
Input page of the 1/0 menu under SETUP.

You can also monitor levels on the Meters page of the Home menu.

Except at the very lowest settings, Input level adjustments do not affect gain levels. As you adjust
the input level to the A/D converter, the output is compensated accordingly, so what you hear is not
affected by how you set these controls.

OUTPUT LEVELS - o S

Output levels are very easy to monitor on the front - '
panel meters, and easy to control using the four front
panel LEVEL knobs. You can also monitor output levels I - I I I I l

in higher resolution by paging to the Meters page from
..
AYTLIT Mk FES

the Home menu.
The Meters page of the Home menu shows all I/0 levels.

Outputs 1-2 are ready to be connected to consumer
line inputs (-10 dbV). If you are connecting to
professional-grade equipment operating at +4dBu, set
the nominal output levels as follows:

» Page to SETUP :1/0 : Audio.

» Adjust Output 1: Output Level or
Output 2: Output Level to +4dBu.

RES0A%

Learn more about the I/0 Menu on p. 71.

If you notice the Outputs clipping, this means your
presets are too hot. Section 7 on p. 49 is

dedicated to the important subject of adjusting preset
levels.

The Layout also has a Meters view showing block levels.
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HUMBUSTER™ CABLES

Most FRFR setups use the XLR outputs of the Axe-Fx Ill into the balanced inputs of mixers, monitors, and other
devices. For these applications, XLR cables or XLR-to-TRS cables are typical.

When connecting the 1/4” outputs of the Axe-Fx Il to unbalanced 1/4" inputs on other devices, you can use
standard 1/4" patch cables, but there is a better option. Humbuster™ technology on all 1/4" outputs of the Axe-Fx
1l can significantly reduce unwanted noise due to the common problem of a ground loop. For this to work, you
must use a special Humbuster cable. This has one TRS end (like a balanced cable) and one TS end (like a guitar
cable). The TRS end connects to the Axe-Fx IIl. The TS end connects to your other device or amp.

Humbuster cables are available from http:/www.fractalaudio.com/cables. You can make your own by following
the diagram below. Be sure to use high-quality connectors and shielded cable.

TIP SLEEVE TR T SLEEVE TIP
|

||| = O.I |

RING S S

MONO VS. STEREO

9 The Axe-Fx Ill comes pre-configured for stereo but you can connect it in mono with no issues.

W

In mono, however, you may find that certain presets or settings produce unexpected results.
For example, a panner sounds like a tremolo when one channel is missing. A ping-pong delay
may “ping” but never “pong”. Stereo enhancers or certain types of modulation may not be
apparent at all. Even the tone can change if amps or cabs have been panned. Here is an
overview of several scenarios, with recommended settings for each.

» STEREO: No special settings required.

» HALF STEREO: Leaving the Axe-Fx IIl in its default stereo configuration but connecting
only one (Left) output results in “half-stereo.” This setup works fine, aside from the
exceptions mentioned above (ping-pong, panning, etc). No special settings required.

» MONO, COPY L>R: Sonically, this is identical to half-stereo, with the same limitations, except that
mono signal is produced at both the left and right jacks so you can connect to two monitors. To
switch to dual mono, open SETUP: 1/0: Audio and set Mode for the desired output to “COPY L->R".

» MONO, SUM L+R: In this setup, left and right channels are added together resulting in a mono
signal at both left and right outputs of the Axe-Fx IIl. While this does not discard half of the
channels like half-stereo does, summing has its own issues. For example, short delays or
phase differences between channels can result in strange artifacts or cancellation. To switch
to summed mono, open SETUP: 1/0: Audio and set Mode for the desired output to “SUM L+R".

On the Axe-Fx IlI, a flexible block-based 1/0 system makes it easy to use different outputs with different
settings for different purposes. See Input and Output blocks in the “Blocks Guide”.

All options of the 1/0 menu under SETUP are detailed in Section 12.


http://www.fractalaudio.com/cables
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THE HOME PAGE: PRESETS

Once you have connected your Axe-Fx Il you can begin to audition factory preset sounds. Remember that aside
from a few templates, the factory presets are designed for use with full-range speakers, monitors, or headphones.
See Section 4 for details on creating presets for other setups.

The Axe-Fx Ill contains 512 preset memories (1024 on the Mark 1), each a fully independent rig with its own
amps, cabs, effects, settings, controllers, and more. When you consider everything that is possible with Scenes
and Channels, a single preset can easily cover an entire song, or even a whole show.

Here’s how to explore the factory presets: Previous Scene

» Press HOME to show the Home page, —
where you can switch presets.

» To change presets, turn the VALUE knob .
or use the NAV left/right buttons. Previous NAV p Next

» Many factory presets contain fully developed Scenes. Preset Preset
You can switch Scenes using NAV up/down or knob A.
See p. 9 for an introduction to Scenes.

v
Next Scene

OTHER HOME MENU FUNCTIONS

» The push functions of
the five knobs of the hme page provide access to other areas:
* Tuner (Page 67)

» Layout grid (Page 8 and Page 34)
= Controllers (Page 59)

= FC Per Preset (See Section 13: FC Controllers).

= Setup (Page 3 and Page 69).
» A mini-Tuner appears at the top of the Home page itself.

THE PRESETS DIRECTORY

» You can also access a PRESETS directory:

» From the Home page, press PAGE RIGHT until the Presets page is shown.

= Presets are shown in numerical order. To sort presets alphabetically by name, press the “Sort A-Z" button.
= Use the VALUE wheel and NAV buttons to select any entry.
= The ENTER key loads the selected preset and returns to the Home page
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INTRO TO THE LAYOUT GRID

In the world of traditional gear, our options are limited by budget, space, weight, and the limits of the gear itself.
Building a rig means making hard choices. With the Axe-Fx Ill however, a limited selection of gear is instead
replaced by a vast (ever-growing!) “inventory” of virtual amps, cabs, effects, and more. Every preset gives you the
flexibility to design a totally new rig composed of whichever components you choose.

Let's learn the vocabulary of preset creation. To create a preset, virtual pieces of gear are selected from the
inventory and placed as blocks into the slots of the layout grid, a structure of rows and columns. Each block
represents a different component like a wah pedal, amp, reverb, etc. Blocks are connected together using virtual
cables, and you can create splits, merges or multiple parallel paths as needed. Passive shunts carry signal
through empty grid spaces. Special input and output blocks connect to the various jacks and USB signals of the
Axe-Fx . The following graphic illustrates these concepts:

OOO
Q@

Passed
REV 3 ouT1)] toOUT1 :
Jacks

:' ............................................ The Layout Grid ............................................ :

Let’s review what is happening above. Various blocks have been placed on the grid and connected with cables.
Signal flow begins at the Input block on the left. It then goes to a Wah block. The wah connects to a shunt, which
has no effect on the sound and is shown only to introduce the idea of how it carries signal from one location to
another. The shunt is connected to an Amp block (we might set its type to “Plexi T00W High"), which in turn feeds
a Cab (one of the many “4x12" options, perhaps). This is connected to a Reverb and then to an Output block. In
this limited example, only a few blocks are shown on a partial grid. In reality the size of a preset is limited only by
the grid structure, block inventory, and total processing power (“CPU"). You will find that you can create very large
virtual rigs with multiple amps, cabs, and effects.

@ A new “ZOOM” feature shows the whole grid at once. Look for the ZOOM button on Layout menu pages.

8
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INTRO TO SCENES AND CHANNELS

Imagine a rack system like those used by many guitar players over the past decades. In this system, various
amps, pedals, and rack units are connected through a central switching system, which places components in or
out of the signal path at will. Some componenets in a rig like this have their own settings that the switcher can
control remotely—like the channels on an amp, or the different settings of a delay. Using the switcher, you set up
different combinations gear and settings and then save a preset: Clean, Rhythm, Lead, etc. (Yes, this old rig does
all this and weighs just a few hundred pounds!)

A single Axe-Fx Il preset is comparable to an entire rig. Axe-Fx Scenes, are an innovation something like a
switching system. A Scene stores whether each block is engaged or bypassed, and which of up to four “channels
it should be on. A Channel is like a preset within a block; each block has up to four channels, and every channel
its own fully independent settings. For example, Channel A of a Drive block might be a “clean boost”, B could be a
“screamer”, C a distortion, and D a fuzz. So, with channels, you get four different sounds from just one block! By
switching blocks and channels for you, Scenes offer a way to select different sounds without changing presets.

”

Scenes offer many advantages. First, they eliminate “tap dancing” and make complex sound changes easy. Also,
scene changes are fast and can even be perfectly seamless. Scenes also make it easy to set up delay and reverb
for “spillover” so tails can ring out across changes. Scenes even have their own names, which is especially helpful
as you step through them.

SCENES AND CHANNELS: A VISUAL EXAMPLE

[ IN 1 —cMP{A—{DRV [A—{AMP[;}—{CAB [s}—{CHO[s}—{bLY [s}—{ouT 1]

Here is our preset. The Input 1 block feeds a Compressor followed by a Drive, then into an Amp and Cab,
followed by Chorus and a little Delay, ending up at the Output 1 block.

[ IN1 —{eMP[i— v —{aMP[i—{cAB [{—{cHoli—

SCENE 1 - “Clean”: For scene 1, the Drive and Delay blocks are bypassed. We dial in the Compressor, Amp,
Cab, and Chorus for a classic clean tone. Notice that the amp says “1A”. This means we are using Amp 1, set
to channel A. Let's imagine it as the “ODS-100 Clean” model. We name the scene “Clean”.

—{DRV [{H—AMP[E—{cAB [J—H0| — 0UT1

SCENE 2 - “Crunch”: To create scene 2, we bypass the Compressor, Chorus and Delay and engage the Drive.
The Amp block is changed from channel A to channel B, which we dial in as a “Euro Blue” crunch model.
Remember, each channel has a totally independent set of settings, so every amp parameter exactly as we wish
for this scene: Drive, Treble, Mid, Bass, and many, many more. We then dial in Channel “A” of the drive block
with a good “screamer” sound by selecting the “TS808 OD” type. Let's name this scene “Crunch”.

[ IN1 —cmpPE—{pRrv[iAMP[E—{cAB i —{oy |i—out 1]

SCENE 3 - “Lead”: Here's our soaring lead. The Chorus is bypassed. We've changed the compressor to
Channel “B” and dialed it in for sustain. The amp is the same as the “Crunch” scene but Drive changes to “B”,
which we'll make a “Fat Rat”. The Delay is on channel “B” dialed in with higher mix and feedback. We name the
scene “Lead”.

Learn more in “Scenes & Channels” on p. 43




1 INTRODUCTION

GRID EDITING: QUICK START

Learn more about working with the grid in Section 5. Meanwhile, here’s a very quick primer:
» From the Home page, press LAYOUT (knob B) or ENTER to show the “Edit”

page of the Layout menu, commonly called the “grid”.
» Use the NAV buttons to move the cursor around the grid.

» Turn the VALUE knob to cycle through the inventory of blocks at any grid location. When
you find the block you want, press ENTER to confirm. Press EXIT to cancel changes.

» On the grid, “push” functions of the B, C, and D knobs allow you to toggle a block’s Bypass state,
Delete a block, or create/remove a connector Cable between any two blocks in adjacent columns.

» To save any changes, press STORE, ENTER, ENTER.

BLOCK EDITING: QUICK START

Learn more about editing blocks in Section 5. Meanwhile, here’s a very quick primer:

» On the grid, select the desired block and press EDIT to open its menu.
» Use the PAGE buttons to navigate menu pages.

» Many blocks have a TYPE page, which allows you to dial in classic settings instantly. Examples
include setting an amp to “USA Lead+”", a drive to “Face Fuzz", or a reverb to “Large Spring”.

» Usethe A, B, C, D, and Eknobs to edit on-screen parameters. From
any block’s Edit menu, press EXIT to return to the grid.

» To save any changes, press STORE, ENTER, ENTER.
» The stylized diagram below shows a typical edit menu page with annotations:

Block Name and Number Menu Pages (Tabs) I/0 Meters
Block Type Current Scene/Channel Tuner :
Drive 1 § Type (Ba.sic} Expert : Mix Al
Current 7808 0D Scene:1 ' Channel: A — =
Parameter
Value BOX ................................................ C ........................ 5.[]0 )
Current
Parameter -oooofeeeeeeiinns @ @ @ @ Yellow ring/dot
Highlighted : O S shows Modifier
Drive Tone Mix Level capability
Inactive Row
is dimmed ...................
(NAV Up/Down
to change rows)
Push Functions -.....|C cHANNEL - ) ( CHANNEL + ) (_ BYPASS ) (_ RESET ) (_ MODIFIER )

(A-E)

These change Bypass or Resets Adds a Modifer

the Channel Engage this this Block to to the current
of the block block defaults parameter
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1 INTRODUCTION

USB OVERVIEW

USB provides the Axe-Fx Il with a host of great features. A 16-core, 500 MHz microcontroller provides 16
channels of flawless 48kHz USB audio (8 in, 8 out) allowing the Axe-Fx Ill to be the center of your music
workstation. The audiophile-grade signal path components and converters provide better audio performance than
most dedicated USB audio interfaces. With 8x8 channels you can record multiple tracks of processed audio and
DI signals, monitor backing tracks, audition stereo re-amps in real-time, and more. A USB audio sound source can
even be placed on the grid for processing via the dedicated USB Input block.

USB is also required to use Axe-Edit and Fractal-Bot, the companion software products for the Axe-Fx Ill.
See Section 3: USB, on p. 19 for full details on the USB capabilities of the Axe-Fx Ill.

FRACTAL-BOT & AXE-EDIT Il

In addition to providing audio and MIDI capabilities, connecting the
Axe-Fx Ill to a computer via USB allows you to use companion software
applications Fractal-Bot and Axe-Edit IlI.

Fractal-Bot is a small, simple program used to update the Axe-Fx Ill when
new firmware is released. It includes tools to backup or restore presets
and other custom settings, and can be used to install downloaded presets
or cabs.

Axe-Edit Il is a full-featured software editor/librarian for the Axe-Fx IlI
and FC Controllers. If you are comfortable with audio software or plug-
ins, you will probably enjoy using this program to work with the Axe-Fx
ll. While the Axe-Fx Ill can certainly be operated from the unit's front panel, Axe-Edit Il brings a new level of
convenience, including some “power-user” routines that aren’t possible on the unit itself (e.g. Block Library, Scene
Swap, Performance Control pages, etc.). It also provides tools for managing presets and banks, installing Cab
Packs, and more.

You can download Axe-Edit lll for Mac or Windows at http://www.fractalaudio.com.
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1 INTRODUCTION

CONNECTING PEDALS DIRECTLY

This section is for pedals connected to the local “Expression” jacks of the Axe-Fx Ill.
For pedals connected to a MIDI or FC Series controller, see the next page.

Each of the two local Expression jacks of the Axe-Fx Il allows you to connect one expression pedal or one
external footswitch. A connected pedal or switch can change effect parameters, or operate any of a long list of
global functions. Many factory presets are ready for use with one or more pedals.

TO CONNECT & CALIBRATE AN EXPRESSION PEDAL...

Expression pedals for the Axe-Fx Ill should have a linear resistance taper and must have a maximum resistance in
the range of 10-100kQ. Expression pedals must be used with Tip-Ring-Sleeve (TRS) cables!

Connect your expression pedal to the desired jack with a TRS cable, then follow these instructions to calibrate:
» Page to the Pedal page of the I/0 menu under SETUP.

» Ensure that Pedal Type is set to “CONTINUOUS".

» Navigate to the Calibrate Pedal function and press the ENTER button.

» Follow the on-screen instructions to perform calibration.

TO CONNECT A SWITCH...

Follow the instructions above and simply set Type to “MOMENTARY" or “LATCHING" based on what you're
connecting. (If you're not sure, check with the switch manufacturer or try both settings to see which works better.)
Calibration is not required. You can use a normal guitar cable (TS) for switches. Only ONE switch can be used at
each pf the pedal jacks.

THE EV-SERIES EXPRESSION PEDAL

The Fractal Audio Systems EV series of expression pedals are perfect for use with all Fractal Audio Systems
products. The EV-1 is a full-sized expression pedal. The EV-2 is a compact version. These pedals feature rugged
cast metal casings, a high quality 100kQ potentiometer, and built-in analog volume pedal capability. Learn more at
https://www.fractalaudio.com.

F AQ. WHAT IS TRS? “TRS" stands for TIP-RING-SLEEVE and describes the

[ configuration of a 1/4" end plug or jack with three contacts. Normal guitar cables
are “TS” (Tip-Sleeve) since they lack the “ring” used as a third contact. Expression

TIP SLEEVE pedals require TRS cables because voltage is transmitted to them on one contact
| | (the tip), and returned on another (the ring), allowing the host device to sense pedal
C:]]:. position. The third contact (sleeve) is connected to ground.
RING
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1 INTRODUCTION

GLOBAL EXPRESSION PEDAL SETUP

Pedals need to be assigned before they do anything. Once you have connected and calibrated a pedal according
to the instructions on the previous page (or if you are using a MIDI or FC-connected pedal) you can globally assign
it as “External 1", which is used in many factory presets as a Wah controller.

To set “External 1" to respond to your connected pedal:
1. From the Home page, open SETUP: MIDI/Remote and change to the External page.
2. NAV to External Control 1.
3. Turn the “A” or VALUE knob to set this external controller to your pedal:
= Select “PEDAL 1" or “PEDAL 2" for the onboard Expression jacks.

= Select “FC__ PEDAL __" for a pedal connected via an FC series controller.

= Select a number if your pedal is transmitting a MIDI CC#. For example, by default, the Fractal Audio
Systems MFC-101 transmits CC#11 for XP1 and CC#16 for XP2.

4. EXIT when finished. Most of the first 100 Factory Presets contain a Wah block you can test with.

Learn more about assigning pedals and switches to sound parameters in Section 9: Modifiers.

GLOBAL VOLUME PEDAL SETUP

The Axe-Fx Il allows remote control of the volume at all inputs and outputs. If you have a second pedal, or if you
want to use one pedal for global volume instead of expression, follow the instructions below:

The first step is to decide which volume you want to control. Adjusting Input volume affects gain/distortion and
the behavior of level-dependent blocks like the compressor or gate. Adjusting Output volume does not affect
level-dependent blocks, but scales everything you hear including effect tails. For all other volume options, you can
insert a Volume block anywhere in your preset and control it with an “External Controller” as described above
(See also “Modifiers” on p. 53.)

To set up a global volume pedal, first ensure that you have a pedal connected and ready to use. Then:
1. From the Home page, open SETUP: MIDI/Remote: Other.
2. NAV to the entry for the volume you want to control: Input 1, 2, 3, or 4, or Output 1, 2, 3, or 4.
3. Turn the “A” or VALUE knob to assign a controller to your selected entry.

= Select “PEDAL 1 or PEDAL 2" for the onboard Expression jacks
= Select “FC__ PEDAL __" for a pedal connected via an FC series controller.

= Select a number if your pedal is transmitting a MIDI CC#. For example, by default, the Fractal Audio
Systems MFC-101 transmits CC#11 for XP1 and CC#16 for XP2.

4. Test and EXIT when finished.
Learn about other options for global remote control in ”Ti%g MIDI/Remote Menu” on p. 75.



1 INTRODUCTION

SHORTCUTS

The Axe-Fx lll has many user interface shortcuts. These are listed in “Shortcuts” on p. 102.
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2 HARDWARE OVERVIEW

2 HARDWARE OVERVIEW
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Chassis — The Axe-Fx Il is housed in a rugged 3U steel chassis with a sleek anodized aluminum front panel.
A pair of high-strength handles make the unit easy to manage.

o Power Switch — The front panel power switch turns the Axe-Fx Ill on or off with pop suppression.

Color Display — A large 800x480 custom color display has 30x the resolution of previous models. The
display has excellent brightness and contrast for high readability even in difficult conditions.

0 A, B, C, D, and E knobs — Five endless rotary push-encoders perform different functions on different menu
pages. Most “Edit” menus show one or two rows of five knobs for easy 1:1 operation. On vertical menu
pages, knob functions are indicated on-screen by labels (“A” through “E"). Push functions are shown on-screen
as buttons. These knobs also have hidden “double tap” functions detailed on p. 103.

HOME Button — This button shows the Home menu—a convenient starting point for loading or editing
presets, and accessing the tuner, controllers, metering, and global setup options. You can double-tap home
as a shortcut to open the layout grid.

EDIT Button — This button opens the Edit menu for a block selected on the Layout grid. You can also tap
EDIT sequentially to step through all blocks in the current preset (top-to-bottom, left-to-right), or double-tap
to step in reverse order. See “Presets” on p. 33 for more on editing presets.

STORE Button — Enters the Store menu where you can save presets and enter names for presets or scenes.
See “Saving Changes” on p. 41.

TEMPO Button — Tap this button once to show the Tempo page of the Controllers menu, or tap 2+ times to
set a new tempo. The tempo can also be entered using a footswitch or MIDI. After setting the tempo, press
EXIT to go back to back to wherever you were. See “Tempo” on p. 65.
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2 HARDWARE OVERVIEW

@) VALUE Knob — The VALUE knob performs different functions on different menu pages. In the Home menu,

it selects presets. In Layout (grid) pages, it is used to add or modify blocks on the grid. In Edit menus, it
changes parameter values, selects from lists, and more. A hidden “push” function enters the Layout (grid) of
the current preset from other pages or menus.

NAV Buttons — The four NAV buttons perform different functions on different menu pages. On the preset
pages of the Home menu, they select and load Presets (Left/Right) and Scenes (Up/Down). In other menu
pages, they select between on-screen parameters or options, moving the “focus” of the VALUE knob, as
indicated by a blue highlight and brighter blue text.

ENTER and EXIT Buttons — The ENTER button executes commands, commits changes, accesses sub-menus,
and more. EXIT works for cancel, escape, and various other functions.

PAGE LEFT and PAGE RIGHT Buttons — These buttons step through menu pages, shown as “tabs” at the top
of the display.

@ Meter Bridge — Eight LED meters show the levels of every input and output on the Axe-Fx IlI.

For inputs, the red LED lights at -6dB. Set input levels so your loudest playing “tickles the red” if possible
(see p. 5). For outputs, the red LED indicates -1 dBFS and is therefore a more immediate indication of
clipping. You can also find meters on the Meters pages of the Home and Layout menus.

Status LEDs — Three LEDs indicate important information. The Tempo LED flashes to show the current
Tempo. The Edited LED lights whenever the current preset has been altered but not saved. The MIDI In LED
lights while MIDI data is being received at the MIDI Input or via USB.

@ Output Level Knobs 1-4 — These knobs independently control the volumes at the corresponding rear panel

O

outputs. The Output 1 knob simultaneously controls Output 1 XLR jacks and 1/4” jacks, and the headphones
level. Outputs 3 and 4 are at unity gain when set fully clockwise.

Headphones Output — 1/4" Stereo Jack — Connect headphones here to monitor Output 1 (see above).

m Front Panel Instrument Input (mono) — (1) 1/4" Jack (unbalanced) — Plug your instrument into this jack

intended specifically for use with electric, acoustic, and bass guitars. See Notes below for details about both
front and rear instrument inputs.

NOTES ABOUT FRONT & REAR INSTRUMENT INPUTS

»

The front Instrument input always overrides the rear instrument input. This allows you to build
a rig using the rear input—with a wireless unit, for instance—and then change to the front input
simply by plugging in a cable. There are no settings for this. The input switches automatically.

Both front and rear Instrument inputs feature our “Secret Sauce IV” circuitry, which — among other
things — lowers the noise floor using a proprietary technique and special analog input circuitry.

The Input 1 block sets the impedance for Input 1 automatically, or can be manually overridden
for “loading” effects on your pickups. See Input Blocks in the “Blocks Guide”.

You can also connect guitars and other instruments to Inputs 2, 3 or 4. These are designated as
LINE Level but accommodate high impedance sources so as not to load down guitar pickups.

You can use traditional effect pedals in a loop, or between your guitar and the Axe-Fx Ill. You may
need to trim the input when using a loud guitar or pedal. See “Setting Levels” on p. 5.
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2 HARDWARE OVERVIEW
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ANALOG INPUTS

Axe-Fx lll inputs are extremely flexible. Any input can be placed as a block on the grid for use in any number of
scenarios. Example rig diagrams are provided in Section 4.

@ Input 1 [Instrument] (mono) — (1) 1/4" Jack (unbalanced) — Plug your instrument into this jack intended
specifically for use with electric, acoustic, and bass guitars. See Notes (previous page) for details.

@ Input 2 L+R (stereo) — (2) XLR/1/4" Combo Jacks (balanced) — These combo jacks combine XLR female and
1/4" jacks in one, accepting either balanced or unbalanced line level signals.

@ Input 3 L+R (stereo) — (2) 1/4" Jacks (balanced) — Input balanced or unbalanced line level signals.
m Input 4 L+R (stereo) — (2) 1/4" Jacks (balanced) — Input balanced or unbalanced line level signals.

Balanced audio connections are resistant to noise and interference. It is best to use XLR or TRS (3-conductor)
cables when connecting Axe-Fx lll inputs 2, 3 and 4 to the balanced outputs of other devices. Regular TS-type
“patch” cables (2-conductor) are sufficient when connecting to unbalanced outputs.

ANALOG OUTPUTS

Like inputs, outputs are typically used by placing blocks on the grid, though in this case the various XLR and 1/4"
Humbuster jacks suggest different uses for different outputs. Example rig diagrams are provided in Section 4.

Humbuster technology on all 1/4" outputs can significantly reduce hum from ground loops.
Humbuster Cables are available at http://shop.fractalaudio.com. Learn more on p. 6.

@ Output 1 L+R (stereo) — (2) XLR-Male (balanced) and (2) 1/4" Jacks (Humbuster)
Use the XLR jacks to connect Output 1 to balanced inputs, employing the provided ground lift switch if
necessary to reduce 60-cycle hum. Use the 1/4" unbalanced Humbuster outputs to connect to unbalanced
inputs, such as those on guitar power amps and other devices. Output 1 is utilized as the main output in all
factory presets.
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2 HARDWARE OVERVIEW

@ Output 2 L+R (Stereo) — (2) XLR-Male Jacks (balanced) — Use these XLR jacks to connect to balanced
inputs. Use the ground lift switch if necessary to reduce unwanted 60-cycle hum.

@ Output 3 L+R - (Stereo) — (2) 1/4" Jacks (Humbuster) — Use these 1/4" unbalanced outputs to connect to
unbalanced inputs, such as those on guitar power amps or other devices.

@ Output 4 L+R - (Stereo) — (2) 1/4" Jacks (Humbuster) — Use these 1/4" unbalanced outputs to connect to
unbalanced inputs, such as those on some guitar power amps or other devices.

Outputs 3 and 4 are designed for unity gain applications such as the popular “Four-Cable Method” and other
setups using traditional guitar amps. Set the OUT 3 and OUT 4 Level knobs fully clockwise for unity gain. See
the relevant rig diagrams in Section 4 for more information.

@ Digital Inputs and Outputs — This includes both S/PDIF and AES/EBU format input and output jacks. Only
one or the other pair can be active at any time depending on the setting of the SPDIF/AES Select parameter
found in SETUP: 1/0: Audio. These jacks transmit and receive at a fixed rate of 48k. The Axe-Fx Il defaults to
using its internal clock but can also use Word Clock signals received at the digital input. Find descriptions of
related parameters under “I/0: AUDIO Page” on p. 72.

@ Expression Inputs — (2) 1/4" Jack — These are used to connect an external expression pedal or switch to
control various functions of the Axe-Fx lll. See “Connecting Pedals Directly” on p. 12 for more information.

@ FASLINK Il Connector — Connect Fractal Audio FC-6 or FC-12 foot controllers here. A standard XLR cable
powers the FC without an external “wall wart” adapter, and carries 2-way communications.

o NOTE: The FASLINK Il port on the Axe-Fx Ill is designed for our “FC” series of foot controllers and is NOT
compatible with the FASLINK port on our MFC-101 MIDI foot controller.

@ USB — This provides the Axe-Fx Ill with 8x8 USB audio and 2-way MIDI capabilities when connected to a
compatible Mac or PC. Drivers are required for Windows. No driver is required for Mac OS X. See Section

3. USB, on p. 19 for more.

@ MIDI Ports — The MIDI IN port of the Axe-Fx Ill allows you to use a 3rd party MIDI controller or interface to
control various functions including preset and scene selection, effect bypass, channel changes, parameter
changes, and more. Messages received at the MIDI IN port are passed automatically to the MIDI THRU port.
The MIDI OUT port transmits MIDI data generated by the Axe-Fx Ill to connected devices.

See “The MIDI/Remote Menu” on p. 75 for details on how to configure the MIDI Channel and other options.
MIDI messages can also be transmitted by presets or by the Scene MIDI block. See

@ AC Power Receptacle — Insert the supplied power cable and connect the other end to a grounded AC power
receptacle. The Axe-Fx Ill has a universal power supply, which means it can be used around the world
without an adapter simply by changing the cable.
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3 USB

3 USB
COMPUTER INTEGRATION

With a USB connection to a computer, the Axe-Fx Ill functions as an 8-in/8-out 24-bits 48kHz ultra-low latency
audio interface for Mac and Windows computers. A driver is required for use under Windows. This extremely high-
quality audio interface is powerful enough to be the centerpiece of a Digital Audio Workstation (DAW).

In addition, a computer connection provides high-speed “MIDI-over-USB” for remote control of the Axe-Fx Il
backups, updates, editing, and more.

WINDOWS MINIMUM REQUIREMENTS

0S: Windows 7 SP1 or newer (all versions compatible with x86 or x64).

CPU: Intel Core 2 @1.6 GHz or better, or AMD equivalent.

Memory: 1GB minimum.

USB: USB 2.0 support required.

Driver: The Axe-Fx lll is fully class-compliant, but driver installation is still required for use under Windows.

The Windows driver can be downloaded at http:/www.fractalaudio.com/support.

Step-by-step instructions are included with the installer.

MAC MINIMUM REQUIREMENTS
0S: 0S X 10.6.8 or later for MIDI-over-USB (Fractal-Bot, Axe-Edit Ill, Cab-Lab, etc.).
0S X 10.9 or later for USB audio. An issue in older OS X versions causes audio pops.

CPU: Intel Processor or Apple M1 series.

Memory: 512MB minimum.

USB: USB 2.0 support required.

Driver: No driver is required for Mac 0S. The Axe-Fx Il is class-compliant.

Important: If you are using a USB-C to USB adapter on an Apple computer, always plug the USB-C end of the
adapter into a USB-C or Thunderbolt 3 (USB-C) port on your Mac first, and then connect the USB cable of your
Axe-Fx Il to the adapter.

MIDI-OVER-USB

The USB connection also carries high-speed “MIDI-over-USB”. On the computer, the Axe-Fx Ill MIDI In port inputs
MIDI data from the Axe-Fx III. The Axe-Fx Il MIDI Out port transmits data from the computer to the Axe-Fx IIl.

MIDI-over-USB performs the same functions as regular 5-pin MIDI, only faster. For example, the Axe-Fx IIl will
process an incoming MIDI Program Change message whether that message is transmitted through the unit's own
MIDI IN port, or via the Axe-Fx Il MIDI Out port of a connected computer.
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3USB

USB INPUTS AND OUTPUTS

The USB Recording and playback capabilities of the Axe-Fx Ill are illustrated below. The numbered red boxes
in the top section represent USB inputs on the computer, and the numbered green boxes in the top section
represent USB outputs on the computer.

In the following diagram, parameters shown in purple are found in SETUP: 1/0: Audio

COMPUTER INPUTS (RECORDING)

- @ @ Record Processed Audio
- @ @ Record Processed Audio

INST

IN 1 @ @ Record a DI for re-amping
IN 2 or IN3 or IN4 Record a stereo source without processing.

USB OUTPUT 7,8 SOURCE

COMPUTER OUTPUTS (PLAYBACK)
@ @ ) OUT 1 L+R  Play Computer Audio

USB OUT MAPPING | Can be swapped:

@ @ OUT 2L+R Play Computer Audio

@ @ ﬂ and/orIN 2,3 or4 Route Computer Audio to the grid for re-amping or processing.

INPUT 1 SOURCE, INPUT 2 SOURCE, INPUT 3 SOURCE, INPUT 4 SOURCE

E opt: SPDIF/AES OUT As above, plus option for playback at digital outputs.
SPDIF AES OUT SOURCE

OPTION: USB INPUT MONITORING ONLY

It is possible to record and play back USB audio without also hearing “local” audio from the Out 7 or Out 2 blocks at the
corresponding physical jacks by changing SETUP:1/0: Audio: Output 1 (or 2) Mode to “MUTE”

The following diagram shows how signal is routed during normal use and when this special option is used.

Output 1 Mode: STEREO BUTPUT 1 Output 1 Mode: MUTE outPuT 1
e =
v
) (1) (2)

RECORD 182  PLAYBACK 1&2 RECORD 182 PLAYBACK 1&2
UsB UsB

\ 2 4
A\ A 4

N
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3USB

MAC 0S X SYSTEM AUDIO

By default, Mac OS X system audio plays through USB Channels 1+2 of a connected device. If you are using a
multi-channel audio application such as Logic or Mainstage, you can simply select the desired outputs on a track-
by-track basis. The following section applies rather to system audio.

Audio from apps such as Apple Music or iTunes will normally be played back to the first pair of USB outputs.
As detailed on the previous page, these are —by default— mixed in at output 1, which is also the destination for
processed guitar signals in all factory presets.

If you want to separate system audio and guitar processing to two different pairs of outputs, you might think at
first that you need to change every factory preset to use the Output 2 block. That would work, but there are two
other options.

The first option is to re-map USB Audio playback so computer outputs 1 and 2 to go to Out 2 L+R instead of Qut 1
L+R. To do this, change SETUP : 1/0 : Audio : USB OUTPUT MAPPING to “1/2 -> OUT2, 3/4 -> OUT1".

The second option is to use the “Configure Speakers” option in Mac 0S. To change this setting:
1. First ensure that the Axe-Fx Ill is selected as your output device.

= Connect the Axe-Fx Ill to your Mac as described on p. 19.

= QOpen the Output pane of Sound preferences (Choose Apple menu > System Preferences, click Sound, then
click Output) and select the Axe-Fx IIl.

2. Open Audio MIDI Setup (find it in Utilities in your computer’s Applications folder).
3. Select the Axe-Fx Il device from the list, then click the Configure Speakers button (lower right).

4. Make sure that the Configuration is set to “Stereo” and then select the desired left and right channels.
IMPORTANT: As shown in the screen capture below, the computer outputs corresponding to Axe-Fx Out 2 L+R
are numbered “3” and “4” in the computer.

5. Click “Apply” then click “Done” to finish.
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3 USB

USB RE-AMPING

The Axe-Fx Il USB Audio capabilities are perfect for “re-amping”, a method in which the raw un-processed DI
output of a guitar is recorded and then re-processed later through the amp, cab, and effects of your choice.
Re-amping has many benefits. First, it allows you to record when inspiration strikes, capturing a Dl instead of
obsessing over final tone. Later, you - or a mixing engineer - can redesign a sound as your track’s production
advances. Also, punches and edits made on the DI track are essentially made inaudible by the re-amping process.
In comparison to other products, the Axe-Fx Il allows you to use the unit in the best and most effective re-amping
workflows, including being able to dial in new tones while simultaneously listening to the track for context.

NOTE: This method is for USB Re-Amping. For analog reamping, simply copy Input 1 to Output 3 or 4 (p. 73).

This tutorial also assumes you are using default settings for the varioys parameters in Setup: I/0.

STEP 1: RECORDING

The following tutorial assumes that the Axe-Fx Ill has been selected as the audio interface in your Digital Audio
Workstation (DAW), and that you have connected Output 1 L/R to studio monitors, or that you are monitoring
through the Axe-Fx lll headphones jack. The details for each step below may vary slightly from one DAW to
another, but this guide should be easy to adapt to your own environment.

1. Inyour DAW, select Axe-Fx Ill as the main audio interface. Set the main outputs to Axe-Fx Ill Outputs 1+2.
2. Create a new project in the DAW, and set its sample rate to 48kHz. Record or insert any backing tracks.

3. Connect your guitar to the Instrument input and select a preset well-suited to the material you're recording.
4. For this tutorial, we will record both the processed output and the DI.

= Create a mono track. Name this track something like “Guitar DI”. Set its input to Input 5. This is the DI
output of the Axe-Fx IIl. This will record the signal at the Input 1 Instrument jack with no processing.

= (Create a stereo track. Name this track something like “Guitar Reference 1". Set its inputs to Axe-Fx IlI
Inputs 1+2. This will record the processed guitar signal sent on the grid to the OUT 1 block.

5. Arm both of your guitar tracks for recording, making sure that Software/Input Monitoring is NOT enabled.

6. Hit RECORD and roll the track. You should see signal on both tracks. Be aware: while the processed track will
show “hot” levels, the signal level on a DI track will appear to be very low. This is NORMAL! You are recording
the instrument level signal exactly as it comes out of your guitar with no pre-amplfication.

STEP 2: RE-AMPING

To prepare for basic re-amping, change two settings on the Axe-Fx Ill.

1. Press HOME and open SETUP : 1/0 : Audio and make the following two changes:

= Change Digital Input Source to “USB/CHANNELS 5/6".

= Change Input 1 Source to “DIGITAL".

MUTE the “Guitar Reference 1" track.

Change the output of your “DI" track to Axe-Fx Il Output 5/6. Set its output level to -6.0 dB.

Solo your DI track, then rewind and hit PLAY. You should hear the DI being processed by your Axe-Fx Il preset.

Record the re-amp. Create a stereo track. Name this track something like “Guitar Re-Amp 1”. Set its inputs to
Axe-Fx Ill Inputs 142,

Arm your re-amping track for recording, making sure that Software/Input Monitoring is NOT enabled.
. Rewind, hit RECORD, and roll the track. The output of the preset is recorded.
8. Change Input 1 Source back to “ANALOG"” when you finish re-amping.

a R wbn

N o
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4 SETTING UP

4 SETTING UP

This section provides an overview of various ways to use the Axe-Fx Ill. These diagrams represent just a few of
the many ways to use this flexible product, and even if you only intend to use a basic setup you can still learn from
looking over this section.

GENERAL PRINCIPLES

POWER & LEVELS

» When creating a new setup, begin with all level knobs turned down and all devices powered off.
» The Axe-Fx Ill features pop suppression on startup, but speakers or

monitors should still be powered on last whenever possible.
» Basic surge/spike protection is recommended but ot required.

AXE-FX IIl INPUTS

» When connecting a guitar to the Axe-Fx llI, the front or rear Input 1/Instrument jacks are preferable.
These feature “Secret Sauce IV” circuitry, which lowers the noise floor using a proprietary technique
and special analog input circuitry. The front jack overrides the rear one, so you can connect in different
ways without changing menu settings even when the rear jack is utilized in a rack system.

» You can also connect guitars and other instruments to Inputs 2, 3 or 4. These are designated as
LINE level but accommodate high impedance sources so as not to load down guitar pickups.

» When connecting the outputs of other devices to inputs on the Axe-Fx lll, use appropriate
cables and connectors. For balanced signals use balanced connectors. Regular guitar
cables are fine for unbalanced connections to the inputs of the Axe-Fx Ill.

» Setting Input Levels correctly is important. See “Setting Levels” on p. 5.
AXE-FX Il OUTPUTS

» Outputs 1 and 2 default to -10 dBV. You may wish to change these to +4 dBu when connecting
to to professional audio equipment. Find these settings on under SETUP: 1/0: Audio

» When connecting to a device with balanced inputs, it is best to use the XLR
outputs of the Axe-Fx Il with XLR cables or XLR-to-TRS cables.

» If a connected device has unbalanced inputs, use the unbalanced 1/4" outputs of the Axe-Fx Ill. Humbuster
cables are not required, but can help prevent the noise associated with ground loops. Purchase Humbuster
cables at shop.fractalaudio.com or from your nearest Fractal Audio Systems dealer. (See p. 6.)

MONO/STEREO

» Any setup can easily be adapted for mono or stereo with some simple changes to input and output settings.

» See “Mono vs. Stereo” on p. 6 for an introduction, and “I/0: AUDIO
Page” on p. 72 for details on I/0 parameters.

USING THE AMP BLOCK WITH TRADITIONAL GUITAR SPEAKERS

» When using the Axe-Fx lll amp block into traditional (not FRFR) guitar speakers, certain advanced
parameters warrant special consideration. On the “Speaker” page of the Amp block, set Speaker
Drive to zero. You may also wish to zero Speaker Compression. Also consider matching LF
Resonance Frequency to match the resonance of your connected cab — if you know it.
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4 SETTING UP

FRFR/DIRECT

Global Settings: Default
Presets: Factory or Custom

This is by far the most popular type of setup, taking full advantage of the ability of the Axe-Fx Il to every part of an
“end-to-end” guitar chain, from stompboxes to amps, cabs, post effects, and more, for maximum versatility.

Output 1 is connected directly into full-range, flat response (“FRFR") speakers such as those offered especially
for guitar players by a number of manufacturers. Such systems are typically self-amplified (“active” or “powered”),
but may consist of separate “passive” full-range speakers and a full-range power amp. Other suitable FRFR
systems include high-quality PA speakers (including “Personal Monitor” wedges) or studio monitors.

In some cases, signal from the Axe-Fx Ill may pass through a mixer first. That's fine, as long as you connect to
LINE inputs. You do NOT need to use a mic preamp! Contact your mixer's manufacturer if you have any questions.

All Global and 1/0 settings are at default values. All Axe-Fx Il factory presets are designed for this setup.
Adjust overall levels using the front panel OUT 1 knob.

This is also the setup for a Digital Audio Workstation (DAW). Just add a computer connected via USB (don't forget
drivers if you're running Windows) and the speakers connected to your Axe-Fx Il become the main monitors for the
DAW. Headphones can also be used.

CONNECTIONS

» Connect your guitar to
Input 1 (Instrument).

» Connect Output 1 to the
input of your FRFR System.

» The presets used for this
setup also work great
with headphones.

PERSONAL
FRFR
MONITORS

EEEEEEE
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4 SETTING UP

FRFR MONITOR & FRFR TO FRONT-OF-HOUSE

Global Settings: “Out 2 Copy Out 1" Turned ON
Presets: Factory or Custom

This type of setup is similar to the previous FRFR/Direct setup except that it also sends signal to a mixer for front-
of-house mixing (and possible band monitors). In this configuration, the Axe-Fx Il creates a fully modeled end-to-
end guitar signal path for the ultimate in tonal flexibility—stompboxes, amps, cabs, post effects, and more.

Output 1is connected directly to your own monitors. Use full-range flat response (“FRFR") monitor speakers such as
those offered especially for guitar players by a number of manufacturers. These might be self-powered or passive,
with an external power amp. High-end PA monitor wedges can also be fantastic for this purpose.

Output 2 is used as an independent copy of Output 1. For this example, this is accomplished with a Global settings
change rather than inserting an Output 2 block in every preset. (See “Connections” below for details.)

In the event that your monitors are stereo but front-of-house wants mono, consider whether you want to send them
half-stereo or summed stereo and change SETUP: 1/0: OUTPUT 2 Mode (see “Mono vs. Stereo” on p. 6).

Adjust you own monitor level using the front panel OUT 1 knob.

Adjust your send level to front-of-house using the front panel OUT 2 knob. One advantage of this setup is that you
can adjust stage levels and house levels independently.

CONNECTIONS

» Connect your guitar to
Input 1 (Instrument).

» Connect Output 1 to the input
of your FRFR System.

» In SETUP: I/0: Audio, set
Output 2 Copy Output 1 to “ON". e A °

» Connect Output 2 to the
front-of house system.

= This will presumably be a
balanced connection, so use =)
XLR cables if so. , )

. OUTPUT : Optional

= |f you are working with a sound : : . 2R | forStereo
technician, be sure to tell Toptomal | N ’
them that you are outputting for Stereo
a hot LINE level input — NOT a
microphone level signal. They
should use a balanced line input

o

....................

. PERSONAL 0000l es =
without a preamp. FRFR MONITOR 0l0/0|0/ 0000

= Also tell them you are sending 2929922008
a fully processed “mix-ready” "
sound, and that — at least to 4 % % % % % % % %
start — they should initialize @ ‘= || E== FHEBEFEEFE
the channel with no EQ or
processing. FRONT-OF-HOUSE

MIXER/PA
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4 SETTING UP

POWER AMP & GUITAR SPEAKERS

Global Settings: Modified (see below)
Presets: Factory or Custom

This popular setup uses a power amp and traditional guitar speakers, which are NOT full-range or flat response,
so speaker simulation is disabled globally. Blocks are used to recreate stompboxes, amps, and studio effects.
Depending on your amp, power amp modeling may also need to be disabled globally.

DISABLE SPEAKER CAB MODELING CONNECTIONS
IMPORTANT: For this setup, bypass Cabinet Modeling » Connect your guitar to Input 1 Instrument.

under Global Settings. » Connect Output 1 L to the input
» Navigate to SETUP: Global Settings: Config. of your power amp, which is assumed to
» Change Cabinet Modeling to “BYPASSED”. already be connected to a guitar speaker
cabinet. You can also connect to the FX
Return jack on many amp heads/combos.
CONSIDER YOUR POWER AMP... e on o P
» When using 1/4" outputs, Humbuster cables are
There are two categories of power amp that you can recommended to reduce hum from ground loops.

use with the Axe-Fx IIl. A sonically “neutral” power amp
is generally the preferred variety. Such amps (mostly
solid-state) allow you to use Power Amp Modeling in the
Axe-Fx Ill, which accurately recreates the appropriate -
power amp tone and dynamics for your selected amp Front of Rear
model.

o

The second category is “non-neutral” power amps,
typically tube-powered, and made specifically for
traditional guitar rigs. This includes not only rackmount
amps, but the power amp in a tube head or combo—
usable for a rig like this one when you plug directlyinto &

W W

the amp’s FX RETURN jack. The non-neutral power amp
can sound great, but you'll be “stuck” with the tone and RS
dynamics of that particular amp, and you will almost
certainly want to disable Power Amp Modeling as
detailed below:

DISABLE POWER AMP MODELING

IMPORTANT: when using a non-neutral power amp, set
Power Amp Modeling under Global Settings to OFF.

» Navigate to SETUP: Global Settings: Config.

» Change Power Amp Modeling to “OFF".
GUITAR
SPEAKER
CABINET
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4 SETTING UP

POWER AMP & CAB & FRFR/DIRECT

Global Settings: Default, check I/0 Mono/Stereo settings
Presets: Custom

In this setup, custom presets simultaneously send two different signals—WITH speaker sims sent to a full-range
front-of-house/monitors P.A. mix, and one WITHOUT speaker sims, sent to a “backline” rig consisting of a power
amp and traditional guitar cab. For this example, we are assuming that the backline system uses a neutral power
amp.

Output 1 connects to a full-range system—typically the house PA—sending a complete virtual rig tone, including
simulated speakers. This provides all the benefits of going direct: versatile, consistent tone without “bleed” at very
controllable volume levels for a better overall mix.

Output 2 sends a separate signal, almost identical to the first, but without speaker simulation—because it will be
going to a power amp and traditional guitar speaker. This approach provides a very familiar “backline” experience—
great natural sustain and feedback, “moving air,” and familiar stage volume and presence.

| IN1 H wAH H DRV H{ AMP [ cHo [ by | REV WHOUHJ

ouT2

This setup requires custom presets with both Output 1 and Output 2 blocks on the grid. Output 1 is at the end of the
chain (where it appears in factory presets) and Output 2 taps the signal just before the cab block as shown below.

Note that the cab block has been moved to after the effects, which may collapse them to mono at Output 1. If a
stereo signal is required at Output 1, the cab block must be modified for stereo use. Another solution would be to
split the signal after the amp into separate chains of [Cab—Effects—Out 1] and [No-Cab—Duplicate Effects—0ut 2].

f\p

I Oshhz

~ Nl

[e=]

....................

INSTR . Optional
IN ,' for Stereo
Front Optional
or Rear for Stereo
0oloo el =
0/0|0|0|0000 i | FRONT-OF-HOUSE ouT
©O/0]0/0/0000 <] MIXER/PA
i i ":'7 i iiii,? Be sure to avoid using a microphone GUITAR
‘ hannel settings that EAl
H/EBBEE EB]| mighontes SPEAKER
HEEEEEET might undesirably color the sound. ST,I:R CABINET
CONNECTIONS
» Connect your guitar to Input 1 (Instrument). » Connect Output 2 to the input of your power

amp. Again, we are assuming a neutral

» Connect Output 1 to the Front-of-House PA. power amp is in use (see note, p. 26).

Inform the sound technician that the Axe-Fx
IIl outputs a direct LINE level signal which » If using the 1/4" outputs, Humbuster cables are
should initially not require any EQ or settings recommended to reduce hum from ground loops.
typically used on a mic'd guitar cabinet.
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4 SETTING UP

FOUR-CABLE METHOD (“4CM")

Global Settings: Default, but see “Tip” Below  Presets: Custom

The Four-Cable Method (“4CM”) setup places the Axe-Fx IIl in two places at once with two separate processing
chains. The first goes in front of your amp, where a chain of “pre” effects like wah and drive replace traditional
stompboxes. The second placement is in the effects loop of the same amp, where a chain of “post” effects like
delay and reverb appear. Although a head and separate cab are shown, many combo amps also offer an onboard
effects loop and can be used as well.

4CM requires special presets with no Amp or Cab blocks. A stylized illustration appears below. Signal hits
the Axe-Fx Il first, where it is processed by pre effects. Output 3 feeds the front of the amplifier. A chain of
post effects is run in the amp'’s FX loop using Input 4 and Output 4. Note that the pre and post chains are not
connected to each other at all on the grid. In fact, either chain can be as simple or as complex as desired.

[ N1 H{waHH bRV [ -« Hours| IN4 H by H Rev H{ -« Hout4

Pre-FX Post-FX

CONNECTIONS

» 4CM requires custom presets with no Amp or Cab
blocks (see above). A template is included (#382).

» Connect your guitar to Input 1 (Instrument).

» Connect Output 3 L to the input of your amp. S S
Set the front panel OUT 3 knob fully clockwise ; :
for unity gain operation. A Humbuster cable is
recommended to reduce hum from ground loops.

ERsETAL,
=\ AXE-FXH
(L) e

s
6
&

<

» Connect your amp’s FX Send to Input 4 L on =) =]
the Axe-Fx IIl. Input levels can be adjusted on INPUT ) (ouTPuT ) (oUTPUT ) : OUTPUT
the Input page of the 1/0 menu under SETUP. 4 4 3L 4R
Set Input 4 Mode to “LEFT ONLY” on the I Optional
Audio Page of the 1/0 menu under SETUP. X X for Stereo.

» Connect Output 4 L to the FX Return of your amp. SEND RET.URN
Set the front panel OUT 4 knob as desired for =
appropriate volume. A Humbuster cable is Amplifier Guitar
recommended. To extend this configuration Amp
for optional stereo, connect Output 4 R 9 0000 ¥

to the FX Return of a second amplifier,

levels, padding their outputs for even lower noise. To
find the right setting, adjust either of these settings

as high as possible without clipping the outputs, as
indicated by a red LED on the front panel meters. You'll
actually hear the noise floor drop as you increase
Boost/Pad. Find these options on the Audio page of \ 4
the 1/0 menu under SETUP.

bypassing that unit's preamp altogether.
TIP: OPTIMIZE FOR LOW NOISE
The optional Boost/Pad functions on Outputs 3 and
4 are designed to run the D/A converters at boosted

28



4 SETTING UP

FX PROCESSOR ONLY (“POST")

Global Settings: check 1/0 Mono/Stereo settings, see “Tip” Below
Presets: Custom

Although it was designed for complete rig replacement, the Axe-Fx lll can also be put to superb use as a
standalone FX processor, providing access to our industry leading effects for those who are not ready to make the
switch to modeling.

This setup uses only three of the four cables used in the Four-Cable Method (p. 28) for operation in an amp'’s
FX loop, providing post- but no pre-effects. Output 3 and 4 are designed for unity gain applications—which may
or may not be important in this case depending on your amp. Here we'll use Output 3 and pair it with Input 3 for
simplicity’s sake.

You will need to create custom presets without Amp or Cab blocks, containing only those effects that sound good
to you after preamp distortion: typically chorus, EQs, delays, reverbs, certain types of pitch shift, etc.

CONNECTIONS T -

» This setup requires custom presets
with no Amp or Cab blocks.

» Connect your guitar to your amp'’s
instrument input as usual. INPUT

3L
» Connect the FX Send of your amp

to Input 3 L. Input levels can be

adjusted in SETUP : 1/0 : Input. E
» In SETUP: I/0: Audio, set Input

3 Mode to “LEFT ONLY". ;.
» Connect Output 3 L to the FX Return of your fAmplifier

amp. A Humbuster cable is recommended. INSTR Y
; 8o 0 Q00T "?;- IN
» Set the front panel OUT 3 knob as desired

for appropriate volume levels. If unity gain ;-
is required, set the knob fully clockwise.

= To extend this configuration for optional
stereo, you would typically connect Output
3 R to the FX Return of a second amplifier, SPEAKER
bypassing that unit's preamp altogether. CABINET

= Qther types of stereo setup are of course
possible, including using two totally
different amps each connected on Left and
Right sides of one 1/0 pair, or I/0 3 for one
amp and I/0 4 for another. There are no
limits except your imagination.

. of a second amp for
' optional stereo.

)

e
o

TIP: OPTIMIZE FOR LOW NOISE

The optional Boost/Pad functions on Outputs 3 and 4 are designed to run the D/A converters at boosted levels,
padding their outputs for even lower noise. To find the right setting, adjust either of these settings as high as
possible without clipping the outputs, as indicated by a red LED on the front panel meters. You'll actually hear the
noise floor drop as you increase boost/pad. Find these options on the Audio page of the I/0 menu under SETUP.
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FX PROCESSOR ONLY (“PRE")

Global Settings: check 1/0 Mono/Stereo settings, see also “Tip” below
Presets: Custom

Here, the Axe-Fx Il is used as the ultimate virtual pedalboard, providing access to our vast collection of industry-
leading effects between guitar and amp, where traditional pedals might be placed. As with all Axe-Fx Il setups,
you are not limited by the stock offerings but can combine effects in any configuration imaginable, creating totally
new sounds using the layout grid and its modular block architecture. Custom presets contain no Amp or Cab
blocks.

This setup uses only two of the four cables used in the Four-Cable Method (p. 28). Outputs 3 and 4 are
designed for unity gain applications—which is important in this setup. Here we'll use Output 3 and pair it with
Input 3 for simplicity’s sake.

You will need to create custom presets without Amp or Cab blocks, and those presets should be created with an
understanding of how effects sound in front of your amp'’s preamp and the distortion it generates.

CONNECTIONS

» This setup requires custom presets
with no Amp or Cab blocks.

‘i:iiisi=§ﬁ-—;= = oy T
CEeSpESS=C=E! E—EEEE =20
E BeiEESiESsESeSSSEETEE =y,

» Connect your guitar to Input 1 Instrument
on the Axe-Fx lll. Adjust input levels
if required as detailed on p. 5.

» Connect Output 3 L to the input of your amp.
A Humbuster cable is recommended.

» Set the front panel OUT 3 knob o
fully clockwise for unity gain.

OUTPUT
= To extend this configuration for optional 3L
stereo, connect Output 3 R to the input of a

second amplifier.

Optional for
Stereo

INPUT
* You might use the Axe-Fx Ill to select — I
between two amps by changing Channels 92.00000° 2
on the Output 3 block: Combo GUITAR
- Channel A: Balance Center (Both Amps) AMP

- Channel B: Balance Left (Left Amp)

- Channel C: Balance Right (Right Amp)
- Channel D: (Not used)

(See “Scenes & Channels” on p. 43 for

more.) —a -

TIP: OPTIMIZE FOR LOW NOISE

The optional Boost/Pad functions on Outputs 3 and 4 are designed to run the D/A converters at boosted levels,
padding their outputs for even lower noise. To find the right setting, adjust either of these settings as high as
possible without clipping the outputs, as indicated by a red LED on the front panel meters. You'll actually hear the
noise floor drop as you increase boost/pad. Find these options on the Audio page of the I/0 menu under SETUP.
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4 SETTING UP

INSERTING OUTBOARD GEAR

Global Settings: As per your usual setup, check I/0 Mono/Stereo Settings
Presets: Custom

With the typical “direct” setup using only Input 1 and Output 1, the Axe-Fx Ill has enough 1/0 blocks left over
for multiple “send-and-return” inserts of outboard gear. The simple example below imagines a 3rd-party device
inserted using Output 3 (used as a “send”) and Input 3 (used as a “return”). This setup can also be used with
stereo inserts, or expanded with multiple 1/0 pairs for multiple outboard devices. Insert devices can even be
added to other types of setups using these same techniques.

Custom presets are required for this type of setup, with output and input blocks added for the send and return
points (see example below). The Axe-Fx lll has no “FX LOOP” blocks, so inputs and outputs are placed individually
on the grid. In a send/return pair, the Output block is connected to the Input block (as shown below), allowing the
Input block (return) to serve as a master bypass control for the send/return loop.

[ N1 HwaHH prv H{ -« Houts{ N3 | by H Rev H{ -« Hour1]

Serves as a SEND  Serves as a RETURN

CONNECTIONS

» Connect your guitar to =T T
Input 1 (Instrument). o~

» This example assumes Output 1
is connected to FRFR monitors.

» Connect Output 3 L as a “send” to the
input of your outboard device. Adjust
output levels using the front panel OUT 3
knob with the following considerations:
= Qutputs 1 and 2 have options for -10

dbV and +4 dBu in SETUP: 1/0: Audio.

= Qutputs 3 and 4 provide unity gain Main ; IN;;JT ¥ P
when the knob is fully clockwise. out 3

EESES===tn,

_— Optional
* You can also adjust the levels of an f°""°"a' : for Stereo
o or Stereo :
individual Output block. '
» Connect the output of your outboard . =
device to Input 3 L as a “return”. Adjust : H i
: ) o - -O - e O
levels on your device or use the trim
controls under SETUP: 1/0: Input. OUTBOARD GEAR SUCH AS PREAMPS, PROCESSORS, PEDALS, ETC.

» Optionally connect the right
channel inputs and outputs
for stereo insert devices.
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4 SETTING UP

MULTI 1/0 SETUPS

The flexibility of the new Input and Output blocks allows some very cool and complex setups to be basically self-
explanatory. The diagrams below show ideas for rigs which in the past might have required intricate explanations,
but are now just presets.

The ideas in these layouts might inspire other setups, perhaps in combination with the rig setup diagrams found
earlier in this section. For example, you might use extra Inputs and Outputs to insert outboard gear, or use
different backline and front-of-house options. The only limit is your imagination.

For clarity only, all blocks are shown engaged instead of bypassed.

DUAL OUTPUT GUITAR CPU: 82%

Here, Inputs 1 and 2 are used independently with the magnetic and piezo outputs of a dual-output guitar. The two
signals eventually merge for some “mastering” effects before being passed to Output 1 in full layered stereo.
Each chain has a huge complement of effects including amp and cab modeling. The amp for the piezo out might
use a “Tube Preamp” model and an acoustic guitar simulation IR downloaded from Axe-Change.

FULLY INDEPENDENT GUITAR AND BASS CPU: 83%

This rig processes full guitar and bass rigs at the same time! Guitar uses Input 1 and Output 1. Bass uses Input 2
and Output 2. This setup would have required two separate Axe-Fx Il units to accomplish. You can easily imagine
adapting a setup like this to process two electric guitars, or separate simultaneous electric and acoustic. By the
way, these signal paths are copies of actual presets used by some artists who endorse Fractal Audio.

GUITAR CHAIN & MIXER EFFECTS CPU: 84%

Let's look at a more vertical example. Here, a mini FRFR guitar rig is combined with three rich sets of effects
imagined to be integrated with a mixer for live performance. 1/0 pair 2 is used for a special vocal FX insert chain,
complete with a raging Drive block. Chain 3 is a massive stereo shimmer for a keyboard rig, controlled by its own
volume pedal. Chain 4 contains a bevy of effects, imagined to be used in different scenes on an Aux bus.




5 PRESETS

9 PRESETS

OVERVIEW

» The Axe-Fx Ill contains 512 preset memories (1024 on the Mark 1), each a fully independent
rig with its own amp, cab, effects, and more. Every preset has its own name.
» The Axe-Fx Ill ships with various “Factory” presets, plus many empty locations,
but even Factory presets can be changed or completely overwritten.
» If you want to restore the factory presets (or install the newer versions we occasionally release), you can
download them from https:/www.fractalaudio.com and re-install them using Fractal-Bot or Axe-Edit.
» Asintroduced in “Intro to the Layout Grid” on p. 8, presets are built
on by inserting, connecting, and dialing in “Blocks”.
» Presets contain “Scenes” and Blocks contain “Channels”. Both of these
subjects are covered in depth in Section 6: Scenes & Channels
» Compared to other products, the Axe-Fx Ill allows larger presets with greater
capabilities. When you consider everything that is possible with Scenes and Channels,
a single preset can easily cover an entire song, or even an entire gig.
LOADING PRESETS

Different areas of the Axe-Fx Ill provide different ways to load presets:

On the Home page - Use the NAV LEFT and NAV RIGHT buttons or turn the VALUE knob.

On the “PRESETS" directory page of the HOME menu - Select a preset and press ENTER. Presets in the
directory are sorted in numerical order. To re-sort alphabetically, press the SORT A-Z button (v A).

FC CONTROLLER - The FC Controllers offer a range of dedicated “preset select” options.

MIDI - MIDI Bank and Program Changes select presets using the industry-standard

“Controller 0 + PC" method. See “MIDI Reference Tables” on p. 106. MIDI Custom

PC Mapping is also supported, see “Program Change Mapping” on p. 47.

Axe-Fx I Edit  Perform-PP Perform-Gbl

036: FAS Modern

Darker
Brighter
Precision
Dimension
Dry Bright

LAYOUT CONTROLLERS FC PER-PREST
The Home Page
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THE LAYOUT GRID

The grid is a 14x6 framework used for building presets. The grid is made up of spaces or slots into which blocks
are inserted to set up signal flow. Cables connect blocks. Grid spaces and cables are stereo, though not every
block processes audio in stereo.

Access the grid from the Home page by pressing the ENTER button or the LAYOUT Push-knob.

In the default view, the Axe-Fx Ill display shows only a 6x6 section of the 14x6 grid. Navigate to off-screen areas
using the D or E knobs, or the NAV buttons. A bottom scrollbar indicates where you are in the overall left-to-right
layout. To show the entire grid at once, zoom out with the ZOOM button (Push-knob A).

Axe-Fx I oru 4% Meters  Tools Layout cPu m 40% Meters  Tools

(> Scene: 1 Channel Block Level Row Column (3 Scene: 1 Channel Block Level Row Column
Z00M BYPASS DELETE CABLE CONTROLLERS | Z00M J BYPASS DELETE CABLE CONTROLLERS
The grid normally shows six rows and six columns. Zoom out to show the entire grid at once.
You can scroll left or right with navigation controls. This also reveals VU meters for leveling scenes and presets.

WORKING WITH BLOCKS

As explained in “Intro to the Layout Grid” on p. 8, the Axe-Fx Ill grid must be populated with Blocks.These

come from a large inventory of amps, cabs, stompboxes, studio effects, and more. To interact with the grid you
must move the cursor — a yellow rectangle controlled by the D or Eknobs, or the NAV buttons. For simplicity, we'll
refer simply to these controls as “NAV” going forward.

TO INSERT A BLOCK...

» NAV to the desired grid location.

» Turn the VALUE wheel to step through the list of blocks, including options for SHUNT (see below) and NONE.
» Press ENTER to confirm or EXIT to cancel changes.

» Every preset has its own complete inventory of blocks. Using a block in

one preset does not make it unavailble to other presets.

TO CHANGE OR REMOVE AN EXISTING BLOCK...

» Select the block and turn VALUE to change it to the desired type. To REMOVE a block, select “NONE".
» Press ENTER to confirm or EXIT to cancel changes.

A shortcut makes it easy to remove an existing block or convert it to a shunt. Select the
DELETE ] block and press the DELETE button (Push-knob B). A deleted block is replaced by a shunt.
Delete any shunt to leave an empty space.
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TO BYPASS OR ENGAGE A BLOCK...

» Use NAV buttons to select the block.
» Press the BYPASS button (Push-knob C). Bypassed blocks are grayed out (dimmed).

SHUNTS

A shunt is a sonically transparent block—a mere tool which carries signal through otherwise empty grid locations.
Your preset will be silent unless you make a complete connection from the Input block to the Output block, so
place a shunt wherever you don't use another block like an Amp, Cab, or effect. Like grid spaces, a shunt is stereo;
you don't need two for left/right. Shunts do use a small amount of CPU, so don't overdo it.

TO INSERT A SHUNT...

» NAV to the desired grid location and turn VALUE until “SHUNT" is displayed.
» Press ENTER to confirm or EXIT to cancel changes.

INPUTS AND OUTPUTS

Input and Output blocks are required to place input signals on the grid or pass signal to output jacks. All factory
presets use Input 1 and Output 1. Other setups may require different Input and Output blocks.
See “The Fractal Audio Blocks Guide” for additional information.

BLOCK DISPLAY TYPES

The color display shows different grid block states as follows:

Input Bypassed Selected Normal Shunt Output

GLOBAL BLOCKS

Global Blocks allow settings for a given block instance to be automatically synchonized across multiple presets.
For example, a global AMP block could be used in several presets. When any setting of that amp is changed on
one, the others update automatically. See also “Global Blocks” on p. 92.
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MOVING BLOCKS, ROWS, AND COLUMNS

The Tools page of the Layout menu contains various utilities to MOVE individual blocks, rows, or columns UP,
DOWN, LEFT, or RIGHT. When a block or a grid row/column is moved, it swaps places with the item in the space
it is moved to. This may result in certain connector cables being modified or removed, so be sure to observe
how the elements of your preset are interconnected before proceeding with a move operation.

» Open the Tools page of the Layout menu.

» Select a function with the FUNCTION knob (A): Move Effect/Column/Row, Left/Right/Up/Down.
» Use the NAV buttons to select the target Block, Row, or Column you wish to move.

» Press ENTER to execute the move.

CONNECTOR CABLES

Just like physical gear, the blocks in the Axe-Fx Il need to be connected together for signal to flow. This is done
using virtual cables, which run from one grid block to another. With even one connector missing, your preset may
be totally silent! Like shunts, connectors are totally transparent.

TO CREATE A CONNECTOR CABLE...

» On the grid, navigate to the block where you wish the cable to
BEGIN. You can't start from an EMPTY grid space!

» Press the CABLE button (Push-knob D), or ENTER. The selected block
and its neighbor to the right will alternatingly flash.
» NAV to the desired destination block, which must be in the next column to the right.
» Itis possible to select an empty location. A shunt will be added there if you complete the cable.

= Be sure to select a destination that is not already connected to the block
you started from, or you will REMOVE that cable (see below).

» Press ENTER. To cancel without connecting, press EXIT instead.

TO REMOVE A CABLE CONNECTOR...

Cables are removed in much the same way as they are created.

» On the grid, NAV to the block where the cable begins.

» Press the CABLE button (Push-knob D), or ENTER. The selected block
and its neighbor to the right will alternatingly flash.

» NAV to select the “other end” of the cable you wish to remove.

» Press ENTER. To cancel without removing, press EXIT instead.

SHORTCUT: To span multiple empty grid columns with a series of shunts and cables, select
any block that is followed by a series of empty spaces, then press-and-hold the ENTER button. The
intervening spaces will be automatically filled with shunts and connected with cables. Careful: any
existing cables encountered along the way will be REMOVED!

_ stereo in/stereo out. The grid allows up to six full stereo paths, and you do NOT necessarily need to
"-.xx =& create parallel grid paths for stereo! Some blocks internally process audio in mono (such as Amp or
“../ Drive) but even these generally have Input Select and Output Balance parameters.
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» No cables = No sound. Even one missing link will break the chain.
» Signal flows from LEFT to RIGHT.
» A cable MUST originate from a BLOCK or a SHUNT. Empty locations are not viable origins.

» If you try to connect to an EMPTY location, a SHUNT will be created there.

» You can ONLY connect to blocks in the next column to the right.

The diagram below illustrates some of the ideas above:

glelelEle]le
glelzitiele
HYIYREE
glelelEle]le

The % represents the origin of a connector cable.

The v shows valid possible destinations.

The © symbol shows destinations that are illegal/unavailable.

Any columns farther left or right would also be illegal/unavailable.

If the Y were in a different ROW, every v would still be in the same place.

» You may freely SPLIT or MERGE up to six ways at any point. This is sonically transparent and there is zero
risk of signal degradation or phase problems. CROSSING is also possible. Here are some examples:

Split

T
™
1/

Merge

0
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BLOCK INVENTORY

The following table contains an overview of every block. Each preset has the entire inventory to choose from.

BLOCK DESCRIPTION

AMP Amp Here it is! Hundreds of amp models in one block.

CAB Cab Speaker cab simulation offering our proprietary UltraRes™ and FullRes™ Technologies.
CHO Chorus Create classic mono and stereo modulation effects including vibrato.

CMP Compressor Control dynamics and add sustain.

XVR Crossover Split a signal into high and low frequency components.

DLY Delay Up to 8000 ms of delay, with types for analog, digital, tape, and more.

DRV Drive 25+ types including boost, overdrive, distortion, fuzz, and many more.

ENH Enhancer Classic and modern modes to create and control spatialization.

RTN Feedback Return  Receives signal from the Feedback Send block.
SND Feedback Send Transmits signal to the Feedback Return block.

FLT Filter Includes low pass, high pass, band pass, and many other types.
FLG Flanger Various types cover everything from subtle modulation to extreme jet.
FOR Formant Create dynamic vowel sounds with this multi-mode formant filter.
GTE Gate/Expander Useful for everything from subtle control to extreme effects.
GEQ Graphic EQ A variety of modes allow easy, flexible tone sculpting.
IN Input Injects the signal from physical inputs onto the grid.
IRP IR Player Similar to the Cab Block -- Impulse Response processing in a lightweight version.
LPR Looper A powerful looper with great remote control options.
MGT Megatap This 128-tap delay creates fantastic sonic patterns and beautiful brute force reverbs.
MIX Mixer Allows you to mix up to six stereo signals.

MBC Multiband Comp  Three-band compressor that is great for mastering or dynamic EQ.
MTD Multitap Delay A variety of special delays including diffuser, quad-tap, and more.

MUX Multiplexer This input selector routes one of many inputs to an output.
OUT Output Transmits signal to the corresponding physical output jacks.
PEQ Parametric EQ The 5-band parametric equalizer allows precise control of tone.
PHA Phaser A variety of vintage and cutting edge phaser effects, including ‘vibe.
PIT Pitch Shift Includes detune, harmonizer (intelligent/custom), whammy, and more.
PLX Plex Delay Up to eight delay lines interacting in a matrix. Gorgeous!
RES Resonator Resonant comb filters in parallel. Create chords and more.
REV Reverb World-class recreations of vintage springs, rooms, halls, and more.
RNG Ring Mod The extremely flexible ring modulator provides for a range of cool effects.
ROT Rotary Simulates a classic rotary speaker with multiple microphones.
RTA Realtime Analyzer Visually plots the frequency spectrum of an input signal.
SYN Synth A 3-voice monophonic synth that tracks what you play.
TTD Ten-Tap Delay Set the time, pan, and spacing of one to ten separate echoes.
TMA Tone Match Matches the Axe-Fx lll to the sound of an amp, recording, or device.
TRM Tremolo Creates classic trem, plus auto-pan or extreme psycho acoustic effects.
VOC Vocoder Digital re-creation of the analog classic. “Stop the human. Stop the intruder.”
VOL Volume/Pan Simple volume block also offers channel input/output tools.
WAH Wah The classic wah, with multiple types based on classic originals.

Each preset also includes a set of Controllers for automation, and a Scene MIDI block.
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EXAMPLE PRESET GRIDS

Several preset illustrations appear below, to explain how blocks are combined to form presets.
These illustrations are screen-captures from Axe-Edit Ill, rather than representations of the small screen.

Ex 1: Sweet and Simple. Wah. Drive pedal. Amp and Cab. Delay and Reverb. Notice the In 1 and Out 1 blocks.

Ex 3: An entire parallel chain for a shimmery, filtered effect with a VOLUME block for its own "Send" control.

=

| Bacsian | ]
1 |_ | L
e DLy Filber |

Ex 4: A complex preset with effects before and after two amps. A stereo cab feeds OUT 1 (Front of House), while
Output 2 taps the signal with NO cab for use with a neutral power amp & real guitar speakers (on-stage backline).

Ex 5: A more complex preset with two amps, parallel paths, outboard gear, and 4 each of drive and delay blocks.

(This preset is the first on this page to show some blocks which are bypassed.)
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EDITING EFFECT BLOCKS

Blocks are fully programmable, meaning you can dial in every setting as desired and save the result. The Edit
menu for every block contains one or more pages, each with multiple parameters to control various functions.
Here's a quick guide covering how to access and work with the different types of Edit menu pages.

OPENING AN EDIT MENU

» On the Layout grid, select the desired block and press EDIT.

» OR... from anywhere, press EDIT to jump right to the Edit menu for the

selected block (or the first block if none is selected).

TURNING PAGES

» Some menus have multiple pages, shown as
“tabs” at the top of the menu (red arrows, right).

» Tap the PAGE buttons to page left or right.

EDITING "KNOB"” PAGES

» Some Edit menu pages show rows of
up to five virtual controls like knobs,
switches or selectors. To make changes,
use the five knobs below the display.

» You will hear all changes in real time.
» Switch between rows using NAV UP/DOWN.

EDITING “MENU" PAGES

» Some pages have vertical lists of parameters.

» Use the NAV UP/DOWN buttons to step through
the list or NAV LEFT/RIGHT buttons to jump.

» The Aknob and the VALUE knob
operate the selected parameter.

» B, C,D, and E knobs control other parameters
in the list, as shown by labels on the list.

OTHER PAGE TYPES

» Some pages are arranged in rows and
columns. Some include interactive meters
or graphs. Use NAV and VALUE or AB,C,D,E
knobs to move around and make changes.

» For TYPE pages, such as Amp Type, just
NAV through the list to make a selection.
Selections take effect instantly.
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Chorus 1 Type [ Basic)] Expert Mix

Analog Stereo Scene:1 Channel: A - —

C 50.0 % )7
o 0 O O
Number Tempo Rate Depth Delay
Voices Time

(_CHANNEL - ) ( CHANNEL + ) (__BYPASS ) (__RESET

) (_MODIFIER )

Chorus 1 Type Basic [Expert] Mix
Analog Stereo Scene:1 Channel: A — r—
B High Cut 8000 Hz
C LFO Phase 90.0 deg
D LFO Type TRIANGLE
E Auto Depth LOW
Phase Reverse NONE
Drive 3.33
Width 50.0 %
LFO2 Rate 0.050 Hz
LFO2 Depth 0.0%
Stereo Spread ® 100.0%
(_CHANNEL - ) ( CHANNEL + ) (_BYPASS ) (_ RESET ) (_ MODIFIER )
Multiband Compressor 1 (Config] Mix
Scene: 1 Channel: A ] —
Low Mid High
Crossover Freq  500.0 Hz 10000 Hz
Threshold -80 db -20db -10db
Ratio 1.000 20.00 2.000
Attack 10.00 ms 10.00 ms 10.00 ms
Release 10.00 ms 1000 ms 500 ms
Level -20.0dB -6.00dB
Detector Fast RMS Peak RMS+Peak
Mute OFF o LOW MID HI
& Nav Value Value Value
(_CHANNEL - ) ( CHANNEL + ) (_BYPASS ) (_ RESET ) (_ MODIFIER )
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RESETTING A BLOCK/CHANNEL

Use RESET when you want a fresh start after making changes to a block.

» Ifitisn't already open for editing, select the desired block on the grid and press EDIT.

[ RESET ] » Press the RESET button (Push-knob D). You are prompted to reset the current channel.

» Press ENTER to confirm. You can reset other channels in a block as they are used.
Learn more about Channels in Section 6: Scenes & Channels.

SAVING CHANGES

After making changes to a preset, you may want to save the results. Here's how:

TO STORE A PRESET...
» Press STORE to show the STORE page.
» Press STORE again (or ENTER) to display “Do you want to overwrite the Preset?”

» Press ENTER again to confirm, or EXIT to cancel.
» The message “SAVED!" is shown when saving is complete.
What constitutes “making changes”? Obviously, parameter edits, but also changing the scene (see

Section 6: Scenes & Channels), and sometimes, when new firmware requires changes to be
made automatically, simply loading a preset can cause the edited light to turn on.

TO CHANGE THE PRESET NAME OR LOCATION...

The Axe-Fx Ill has 512 preset memory locations (1024 on the Mark I1).
You can edit the name of any preset while storing.

» Press STORE to show the STORE page.
» NAV down once to the PRESET line.
= Turn the B knob to move the cursor.
= The C knob selects upper case letters.
= The D knob selects lower case letters.
= The E knob selects numbers.
= The VALUE knob selects ALL characters, including symbols.
* You can use up to 31 characters in a preset name.
» You can also NAV to any Scene name to edit it in the same way.
» Press STORE again (or ENTER) and then press ENTER again to confirm.

» The message “SAVED!" is displayed and the new location (if any) is loaded.

Scene naming is a powerful capability. Aside from stating what a specific scene is intended for,
the names of un-used scenes can be used for short notes or reminders. Shorthand may help. For
example, a “slash” could indicate expression capability on an “External” controller:

“FB /1, Time /2" could show that Feedback is controlled by “External 1" and Mix by “External 2.
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PRESET CPU LIMITS

Each block you place in a preset contributes to the total CPU load for that preset. You can check the current load
at any time by viewing the mini CPU meter at the top of the grid.

The maximum allowable load is about 80%, and if you manage to get much above that, audio performance may be
compromised.

When inserting a new block would cause an overload, this is prevented and the message “INSUFFICIENT CPU" is
displayed. It is assumed that a new block will be used to its limit when making this determination.

If you are prevented from inserting a block because of CPU limits, you can remove an unused or less important
block. Adjusting certain parameters can also help. Beware of trying to set parameters back to higher values after
inserting the desired block. At extremely high CPU usage levels, the Axe-Fx Il may become unstable and/or Axe-
Edit may stop responding.

Here are a few of the common block parameters whose settings have a measurable effect on CPU usage:

= Amp: Output Comp: Set to "0" for the least CPU usage.

= Cab: Mute: The more IRs you use per block, the higher the CPU usage.
Cab Preamp and Room settings also affect CPU.

= Reverb: Quality and Echo Density. Lower = less CPU. The “Spring” type uses the least CPU.
= Compressor: Set Type to one of the "PEDAL' options to use less CPU.

» Phaser: Stages. Lower = less CPU.

= Filter: Order and Q. Lower = less CPU.

= Multitap Delay: Type. Different types have different CPU requirements.

= Modifiers also affect CPU usage.

= Synth : More voices = more CPU.

The Fractal Audio Wiki keeps a list of CPU saving ideas. Find it at:
https://wiki.fractalaudio.com/axefx2/index.php?title=Presets and_blocks.

CPU & USB

With its dedicated processor for USB, CPU usage is not increased when USB is connected.
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6 SCENES & CHANNELS

6 SCENES & CHANNELS
OVERVIEW

Before reading this section, please review “Intro to Scenes and Channels” on p. 9.

Every Axe-Fx Il preset contains eight Scenes. Scenes don't need to be added or created, and there’s no way to
delete them either—they're just there, ready for use. Think of a Scene like a “preset within a preset.” Scenes control
which blocks are on or off, which Channel each block is set to, and more.

There are many benefits to using Scenes. Selecting a Scene allows you to recall with one tap what would otherwise
require “tap dancing” across foot switches. Scenes load instantly and changes can be gapless and seamless, and
they offer the easiest way to ensure perfect “spillover” of time-based effects like delay and reverb.

The Channels feature is almost self explanatory. Most blocks have some number of channels (typically four), and
for each channel you can set every parameter of that block to any setting. It's like having multiple blocks in one.

WHAT SCENES INCLUDE...

= Each Scene sets the Bypass state of every block in the current preset.
= Each Scene sets the Channel of every block in the current preset.
= Each Scene has its own levels via the Scene Level settings in every Output block.
= Each scene has its own settings for four Scene Controllers (See p. 63).
= Scenes can use the Scene MIDI block to send MIDI
messages. See “Sending MIDI” on p. 100

= Scenes interact with FC controller “Control Switches”
(See Section 13: FC Controllers).

= FEach Scene also has its own Name.

WHAT SCENES DO NOT INCLUDE...

In short? Everything else. Scenes only affect the items listed above. Scenes cannot change which blocks are
placed on the grid, or change the grid routing. You cannot tweak effect parameters per Scene (except through
Scene Controllers), but remember, you can switch Channels.

WHAT EACH CHANNEL INCLUDES...

Each Channel stores its own settings for every parameter in the block. This gives you up to four independent
sounds from a single block. Note that just like on a traditional pedal or processor, time-based blocks such as
Delay and Reverb share one set of memory across different channels, so you may hear a “sweep” if you change
time or size. To avoid this, just use different blocks from scene-to-scene.

F AQ. WHY NOT JUST CHANGE PRESETS? Preset changes give you total

® flexibility. You can change anything and everything in every preset, but there are also
drawbacks. Synchronizing multiple presets is tedious, it takes care to get levels and spillover just right, and
while preset changes are fast, Scene changes are even faster and can be seamless.
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CHANGING CHANNELS

Different areas of the Axe-Fx Il provide different ways to change Channels:

= On the GRID - Select the desired block and turn the Channel knob (B).
The current Channel is shown above the knob.

= While EDITING a BLOCK - Use the dedicated CHANNEL - and CHANNEL + buttons.
The current channel is shown near the top center of every page in the Edit menu.
= FC CONTROLLER - The FC Controllers offer a range of dedicated “Channel” functions.
= MIDI - MIDI and other Global Controllers such as a connected external footswitch can be

|n

used to select Channels. See “Selecting Scenes & Channels Remotely” on p. 46.
» Of course, Axe-Edit can also be used to change channels.

SETTING UP CHANNELS

Whenever you edit a block, you are already programming at least one Channel (usually Channel A). Programming
additional channels is easy: simply select the desired channel as described above and use your usual methods to
set the various parameters to their new values. Repeat for each Channel in the block and then save the preset.

TO COPY A CHANNEL...

The Tools page of the Layout menu (“grid”) provides a utility to copy one Channel to another. This works within a
single block only; you can’t copy a Channel from one block to another, or from one preset to another.

Navigate to the Tools page of the Layout menu (grid).

Turn the VALUE wheel until “COPY CHANNEL" is shown on the display.

Use the D knob to select the scene you want to copy from. Channel letters are shown above the knobs.
Use the E knob to select the location you want to copy to.

Press ENTER or the on-screen EXECUTE button (Push-knob C) to complete the copy.

Test your preset and remember to STORE to make the changes permanent.

S gk wbh=
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SELECTING SCENES

Different areas of the Axe-Fx Il provide different ways to select a Scene.

= On the Home page - Use the NAV UP/DOWN buttons or turn knob A. The current scene is highlighted.
= On the GRID - Turn the Scene knob (A). The current scene is shown above the knob.

= FC CONTROLLER - The FC Controllers offer a range of dedicated “Scene Select” functions.

= MIDI - MIDI and other Global Controllers such as a connected external footswitch can be

used to select scenes. See “Selecting Scenes & Channels Remotely” on p. 46.
= Of course, Axe-Edit can also be used to select Scenes.

SETTING UP SCENES m

When you create or edit any preset, you are working with at least one Scene. To set up additional
scenes, simply select the desired Scene and use the usual methods to turn effects ON or OFF and
select channels, then save your changes. Here are step-by-step instructions:

TO SET UP A NEW SCENE OR EDIT AN EXISTING ONE...

1. Load the desired preset and select the desired Scene.
2. Bypass or engage each block as desired.
= On the Layout (grid) or while editing any block, use the BYPASS button (Push-knob B).
= Oruse any assigned footswitch or remote controller to bypass/engage the block.
3. Set the Channel for each block as described on the previous page.
4. Test and save your preset. On the STORE page, NAV to your new scene and give it a name (see p. 41).

Always carefully test ALL scenes in your preset—even those you think you might not use.
Ensure that there are no undesired volume jumps or other surprises waiting to happen.

TO COPY ONE SCENE TO ANOTHER...

The Tools page of the Layout menu contains a tool to copy one scene to another. (not including the scene name).
This works within a single preset; you can’t copy a scene from one preset to another.

1. Navigate to the Tools page of the Layout menu (grid).

Turn the VALUE wheel until “COPY SCENE" is shown on the display.

Use the D knob to select the scene you want to copy from. Scene numbers are shown above the knob.

Use the E knob to select the location you want to copy to. You can also choose to copy one scene to “ALL".
Press ENTER or the on-screen EXECUTE button (Push-knob C) and the copy operation is completed.

Test your preset and remember to STORE to make the changes permanent.

Axe-Edit makes it even easier to set up and copy scenes, with useful tools and a dedicated “Scenes Manager.”

S gk wbd
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SELECTING SCENES & CHANNELS REMOTELY

Scenes and Channels can be selected using MIDI or Global Controllers. Switches but not pedals are

recommended in this case (though switches can be plugged in at “Pedal” jacks). Several options are provided.

SCENE INCREMENT AND DECREMENT

The Scene Increment and Decrement functions allow you to step up or down through scenes one at a time. You
must first assign each function its own CC# or pedal/switch option in the MIDI/Remote menu. The function is

triggered by any value of the controller.

SCENE SELECT

This option uses the value of a controller to select a specific Scene. You must first give the
Scene Select function its own controller in the MIDI/Remote menu under SETUP.

The scene is set by the value of the controller (not the controller number itself... see FAQ below).
Values begin at 0, while Scenes are numbered from 1, so “Value plus one = Scene number”
(see table 1, right). The series continues, repeating scenes 1-8 across CC values up to 127"

EXAMPLE: Let's say you want your DAW to select scene 3. Open the MIDI/Remote menu and
assign your desired CC# to “Scene Select”. Let's say CC#34. Set your DAW to send CC#34 with a
value of “2”, which loads scene 3.

CHANNEL SELECT

This uses the value of a controller to select a specific Channel. Each block has its own dedicated
setting for channel select, found across the listings on the Channel page of the MIDI/Remote
menu under SETUP.

The Channel is set by the value of the controller (not the controller number itself... see FAQ
below). Values begin at 0, which is Channel A, and it continues from there. (See table 2, right).

As with Scene Select (above) the series continues, repeating Channels A-D across values to 127.

1 In mathematical terms, that's Scene# = [(CC Value mod 8) +1]

TABLE 1

CC Values, Scenes.
0 =Scene 1
1= Scene 2
2 = Scene 3
3 =Scene 4
4 =Scene 5
5=Scene 6
6 = Scene 7
7 =Scene 8

TABLE 2

CC Values/Channels
0 = Channel A
1 =Channel B
2 = Channel C
3 = Channel D

@ MIDI Control Change messages —aka “CCs"~ have a number (0-127) and a value (0-127).

F AQ ~ MIDI CC Number and CC Value... What's the difference?

The number is like an “ID” specifying which function you want to control. A simple example
might be a MIDI expression pedal that sends CC#7 which is interpreted as Volume by a device. The Axe-Fx IlI

lets you designate CCs for items in a long list found in the MIDI/Remote menu under SETUP.

Once a CC# is set to control a function, its value tells that function what to do. Some functions—like Volume—
interpret data across a continuous range from 0-127. Other functions—like Bypass—simply toggle OFF for a low

value and toggle ON for a high one. Other functions might be triggered by any value.

Different types of physical controllers transmit values in different ways. A pedal that rocks continuously from
heel-to-toe sends a “stream” of values from 0-127. A switch sends a single value for OFF (typically 0) and

another for ON (typically 127). Other MIDI controllers offer other options.

As described above, both the CC number and its value are the key to selecting Scenes and Channels via MIDI.
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PROGRAM CHANGE MAPPING

Another way to select Scenes via MIDI is using Custom PC Mapping, which allows a single incoming MIDI
Program Change (PC) message to select your choice of both Preset and Scene. This is a popular option in cases
where a connected MIDI foot controller lacks the sophistication to transmit the MIDI messages required for scene
selection.

The PC Mapping parameter on the General page of the MIDI/Remote menu under SETUP must be enabled for
custom mapping to be in effect. With this option set to “ON”, an internal table re-maps each incoming MIDI
Program Change message so it can load your choice of preset and scene. The map is limited to 128 entries so
MIDI BANK SELECT messages are ignored while PC Mapping is enabled.

With PC Mapping option set to “OFF”, MIDI Program Changes load presets on a 1:1 basis and Bank Select
commands are processed as usual as per “MID| Reference Tables” on p. 106.

BUILDING THE MAP
The mapping table is on the Mapping page of the MIDI/Remote menu under SETUP.

To use it, follow this simple process:
1. NAV to the row for whichever Program Change message you want to re-map.

2. Use the B knob to set the desired value for Map to Preset.
This is the preset that will load when the selected Program Change message is received.

3. Use the Cknob to set the desired value for Map to Scene. You can choose a scene by its number, or select
“AS SAVED" to load the default scene saved in your preset. (see p. 45 for more on Default Scene).

4. Repeat steps 2 through 4 for any remaining Program Change messages you wish to remap.
5. EXIT when finished. You do not need to store settings in the SETUP menu.

The custom map parameters remain intact even if you switch PC Mapping Off.

SENDING MIDI WITH SCENES

Scenes can also transmit MIDI. See “Sending MIDI” on p. 100.

SCENE LEVELS

Each of the Output blocks includes eight parameters that allow you to cut or boost the level for any scene. Using
these adjustments is a quick way to balance or boost scene levels when other level options are not available.

THE DEFAULT SCENE

When a new preset is loaded, it automatically starts on whichever Scene that was selected when that preset was
last saved. To set the default scene for any preset, simply select the desired Scene and then save the preset.

You can also select a fixed “Default Scene” under Setup: Global Settings: Config. This overrides the last-saved
scene and causes your selected scene to load first for all presets.
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SCENES, CHANNELS & MODIFIERS

The Modifier system provides extensive automation and remote control of parameters on the Axe-Fx Il

Modifiers are detailed in Section 9 on p. 53 but here is a summary of important information about Scenes,
Channels, and modifiers.

SCENE CONTROLLERS

Block parameter values are the same in every Scene of a preset. Of course, you can change the Channel, which is
great but not the same thing. The Scene Controller system, however, provides a way for individual parameters or
groups of parameters to have different values in every scene.

See “Tutorial: Scene Controllers” on p. 63.

CHANNELS & MODIFIERS

Modifiers are shared across Channels, meaning that any modifier you create in one channel will be present on all
channels of that block. This is a great convenience in most cases, avoiding the need to apply the same modifier
multiple times as you change channels.

In some cases, you may notice that if you change an effect Type from one channel to the next, certain parameters
are either not present at all, or appear with different names. For example, in the Delay block, the Mono Tape delay
has a parameter called “Head 2 Ratio”, while this same parameter is called “L/R Time Ratio” in the Dual Delay.
These differences are such that results should not be unpredictable.

SCENE REVERT

Scene changes you make from the Axe-Fx Ill front panel (or Axe-Edit Ill) remain in effect until you save them or
discard them by loading a different preset without saving. Changes made via footswitches or MIDI, however, may
work differently, depending on a Global setting called Scene Revert. With Scene Revert turned on, Scene changes
are discarded as soon as you load a new Scene. Here are two examples so you can compare how Scene changes
work in both modes:

Ex 1: SCENE REVERT OFF (default) Ex 2: SCENE REVERT ON

1. You load SCENE 1. DRIVE 1 is OFF. 1. Youload SCENE 1. DRIVE 1 is OFF.

2. You turn DRIVE 1 ON with a Footswitch. 2. You turn DRIVE 1 ON with a Footswitch.
3. You change to SCENE 2. 3. You change to SCENE 2.

4. You change BACK to SCENE 1. 4. You change BACK to SCENE 1.

5. Drive will be ON as you last left it. 5. Drive will be OFF as you last saved it.

TO ENABLE/DISABLE SCENE REVERT...

1. Page to the General page of the MIDI/Remote menu under SETUP.
2. NAVto SCENE REVERT and set it “ON” or “OFF" as desired.

3. EXIT to finish. (You do not need to STORE changes in SETUP)
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7 LEVELING PRESETS

This section is about balancing levels across Presets, Scenes and Channels. It is not about correctly setting
overall input and output levels.

Balancing levels requires both knowledge and tools. The challenge of getting levels “right” is not unique to the
Axe-Fx Ill. Guitar players and audio technicians face the same obstacles when using traditional equipment: our
hearing, speakers, and surroundings are all variable. On a platform as powerful and flexible as the Axe-Fx llI, the
number of options that affect volume can be daunting, but fortunately there are some good rules of thumb, all
backed by a number of precision controls and meters. This section aims to provide a method you can rely on to
normalize the levels of Presets, Scenes and Channels.

GENERAL PRINCIPLES

» Our ears deceive us. The “equal-loudness contour” or “Fletcher Munsen” effect causes
us to hear tonal balance differently as volume levels change. At lower volumes, low
and high frequencies seem to be relatively quieter. Check your sounds at various levels,
especially “gig” volume, and strive to learn more about this phenomenon.

» Different speaker systems have different frequency response, which affects our
perceptions of tone and volume. Set levels on the same system you will perform through
— ideally, the best and most accurate speakers you can attain. Be prepared to make
adjustments on other systems, and this goes for your tone as well as your levels.

» Context, including other sounds and the environment itself, also change perceptions of loudness.
Two different guitar sounds may seem to be equal in level when you audition them alone, but
might then sound totally different when they are “competing” in a mix against other instruments
such as bass and drums, or when played in a problematic performance space. Don't be
surprised if you work alone to level sounds and then find things sound different on stage.

THE RULE OF THUMB

Challenges aside, it's important that you know how to adjust levels on the Axe-Fx IlI.

» There are a lot of different ways to adjust level on the Axe-Fx Ill. A good rule of
thumb is to use the Level parameter of the Amp block. See “The Method” on the next
page for an a process that works across Presets, Scenes and Channels.

» Above all, use common sense. Rely on meters, but don't set levels solely on how they look. USE YOUR EARS!

EXCEPTIONS TO THE RULE

» When following the Amp block(s) with any level-dependent dynamic effects, such as a compressor
or gate, you will need to re-adjust those blocks after changing amp levels. A better option may
be to “bend” the rule of thumb and adjust the output of the last dynamics block instead.

» This is also the case for any nonlinear effects such as drive which may in rare cases (such as Tape
Saturation or Bitcrusher effects) be placed after the amp. Adjust Level for these blocks instead of the amp.

» If you have prominent Drive/Saturation in the Preamp simulation of the
Cab block, adjust the Level of the Cab block instead.
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A METHOD FOR LEVELING

The grid provides excellent tools for leveling presets, scenes, and channels. While the grid is zoomed out
(press knob A) you will see VU meters for Outputs 1 and 2 at the top of the display. The scale of these meters
is -20 to +10 dB with a red line at 0. (This is the internal level, NOT a dBu reading.) These meters are great for
setting levels.If you page from the Edit page to the Meters page, input (blue) and output (green) meters on each
individual block will help you spot any trouble or gain staging issues.

Edit Meters  Tools cPu Edit Meters  Toals

(> Scene: 1 Channel Block Level Row Column (> Scene: 1 Channel Block Level Row Column
| Z00M J BYPASS DELETE CABLE CONTROLLERS | Z00M J BYPASS DELETE CABLE CONTROLLERS

The zoomed out grid shows VU meters atop the screen. Page right to the Meters page for block meters.

To set levels, play your guitar and watch the top VU meters. Remembering the rule of thumb (see previous page)
navigate to the Amp block and adjust its level by turning the Block Level knob (C). The VU meter should hover
around at the red line. Different types of playing and different amp models and settings will activate the meter in
different ways. “Chugs” for instant, will usually hit the hardest. If you want to compare the levels of two presets/
scenes/channels, play the same type of material while watching the meters. Remember the principles on the
previous page; trust the meters, but use common sense.

TIP: When using two Amp blocks at the same time, you may find it easier to adjust levels in a single block which
sums their outputs, such as a Cab, Mixer, or Volume.

The Layout view allows you to change Scenes (knob A) and Channels (knob B), so you can compare and adjust
everything all within a single page.

LEADS AND LOUDER SOUNDS

Given a method established for normalizing the level across Presets, Scenes, and Channels, what if you
specifically want some sounds to be louder or quieter than others? The best approach is to not boost the loudest
sound but to make the others quieter. This helps prevent clipping that might happen if you make some sounds
too loud. When using this method, use the meters and your ears. It is perfectly fine for some tones to appear very
quiet; Fractal Audio products have an excellent signal to noise ratio and do not suffer internally from the same
degree of problems as analog gear when operating at lower than ideal levels.

Place the looper between the input and your first block.

@ Make it easier to adjust levels by using the Looper block to “play” while you operate the level controls.

| Inl | Lnl:-p:r | Drive | | Mg | | Cab | | Delay
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BLOCK BYPASS LEVELS

Not just amps and cabs, but block effect settings also contribute to preset levels. Here are some tips to help dial
in effects, so that levels can remain consistent as you bypass or engage blocks.

» Learn more about Bypass Modes in “The Fractal Audio Blocks Guide”

» Sometimes, effects are intended specifically to boost or cut levels. Other times, you want the volume to
stay the same as an effect is dialed in. In either case, there’s an easy method you can use to make correct
settings. First, with the effect engaged, dial in the Mix so the blend of wet and dry sounds is as desired. Then,
with one hand on the block’s Level parameter and the other on its Bypass button (Push-knob C), switch the
effect on and off, making level adjustments until the desired volume is achieved when the effect is engaged.

» Time-based effects like delay and reverb are usually best with their Bypass Mode set to “MUTE FX
IN". This ensures that dry levels remain consistent when you engage or bypass the block. Because this
setting masks possible changes to your “dry” signal, you should use the Meters page of the Layout menu
to ensure that the level is roughly the same before and after these effects when they are bypassed.

» Pitch effects require special consideration. Depending on their particular type and
settings, you may wish to treat them like a time-based effect with the “MUTE FX IN”
setting, or you may wish to set Bypass Mode to “THRU" and use the first method.
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8 BLOCKS GUIDE
THE FRACTAL AUDIO BLOCKS GUIDE

Both the Axe-Fx Il and our floor-based modeler FM3 use presets built from blocks, and the blocks on both
devices share many of the same parameters and settings. A separate manual covers these blocks in complete
detail. More than a simple reference, it contains background information, tips, and extra material to help you
make the most of your Axe-Fx or FM3.

The Fractal Audio Blocks Guide can be downloaded from https://www.fractalaudio.com/fas-bg

ﬁHAETﬁ.L
JALELISL BmY N T E M

BLOCKS GUIDE

Complete Referance for
Blocks and Pasameiers
N e Aae-Fx 11 & FMG

Blocks Guide
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9 MODIFIERS

Modifiers can be one of the most exciting features on the Axe-Fx Ill. They allow sound parameters to be remote-
controlled or automated in real time. For example, you might use an expression pedal to operate a wah or
whammy, or use an LFO (Low Frequency Oscillator) to auto-sweep a filter. MIDI can also be used to adjust effects,
control volume, and more. Modifiers are easy to use, but offer incredible depth of power for those who like to
push the limits.

CREATING A MODIFIER

The process of creating a modifier begins at the parameter you want to control. Parameters that can be controlled
are marked with an open yellow circle, as depicted below. When a modifier is already present, the circle will be
solid, like an LED that has been turned on. You will see the same symbol whether the target parameter is on a
knob page, a text page, or any other type of menu.

() () 0

Balance Treble
The open circle The filled circle  Here, a switch This parameter
meansyoucanadda  means a modifieris  instead of aknob has no option for a
modifier here. already present. allows a modifier. modifier.
TO CREATE A MODIFIER...

» Select any parameter that supports a modifier.
» Press the ENTER button or the MODIFIER Push-knob to show the Modifier menu.

» The menu has three pages. The first two are Source pages, determining
which control SOURCE should affect the parameter.

= Select the desired option on the Source 1 page, such as “External 1" or “LFO1".
= Source 2 is used only for advanced applications, so you will be working with Source 1 in most cases.
= Learn more about Sources on p. 55.

» Press PAGE RIGHT to switch to the Modify page. This page contains all of the parameters related to the
interaction between the source and the parameter. Learn more about these options on p. 56. At a
minimum, check that MIN and MAX are set to the lowest and highest values desired. You can test at any time.

» Press EXIT to leave the modifier menu.

» Test your modifier. Modifiers animate on-screen knobs, faders switches and graphs.
For text-only menu parameters, a bar graph shows the value of the source.

» Modifier changes are saved when you STORE the preset.

TO EDIT OR REMOVE A MODIFIER...

» To edit an existing modifier, use the same process as creating a modifier.
» To remove a modifier, change its SOURCE(s)to “NONE".
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MODIFIER TUTORIAL: WAH PEDAL

Here is a basic step-by-step tutorial on setting up a modifier for a classic Wah pedal.
For this example, we assume:

= A Wah block is already in your preset (if not, see
= You have an Expression pedal ready (See “Global Expression Pedal Setup” on p. 13)

Here are the steps:
On the Grid, NAV to your Wah block and press EDIT to show its menu. @
Turn to the Config page of the Wah block’s Edit menu. Wah

Notice the yellow Modifier dot symbol beneath the on-screen Wah Control parameter. Contraol
NAV to select that parameter (or just give its knob a twiddle). It will be highlighted when selected.
Press ENTER or the MODIFIER Push-knob to show the Modifier menu.

On the Source 1 page, change the SOURCE to your pedal. If you followed the instructions on p. 13, this
will be “EXTERNAL 1”. The hardware pedal jacks can also be used directly.

7. Test! The Wah should work when you move the pedal. You'll also see the dot move on the graph. If it
doesn’t work, check your source or make sure the pedal is properly connected and calibrated.

8. Save the preset by pressing STORE, ENTER, ENTER.

The Wah in this example is controlled by an expression pedal. An expression pedal can be used to control other
parameters like whammy control, rotary rate, delay feedback, and many, many more.

A A T o

There are also many different sources we could use instead of a pedal. Try an LFO for a modulating auto-wah, or
an Envelope Follower for some funky Mu-Tron action. And MIDI opens up a world of controller options.
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MODIFIER SOURCES OVERVIEW

There are 70+ different choices to use as modifier sources.

INTERNAL CONTROLLERS LFO 1 LFO 2 ADSR1 | [ADSR2

A A

Internal controllers are a part of every Axe-Fx IIl preset. /\/\/\ /\/\/\ /\" s /\
N

You will find two LFOs (Low Frequency Oscillators), two
ADSRs, a Sequencer, a Pitch Detector, an Envelope
Follower, four Scene Controllers five Manual Controllers.
(See p. 59). Tempo is also in the controllers block. 000000 0000

000060 o ol | |° |0 |
To show the Controllers menu, press the CONTROLLERS M I ©0oce

button on the Home page (Push-knob C) or Layout menu
(E), or press the TEMPO button once. EXPRESSION — SWITCHES —

ONBOARD & FC PEDALS & SWITCHES ‘ ; ne o o
The Expression jacks of the Axe-Fx lll and the Pedal

or Switch jacks of a connected FC-6 or FC-12 can be

assigned directly as modifier sources. In comparison to

previous products, it is no longer necessary to assign —— PEDALS ———

these to an External Controller first (though this is still 1 o 3 4

possible and even recommended).

connected FC to be used directly as modifier sources. <.: > <<l: >> <.: > <.: >

See your FC documentation for more on these.

EXTERNAL CONTROLLERS (e [ee] e [en] [ [se] o] [se] ] o] ] e [ ][] o]

External Controllers are proxy or “go-between” sources. They each have their own global setting to determine
what controls them. You can set them up to be controlled by your choice of:

Sequencer Pitch Envelope Scene Ctrl

Control Switch functions also allow the switches of a

= Any MIDI Control Change (CC#) message.
= One of the onboard Expression (Pedal) jacks.
= One of the Pedal or Switch jacks of a connected FC series controller.

In comparison to Internal Controllers or Onboard & FC Pedals and Switches, external controllers act like a “go-
between” as illustrated below.

Internal Controller or Onboard Exp Jack External Controller
Source Parameter “Source” External Controller ~ Parameter
(e.g. PEDAL 1) (e.g. PEDAL 1) (e.g. External 1)

External Controllers are a great choice for presets you might share, because different people will use different
controllers in different setups.

Example: you send your friend a preset containing a Wah operated by External 1. On your system, External 1 is
globally assigned to “PEDAL 1"— one of the onboard expression jacks. On your friend’s system, External 1 is
assigned to “CC#16" because an older MIDI controller is being used. The Wah works perfectly on both rigs with
no changes required! Learn more about External controllers on p. 61.
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MODIFIER PARAMETERS

The Modify page of the modifier menu contains parameters to determine the nature of the relationship between
the source(s) and the parameter. By default, a modifier is linear: the parameter value moves in direct proportion
to the source. By changing this relationship, you can create a variety of desirable effects. For example, you might
adjust the “taper” of the change, reverse its effect, or smooth the changes over time. Here is an overview of the
additional parameters you can use to create these effects and many more.

The Channel setting determines whether the modifier will be enabled on ALL channels or just on one channel
(A,B,C or D). There are many creative uses for this, including effects which auto-engage only when set to a
particular channel where their modifier is active.

The Source 1 Scale, Source 2 Scale, and Operation parameters are for dual source modifiers.
See p. xx for more.

Min and Max determine the range of parameter change. These are extremely important parameters.

EXAMPLE: The modifier for a pedal controlling Delay Feedback has Min at “10%" and Max at “50%". The
feedback sweeps only from 10% to 50 as the pedal is moved, even though this parameter’s actual range is
from -100% to +100%.

Start, Mid, End, Slope, Scale, and Offset are used to create custom curves which re-map the source to the
target. On the Modify page, a graph shows the relationship between the source (x-axis) and the parameter
(y-axis). A dot on the graph tracks the source. The default settings (first graph below) create a 1:1 linear
relationship (the blue line) between source and parameter. As the source changes, the parameter tracks it directly.
The second two graphs below show just a few examples of the kinds of non-linear curves you can create using
Slope, Scale, and Offset. The pages which follow contain more examples.

Parameter —»

Sourée—)

Damping, Attack and Release: These are used to slow the rate at which the target parameter value “chases” the
source. At low settings, these add just a little smoothing. Try settings of about 5 ms to “relax” a pedal or to ease
a square LFO to eliminate clicks and pops, or use higher settings for slow, lazy changes. Increase Attack to slow
the change as the source is increased. Release controls the rate as the source decreases. The Damping type
parameter determines if damping happens in a linear (constant) or exponential manner (slowing as the source
reaches the extremes.)

Auto-Engage works with Off Value to create effects which turn ON or OFF automatically whenever the source
controller is moved. This is typically used with a Wah pedal so you don't need a toe switch. (Follow the example
on p. 54 and set AUTO-ENGAGE to “SLOW POS" to try it out!) See also Auto-Engage on p. 58.

PC Reset sets the value for an external source when a preset first loads. This allows you to override the actual
position of an external controller until it is moved or updated. To set the default value: after applying the modifier,
exit to the Edit page. Notice that the value of that parameter can be edited as usual. If PC Reset is ON, the value
you set and then save will be used from preset load until the source is changed (i.e. the pedal has been moved).

Update Rate controls how often the modifier is refreshed. The setting of slow is actually very fast, and fine

for the majority of applications. The faster settings require additional CPU but provide even smoother sound
performance when ultra fast changes are required (while using a fast LFO for instance). Check this setting if you
think you hear “zipper noise” while a modifier is in use.
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UNDERSTANDING MODIFIER MIN AND MAX

MIN and MAX set a range for the parameter under control. This lets you fine-tune modifiers in very cool ways. In
the example below, imagine a volume pedal with different settings. Using the principles on this page, you should
be able to achieve a wide range of modifier control scenarios.

Mid: 50.0%  End: 100.0%

- x Max: 10.0
: The pedal “start” (heel position) sets the volume to

. Min: 0.00; silent. The pedal “end” (toe down position)

has the volume at Max: 10 or all the way up.

As you rock the pedal forward, the dot follows the line.

It moves up as it goes and the volume does too.

Here is your basic “vanilla” volume pedal.

Start: 0.0%
‘ Min: 0.0

Max: 10.0

Now, something different: a “boost” pedal with Min set
to 8 and Max still at 10. In the heel position, the volume
will go only as low as 8, instead of 0 as in the previous
example.

Here is a different twist: Min is at 10.0 — the loudest
setting, while Max is at 0.0 — silent.

It looks the same, but this is a reverse volume pedal!

Min: 10.0

USING “MID” TO CREATE BASIC CURVES

Let's imagine a modifier on the feedback of a delay to demonstrate changes to response curves. By now you
should be familiar with the default settings, so let’s skip right to the curved version:

Mid: 25.0% End: 100.0%
\ h Max: 100% As we adjust Mid, the graph shows the curve. At 25%,
5 5 x Max: ° the response is “tapered” so that with the pedal half
| way forward, Feedback is only 25% between Min and
Max.

This type of curve provides gradual control of feedback
: across the lower end of the range, and then a more
v Min: 0% rapid change towards the top.

Start: 0.0%
<€
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ADVANCED MODIFIER CURVES AND SHAPES

You can also adjust Start, End, and Slope (which introduces an “S” or “backwards S” shape). The numbers
beneath each example below show the settings for Start, Mid, End and Slope. With a bit of experimentation, you
will learn to achieve desired modifier effects quickly. Try dialing in the shapes below for practice:

0,75100 50 100,50,0 50 0,100,0 50  0,50,100 0 050,100 100 0,25100 10

Scale and Offset also re-map modifier response. Scale adds vertical exaggeration or compression, while Offset
moves the entire curve up or down on the Y-axis. Segments outside the graph boundaries will be clipped and
replaced by line segments. The examples below show some interesting possible applications.

: : : : 1
5 5 START:  0.0% START:  0.0% START:  47.2%
cereernsseeifflenssnnnnnnns ............. MID: 50% ............. ............. MID: 50% .............. ........... .| mID: 0%
5 5 END:  100% END:  100% END:  60.6%
........................................ SCALE: 2.0 oo | SCALES 0.0 ) Ef..|| SCALE: 10.0
OFFSET: 100% OFFSET: 0% OFFSET: -100%

AUTO-ENGAGE TURNS EFFECTS ON/OFF AUTOMATICALLY

If you have used a Wah pedal with no toe switch, you will recognize “auto engage”. This type of effect turns on
automatically when you rock the pedal forward it and then bypasses when you pull the pedal back. Auto-Engage
allows you to set up any effect like this: wah, whammy—you name it.

Auto-Engage engages or bypasses a block when the Source of a modifier changes. Once you try it, we believe you
will quickly find that this capability comfortably eliminates the need for an expression pedal “toe switch,’

Set up Auto-Enage using two parameters on the Modify page:

Auto-Engage - Determines whether or not the block will automatically engage or bypass. FAST, MEDIUM and
SLOW settings determine how quickly the effect turns ON/OFF once Auto-Engage is triggered. Use SLOW settings
to “relax” auto-engage, so your effect doesn't switch off too suddenly while you're still using it.

= The three POSITION (“POS") options trigger the effect based on OFF VALUE (see below).
= The three SPEED (“SPD") options engage the effect when the controller is moved quickly.
= Setto “OFF” to disable Auto-Engage.

Off Value - Sets the position threshold that the source must cross for auto-engage to occur. When Off Value is
set below 50%, the effect is bypassed when the controller goes below that value. If Off Value is set to 50% or
higher, the effect is bypassed when the controller goes above that value.

For “heel down = bypassed”, set to 5%. For “toe down = bypassed”, try 95%.

MODIFIERS AND CHANNELS

Remember, a modifier is normally shared across all of the channels of the block where it exists. However, you can
also limit it to operating on just a single channel—your choice—by using the Channel setting in the modifer menu.
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9 MODIFIERS

Internal Controllers can be programmed per-preset for use as modifier sources. To access these parameters,
push the CONTROLLERS button on the Home page (Push-knob C) or press TEMPO.

TEMPO Tempo appears in the Controllers menu. For more information, see Section 10: Tempo.

LFO1 & LFO2 LFo

A Low Frequency Oscillator (“LF0") AN
generates control signals in the form of

a variety of wave shapes. Examples of LFOs in use
include the pulse of a tremolo, the back and forth
sweep of a phaser, or the random filter in Ship Ahoy
by Frank Zappa.

Type sets the shape. You can set the Rate or lock the
LFO to the current Tempo. You can vary the overall
Depth and Duty, or symmetry. The Run parameter
starts and stops the LFO. This can be used to keep it
from drifting out of time.

Each LFO outputs “A” and “B” signals, each of which
is an independent modifier source on the list. You
can change the Phase of output B with respect to A.

Quantize changes smooth waveforms into stepped

ADSR1 & ADSR2 ADSR

A AP

The two ADSR sources are envelope generators s«
with Attack, Decay, Sustain and Release
parameters (thus “ADSR”"). The ADSR is triggered
whenever the signal level exceeds its Threshold measured
at the selected input (1 or 2). The envelope has three self-
explanatory modes (Once, Loop, and Sustain) and can
optionally be set to Retrigger every time the threshold is
exceeded. A Type parameter selects between Linear and
Exponential curves.

In comparison to the Envelope Follower, the ADSR
envelope generator always creates the same control
signal, but only triggers when you play hard enough.

PITCH DETECTOR pitch

Detector

The Pitch Detector analyzes the pitch of

ones. Try it on the “TRI” waveform for example. your playmg and outpu‘ts a low value for IIIIIII
low notes and a high value for high notes.
SEQUENCER Sequencer SCENE CONTROLLERS ry—
The Step-Sequencer generates control 000000 . 0000
. Canu 000066 The four Scene Controllers provide a way
patterns by looping through 2-32 “stag- to change sound settings from one Scene 0000

es.” You set the Value for each stage, the

Number of stages, and the Rate or Tempo. The Run
switch allows you to start or stop the sequence.
Damping slurs the change between steps.

ENVELOPE FOLLOWER Envelope
This converts input level to a control signal,|!'ower
responding variably to your playing dynam- |B——
ics. The classic example is a touch-wah,

where the frequency of the wah varies based on how
hard you play. You can set Attack and Release times
independently, set the trigger Threshold, and adjust
the Gain at the trigger signal input, which can be set
to Input 1 or Input 2.

a way to copy/paste Controller channels.

to another. Think of each Scene Controller

as a “virtual knob” whose setting can programmed
with a different value in every Scene. By assigning
this knob as a modifier source, you can create “per-
scene” parameters.

For example, you might assign Scene Controller 1 to
Input Drive in the Amp block with a value of 10% in
Scene 1, 50% in Scene 2, 75% in Scene 3, and so on.

As with any source, a scene controller can be
assigned to multiple parameters at the same time,
each with its own modifier settings.

A Scene Controllers tutorial appears on p. 63.
For more on Scenes, see Section 6 on p. 43.

The Internal Controllers menu offers four channels for four sets of independent settings for ALL of
the items listed above: four tempos per preset, four sequencer settings, etc. When you change the
channel, ALL of the controllers switch to the new channel and the new settings. Axe-Edit Ill provides
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MODIFIERS

MANUAL CONTROLLERS

The five Manual Controllers are virtual knobs with no function other than to serve as modifier sources. A
Manual controller makes it possible, for instance, to create a “super control” where one knob operates multi-
ple sound functions at the same time. For example, you might assign delay mix, reverb time and chorus depth
parameters — all at the same time — to the “Manual 1" modifier source. Now, when you adjust Manual 1, all of
the above parameters will change simultaneously as desired.

Another good use for Manual Controllers is to simulate an expression pedal when you do not have one handy.

Change the value of a Manual Knob in the Controllers menu, or, for a more accessible option, place on one of
the Performance Control pages (see p. 94).

TUTORIAL: MANUAL CONTROLLERS

In this tutorial, we will set up a Manual Controller to adjust the Feedback and Mix of a Delay block.

1.
2.

© N o gk~ w»

1
1
1
1
1
1

1

1

Load the factory preset “#022 Super Verb” and turn on the Delay block.

The first step in using a Manual Controller is to assign it as a Modifier Source to the parameter of your
choice. Enter the Layout grid of the preset, navigate to the Delay block, and press EDIT.

Use the PAGE buttons to locate the Config page of the Delay block.

NAV to the Feedback parameter and notice the open yellow modifier “ring” beneath the knob.
With the Feedback parameter highlighted, press ENTER to display the Modifier menu.

On the Source 1 page, select Manual 1.

Page right twice to the Modify page. Set Min to 0% and the Max to 50%.

Press EXIT to return to the Delay menu. Notice that the open modifier symbol is now a solid yellow dot.
NAV downto the Mix parameter and press press ENTER to display the Modifier menu.

0. On the Source page, select Manual 1.

1. Page right to the Modify page. Set Min to 5% and the Max to 75%

2. Now let’s try the Manual Controller. Press HOME to show the home page.

3. Press the CONTROLLERS button (Push-knob C).

4. Use the PAGE buttons to locate the Manual page of the Controllers menu.

5. Turn knob A to adjust Manual 1 and listen to your delay settings change. As the knob approaches 100%, the
Delay mix increases (louder echoes) and the Feedback increases (more repeats).

6. Press STORE, ENTER, ENTER to save your work. Not only will all of the modifier settings be saved, but the
position of the Manual knob as well.

7. EXTRA CREDIT! Use Axe-Edit to place your Manual 1 knob on one of the PERFORMANCE CONTROL pages and
give it the name “Delay/Mix+FB" (See “Performance Control Pages” on p. 94 for more)
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9 MODIFIERS

METRONOME

A metronome is included for convenience. The Metronome is not technically a controller, but its settings are
accessed through the Tempo page of the Controllers menu. To enable the metronome press the Tempo button
and adjust the level for the desired output(s). Note: the metronome levels persist across presets and are reset to
OFF at power on.

EXTERNAL CONTROLLERS

External Controllers are modifier sources that are in turn controlled themselves via external MIDI or a connected
expression pedal or switch. For example, if the source of a modifier on a Wah effect is set to “External 1" and
External 1 is set to “MIDI CC#16"; a connected MIDI expression pedal transmitting CC#16 then operates the Wah.

This concept is illustrated on p. 61.

The global assignments for External Controllers are set on the External Control page of the MIDI/Remote menu
under SETUP. You can assign a MIDI CC#, an on-board Expression pedal or switch, or a Pedal or Switch on a
connected FC series controller. Choosing an External Controller as the source of your modifier is the same as
assigning any other source (see “To Create a Modifier...” on p. 53). To change which CC# or pedal/switch
operates an External Controller:

1. Open the MIDI/Remote menu in SETUP and page to External Ctrl.

2. Use NAV to select the External Controller you want to change (ex: “External Control 1”).
3. Use VALUE to change the assignment. You can also select “NONE" to disable the selected controller.
4. EXIT when finished.

EXTERNAL CONTROLLER INITIAL VALUES

External Controllers assigned to MIDI are given a value of “0” until some MIDI data is received to change them.
You can imagine how a missing or broken MIDI controller might therefore present a big problem...

The External Controller Initial Value parameters can change the startup value for a controller to 100%. Then,
when the Axe-Fx lll is powered on, any modifiers assigned to the missing controller will be all the way up instead
of all the way down. To change the initial value for an External Controller:

» Page to the General page of the MIDI/Remote menu under SETUP.

» Use NAV to select to whichever controller you want to change (ex: “External Control 17).
» Use VALUE to change the setting.

» EXIT when finished.

MODIFIERS LIST

The last page of the Controllers menu lists all of the modifiers in the current preset. You can jump to edit each
modifier from this list by pressing ENTER.

As you'll gather from looking at the list, the maximum number of modifiers per preset is 24.
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9 MODIFIERS

DUAL SOURCE MODIFIERS

The Axe-Fx Il allows modifiers to have not one but two sources. These can be combined in interesting ways to
jointly control a target parameter. Among many other possibilities, this allows pedal-controlled effects to be
operated by either of two different pedals. (Onstage and offstage for artist and tech, or upstage and downstage
so you can stroll out onto the catwalk during a stadium tour.)

When creating a modifier as described in this chapter, you will notice that the menu has separate pages for
selecting Source 1 and Source 2. The Modify page then has three parameters which allow you to scale and
combine these together. Each source normally ranges from 0-100%, but Source 1 Scale or Source 2 Scale can

be used to reduce the impact of either source. Meanwhile, the Operation parameter determines whether the two
sources will be added (Source 1 + Source 2), subtracted (Source 1 - Source 2), or multiplied (Source 1x Source 2).

After the two sources are combined, the output is constrained between 0 and 100. In other words, you cannot
add two pedals together and have the output become 200%. Any value greater than 100 is treated as 100. So, to
achieve our stated example of having two different pedals operate the same wah, each pedal must be returned to
the heel position when not in use.

The following diagram illustrates how the two sources and their parameters work together.

Source 1 Output
(0-100) ) limited
Source 1 Scale Operation 0-100
(0-100%)  Add
* Subtract
Source 2 * Multiply
(0-100) Modifier Parameters Target
Source 2 Scale (Start, Mid, End, (Ranges from
(0-100%) Slope, Scale, et al.) Min to Max)
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9 MODIFIERS

TUTORIAL: SCENE CONTROLLERS

In this tutorial, we will set up a Scene Controller to adjust the Input Drive of an Amp block. While it is easy enough
to achieve different amp sounds within a preset simply by switching the channel, this example provides an
excellent and easy way to understand how Scene Controllers work.

To complete this tutorial, you'll need a preset with an amp and cab block with four identical scenes. You can
create one on your own, or download the preset “SC Tutorial” from Axe-Change:

https://axechange.fractalaudio.com/detail.php?preset=9221

1.

2 © ® N g AW N

11.

12.

13.

14.
15.
16.

17.

The first step in using a Scene Controller is to assign it as a Modifier Source to the parameter of your choice.
Enter the Layout grid of the preset, navigate to the Amp block, and press EDIT.

Use the PAGE buttons to locate the Tone page of the Amp block.

NAV to the Drive parameter and notice the open yellow modifier “ring” beneath the knob.

With the Drive parameter highlighted (blue), press ENTER to display the Modifier menu.

On the Source 1 page, select Scene Controller 1. We don't need any custom settings on the Modify page.
Press EXIT to return to the Amp menu. Notice that the open yellow modifier symbol is now a solid yellow dot.
Now let's set the values for our Scene Controller. Press HOME to show the home page.

Press the CONTROLLERS button (Push-knob C).

Use the PAGE buttons to locate the Scene Ctrl page of the Controllers menu.

. The Controller 1 column lists eight different values — one per scene. These will set the value for our target

parameter in each of the eight scenes.

Dial in the Scene Controller 1 value for Scene 1. Let’s set it to about 20% for a “cleanish breakup” type of
sound. Use your ears!

Change to Scene 2. Double-tap HOME to go to the grid then turn Knob A to change the scene. Push Knob D
(“Controllers”) to return to the Scene Controllers Editor.

NAV Down to select the Scene 2 row in the Controller 1 column. Turn VALUE to set the value for Scene 2.
Let’s set it to about 45% for a nice crunch. Again, use your ears.

Using the process in the previous steps, set the value for Scene 3 to 75% and Scene 4 to 100% (or as desired).
Press HOME to return to the Home page. Test your first four scenes using the NAV UP/DOWN buttons.

Press STORE, ENTER, ENTER to save your work. If desired, enter Scene Names as outlined in “Saving
Changes” on p. 41.

Feel free to assign other Scene Controllers to other parameters in your preset as desired.

New to Axe-Change? Download the file from the link above, then use Axe-Change to import it. Select
an available preset location
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9 MODIFIERS

MODIFIER TIPS AND TRICKS

= The same source can be assigned to multiple modifiers at the same time. For example, one
pedal can adjust Chorus Rate and Chorus Depth at the same time — even in different ways.

» The modifier menu is unique in that it will not allow you to change pages
unless Source 1 is set to something other than “NONE".

= The modifiers for a given block will normally be shared across all of its channels,
but you can also limit a modifier so it applies only to any one channel—your choice.
Change the “Channel” setting inside the modifier menu to do so.

» Remember that modifiers use a small amount of CPU power while you
use them. Check any presets that are close to the edge.

= All of the Internal Controllers (Tempo, LFOs, ADSRs, etc.) are part of the Controllers block. This block
has four channels, so you can have up to four different sets of Controller values in one preset.

= Each block has a dedicated Bypass parameter, and this parameter allows you to assign a modifier.
(“Bypass Mode” is not used as it was across the previous generation of Fractal Audio products.)

= Scenes cannot change block parameters, but Scene Controllers can. Four different knobs can be used
with modifiers to change the value of desired parameters. See the tutorial on p. 63 for more on this.

= Auto-Engage allows a modifier source like an expression pedal to simultaneously engage an effect and
adjust a parameter. It isn't just for the wah however. Try it with a tremolo or rotary block and rate.

= “The Golden Whammy” is a now-classic modifier application where the very first few degrees of
travel for an expression pedal change the Mix of a pitch block from 0 to 100, and the remainder
of the pedal’s travel operates a classic whammy effect. The transition is perfectly smooth with
no steps or jumps as the effect engages. You can study this in factory preset #88: JS410.

= Internal Controllers are used as modifier sources, but these also have many parameters of
their own which can be controlled by a modifier. For example, one LFO can control the rate or
depth of another one. An Envelope can turn the Sequencer on or off. A Scene Controller can
cause an LFO to start or stop. The potential for creative effect processing is immense!

= The switches of an FC controller can also be used as modifier sources. For this to
work, you need to use the Control Switch function detailed in The Fractal Audio
Footswitch Functions Guide found at https://www.fractalaudio.com/fas-ffg
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10 TEMPO

Tempo is used in electronic music for synchronizing different rates and times, whether inside one machine or
across several. Tempo on the Axe-Fx Il allows for both internal and external synchronization, providing effects
with a central BPM clock that can either run autonomously or follow the tempo of a connected device outputting
MIDI Beat Clock. The Axe-Fx lll does not transmit MIDI Clock itself. The Tempo can be set to any whole number
value in the range 20-250 BPM. The Axe-Fx lll flashes its current tempo on a front-panel LED.

THE GLOBAL TEMPO

The Global Tempo value is a system setting outside of any presets, scenes or channels. You can change it in any
of several ways:

1. Tap two or more times on the front panel TEMPO button.
NOTE: By default, the tempo averages across ten taps, but you can set it to use only two taps with an option
found under SETUP: Global: Config: Tap Tempo.

2. Tap the TEMPO button once and use the Tempo knob (B).
3. Use an external MIDI device to transmit MIDI Clock to the MIDI IN port of the Axe-Fx Ill.

4. Use a MIDI CC# or external switch assigned to Tempo Tap, located on the Other page of the MIDI/Remote
menu under SETUP. (See NOTE under #1 above).

Be aware that whenever you change the Global Tempo, you are also changing the current Preset Tempo, which
will be saved if you store the current preset (see below). Be on guard that you don’t accidentally over-write saved
tempos!

PRESET TEMPO

A given preset can ignore the Global Tempo and use its own saved Preset Tempo instead. In fact, this is the
default setting. Notice that a preset’s Tempo page contains two parameters: one is an actual Tempo (BPM) value,
and the other is a setting called Tempo To Use, which determines what will happen when that preset is loaded.

When you load a preset whose Tempo To Use is “PRESET,” the saved Preset Tempo takes over: the tempo LED

flashes accordingly and all tempo-dependent time/rate parameters are re-calculated. In fact the Global Tempo
has not changed; it remains in the background and will be used when you load a different preset with Tempo to
Use set to “GLOBAL".

Be aware that whenever you alter a preset's own Tempo, you are also updating the Global Tempo.

Remember that each of the four channels of the Controllers menu has its own settings for both Tempo (BPM) and
Tempo to Use. You can use this to have some Scenes or Channels change the tempo while others do not.

TO SET “TEMPO TO USE”"...
1. Load the preset.
2. Tap once on the TEMPO button.
3. Change TEMPO TO USE as desired to either “GLOBAL" or “PRESET".
4. STORE the preset.
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SYNCHRONIZING SOUND PARAMETERS

Rates and times in a preset can be made to sync rhythmically to the Tempo by setting their corresponding Tempo
parameters. This is done by selecting from a list of values, ranging from 1/64-note-triplets to double whole notes,
with 76+ options in all. For example, to set the Time of a Mono Delay block to follow the quarter note pulse of the
tempo, find the Tempo parameter on the Config page of the Delay block’s Edit menu and set this value to “1/4."

The moment you assign a value for Tempo (other than “NONE"), its associated rate or time parameter is
overridden and may not be changed manually — as indicated by its appearance in parentheses. To regain control
of an overridden parameter, set its corresponding Tempo parameter back to “NONE".

Almost every LFO rate and delay time parameter on the Axe-Fx Ill can be synced to the tempo.

TO SYNCHRONIZE A DELAY TO THE TEMPO...

» Navigate to any type of Delay block and press EDIT to show its Edit menu.

» Find the Tempo parameter and set it to “1/4". Feel free to choose/explore
other options. “1/8th dot” is also very useful and popular.

» STORE the preset.

Remember that once a Tempo has been set, you will be unable to adjust Time manually or with a Modifier.

TO SYNCHRONIZE A TREMOLO OR OTHER RATE TO THE TEMPO...

» Navigate to the effect and press EDIT to show its Edit menu.

» Find the Tempo parameter and set it as desired. A typical value here might be
“1/8th" or “1/16th". Feel free to choose/explore other options.

» STORE the preset.
Remember that once a Tempo has been set, you will be unable to adjust Rate manually or with a Modifier.

Note that syncing an LFO to the tempo does not align the phase of that LFO to the Tempo LED, to MIDI song
position pointer, or to other synchronized LFOs. You can synchronize various LFOs together by setting their RATE
knobs fully counterclockwise to “LFO1 SYNC" and then syncing the LFO1 Controller to the Tempo (p. 59).
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11 THE TUNER

The Axe-Fx Ill has a built-i

n Tuner—essential for the performing or recording musician. The tuner is easy to use

and has high-resolution automatic pitch detection, a calibration control, offsets for modified tuning schemes, and
the option to mute audio while tuning. Find the Tuner on the Home page by pressing TUNER (Push-knob A).

The tuner features a note
indicators for sharp and f

ADVANCED

The actual tuner is on the

name display, a “zero-center” meter, a spinning “strobe” type display and triangular
lat.

TUNER FUNCTIONS

Tune page of the Tuner menu.

The Config and Offsets pages provide options for advanced tuner functions.

Configuration Parameters

OFF/INPUT/OUTPUT

PARAMETER Description.
Source Selects which physical input the tuner should listen at.
Mute Determines how the tuner mute function works.

OFF: No mute. All signal is passed as usual when the tuner is engaged.
OUTPUT: The signal is muted at the output. Tails are silenced.
INPUT: The signal is muted at the noise gate. Tails ring out.

0 - 4 Semitones

Display Mode Determines whether the tuner shows note names for accidentals as Sharps, Flats, or a
MIXED/ALL FLATS/ | M of both

ALL SHARPS

Calibration Calibrates the tuner by setting the frequency of A4 (in the octave above middle C).
430.0 - 450.0 Hz The tuner defaults to A440.

Downtune The Downtune control allows for simplified tuning when tuning down one to four

semitones. The Tuner display will read the non-downtuned equivalent note, i.e. if tuning
down two semitones, the D will still show E. While Downtune is set to any value other
than None, any blocks that utilize pitch information will also be transposed accordingly.

Use Offsets Determines whether the Offset settings (see below) are applied or ignored.
OFF/ON

OFFSET PARAMETERS
PARAMETER Description
E1, B2, G3, D4, A5, E6 | Offsets allow the tuner to be calibrated so individual notes diverge from standard
+/-25.00 Cts concert tuning by a defined amount. Use this for example for Buzz Feiten tuning.
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MINI TUNERS »— —=

For convenience, mini-tuners appear throughout the Axe-Fx Ill. These consist of two green triangles to indicate
when a note is flat (left lit), sharp (right lit) or in tune (both lit).
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12 SETUP

MENU

Open the menu by pressing the SETUP button (Push-knob E) on the Home page. The current Firmware Version
is shown at the top of the page. To enter a menu, select it with NAV and press ENTER. All changes take effect
immediately without needing to be stored. The settings for Setup parameters are included in a backup of the
System (see "Backing Up & Restoring” on p. 89).

THE FOOT CONTROLLERS MENU

The Foot Controllers menu is covered in its own Section on p. 81.

THE GLOBAL SETTINGS MENU

@& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

GLOBAL SETTINGS: CONFIG PAGE

PARAMETER Description

Output # EQ Type Four different parameters allow you to change the type of the four global

OFF/GRAPHIC/PARAMETRIC  equalizers at each of the outputs (1,2,3, & 4).

Power Amp Modeling This parameter globally enables or disables power amp simulation in all Amp

ON/OFF blocks in all presets when the Axe-Fx Il is used with a guitar-oriented/tube
power amp that contributes significantly to tone and dynamics. Having these
characteristics applied twice to the sound—once in the virtual power amp
and once in the real power amp—would result in an over-processed sound.
All parameters that are NOT part of the virtual power amp continue to work
normally while Power Amp Modeling is turned off. Presence and Depth are
disabled, and Master Volume becomes a simple volume control.

Cabinet Modeling This parameter conveniently enables or disables Cab block processing in all

ON/OFF presets. The Cab block will not physically appear to be bypassed, but acts

Tone Control Display
AUTHENTIC/IDEAL

Update Pre-11.x Presets Spkr
Imp Upon Load

YES, NO

Speaker Impedance Curve

exactly as if it had been replaced a shunt. Use this when you are using the Axe-
Fx Il with an amp powering a traditional guitar speaker cabinet, or the sound
will be muffled, muddy, and boomy.

This parameter governs the "Tone" page of the amp block. When set to
Authentic (default) only those controls present on the actual amp are displayed.
When set to Ideal all tone controls are displayed. Also, when set to Authentic,
the Bass, Mid and Treble controls are reset to default values when changing
models to ensure accuracy for models that may not have these controls.

This causes older presets to automatically update the Speaker Impedance
Curve parameter to an appropriate value when loaded. NOTE: Setting this to
YES will also cause the EDITED LED to light indicating the preset has been
modified but not saved. See the "The Fractal Audio Blocks Guide" for more on
Speaker Impedance Curve parameter in the Amp block.

Determines how the Speaker Impedance curve is selected when changing Type
(Amp Model) in the Amp Block. When set to "DEFAULT ", the usual matching
impedance curve for the new Type is used. When any other value is set here,
this type will be pre-selected whenever the Amp Type is changed.
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PARAMETER Description
Spillover Allows delay and reverb “tails” to ring out or spill over across Preset changes.
OFF/DELAY/REVERB Setting to “OFF” causes effect tails to be cleared upon preset change. Spillover

DELAY&REVERB, ALL

Reverb Mix
+/- 50%

Effects Mix
+/- 50%

Noisegate Offset
+/-40.00 dB

Prompt on Edited Preset
Change

Indicate Edited on Scene
Change

ON/OFF
Display Offset

0,1

Default Scene
AS SAVED, SCENES 1-8

Tap Tempo
AVERAGE, LAST TWO

Value Knob Push Function

AC Line Frequency

when switching Scenes or using “IA” Switches is not affected by this parameter.
("ALL" includes not only Delay and Reverb but also Plex Delay, Multitap,
Megatap and Ten-Tap delay blocks.)

See also "Spillover"” on p. 99.

This boosts or cuts the MIX for ALL Reverb blocks in all presets. Note that
this offset is NOT reflected in the value shown for the actual Reverb block MIX
parameter. This feature is provided because certain dead or lively performance
spaces may require more or less reverb across all presets.

Remember that MIX generally applies only to Reverb blocks which are wired in
series. (Parallel reverbs typically run with MIX at 100%.)

This feature is provided because certain performance spaces may require more
or less of certain effects across all presets. This boosts or cuts the MIX of all
blocks for which the GLOBAL MIX parameter is set to “ON". This switch must
be enabled on a per-block/per-preset basis and is available on the Mix page of
the Edit menu for these block types: Chorus, Delay, Flanger, Formant, Multitap,
Phaser, Pitch, Plex Delay, Reverb, Ring Mod, Rotary, Ten-Tap Delay

Globally raises or lowers the THRESHOLD of the Noise Gate for all Input blocks.
If the THRESHOLD for a given preset is set to “OFF”, the global Offset will have
no effect. Learn more about the Noise Gate in "The Fractal Audio Blocks Guide"
When set to ON the unit will prompt before changing presets if the current
preset has been edited. This spares you from accidentally losing your edits.
NOTE: Be sure to change this to OFF before performing!

This determines whether or not Scene Changes will activate the "EDITED" light
on the front panel and in the connected editor. Please note that the current
scene is still saved as the default scene even when this setting is turned off.

(Also appears in the MIDI/Remote menu) Causes presets numbers to begin
at 001 instead of 000. This only offsets the display, meaning that it does not
change which preset is actually loaded by a given footswitch or MIDI message.

When set to “As Saved” the scene selected when recalling a preset is the scene
that was active when the preset was last saved. When set to a particular scene
value that scene will always be selected when any preset is recalled.
Determines how the tempo changes when tapping the front panel TEMPO
button or an external tap tempo controller (see p. 79). “AVERAGE" sets the
tempo based on the average of ten taps, meaning taps are more forgiving

but changes are more gradual. “LAST TWO" considers only the time interval
between the last two taps, which means taps must be more precise but
changes occur more quickly.

By default, pushing the main “VALUE" knob shows the layout grid. To disable
this feature, change the setting of this parameter to “NONE".

The Noise Gate in the Input Block uses smart EMI filtering to reduce hum and
buzz. For this to work correctly, you must set this parameter to match the power
line frequency of your country (i.e. 60 Hz for North America, 50 Hz for EU, etc.).
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GLOBAL SETTINGS: OUT 1 EQ & OUT 2 EQ PAGES

Four separate pages — one for each output — each provide an equalizer, plus a master LEVEL adjustment control.
The type of EQ can be changed, or the EQ can be disabled via the EQ Type parameter on the Config page.

Use thes EQs to make global adjustments to the tone or level of ALL presets. This is convenient when you need
to compensate for using a different amp or speakers, or if a particular performance space seems overly bright or
boomy. The master GAIN fader should be used with care as it can cause clipping, and lowering it can affect the
signal-to-noise ratio.

These EQs affect ONLY the Analog outputs. AES/SPDIF/USB are not affected.

NOTE: When Output 2 | Copy Output 1 is enabled, Output 1 Global EQ settings are NOT applied to signals at Out 2.
Instead, the Output 2 Global EQ settings apply as usual.

GLOBAL SETTINGS: CUSTOM SCALES PAGE

The Scales page is used to configure scales for the Custom Shifter type in the Pitch block.
Learn more in "The Fractal Audio Blocks Guide”

Note that as of firmware 12, global scales can also be edited, exported, and imported using Axe-Edit.

PARAMETER Description

Custom Scale Number Selects from among the 32 global custom scales available to edit using the 12
1-32 parameters which follow.

—_SHIFT (+/- 24) These 12 parameters are used to set the shift amount for each of the 12 steps

of the chromatic scale. Range is +/-24 semitones (+/- two octaves). To set up
a custom scale, select its number in the field above and then set each of the
12 pitch values as desired. Changes take effect immediately, with no need to
STORE. Soft-buttons provide options to reset a selected value or all values in
the current scale to the default value of +/- 0 semitones.
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THE 1/0 MENU

& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

1/0: INPUT PAGE

The Input page of the I/0 menu contains four parameters that scale the input to the A/D converters:
Input 1/Instrument Level, Input 2 Level, Input 3 Level, Input 4 Level.

Remember that, except at very low settings (5% or less), input level adjustments do not affect gain levels or what
you hear. This is because as you adjust the level to the input of the A/D converter, the output of the converter
compensates accordingly, so your guitar signal level remains exactly the same when it reaches the grid and any

virtual amps or effects.

The global Input 1 Gain parameter adjusts the gain globally for In 1/Instrument. Use this, for example, to
compensate for a lower output guitar. This adjustment happens prior to the In 1 Gate.

1/0: AUDIO PAGE

PARAMETER Description

Word Clock This selects the clock source for the A/D and D/A converters as follows:

INTERNAL “INTERNAL": uses the internal clock.

P RS Y “SPDIF/AES IN": uses the clock recovered from the current digital input. A
valid 48 kHz data stream must be present at the AES or SPDIF port for the Axe-
Fx Il to operate properly.

SPDIF/AES Out Source This allows you to specify which signal should be transmitted at the SPDIF or

Output 1 or 2, Input 1 or 2 AES digital output. Options include Output 1, Output 2, Input 1 or USB 7,8.

USB Output 7,8 Source This determines whether computer USB audio inputs 7 and 8 will record the
signal from physical INPUT 1, INPUT 2 or INPUT 3.

USB Output Mapping Determines whether the first two pairs of computer USB audio playback
outputs are mapped to Out 1 L+R and Out 2 L+R (in that order) or vice versa.
(See the red note on p. 20 for details).

USB Buffer Size Set this to lower values for less latency with USB Audio, set to higher values

8-256 if you are experiencing distorted audio. Stop USB audio streaming when

Digital Input Source

Input Source (1, 2, 3, 3, 4)

ANALOG, DIGITAL

Input 2 Mode
Input 3 Mode
Input 4 Mode

LEFT ONLY
L+R SUM
STEREO

changing this value so as to allow the buffer to reset properly. Streaming can
be stopped by closing the application sending data to the Axe-Fx IIl or by
disconnecting the USB cable.

Sets the global digital input source to your choice of AES, SPDIF, or USB
Channels 5/6. See "Input Source" below, for more on this.

These four settings determine whether each input is fed by the corresponding
analog input jacks, or by the current Digital Input Source (above). For example,
to route USB audio to Input 1, set Digital Input Source to "USB", and set Input 1
Source to "Digital". See “Input Selection” on p. 98.

These parameters determines whether signals at the corresponding input will

be processed in stereo, or in one of several mono modes (“LEFT”, “RIGHT", or
“SUM L+R").

It is important that you choose the correct setting based on what's actually
connected or present. Setting an input to “STEREQ” and then not connecting
one of the two jacks will result in reduced levels.

72




12 SETUP MENU

PARAMETER Description

Output 1 Mode These four parameters determine how signals at the corresponding output
Output 2 Mode ports will be processed. This control makes it easy to use the same presets
Output 3 Mode in a variety of stereo and mono performance or recording environments. The
Output 4 Mode decision between the mono options “SUM L+R" or “COPY L>R" should be
STEREQ, based on the source material.

SUM L+R See "Mono vs. Stereo” on p. 6 for more information on these options.

&%I;E B USB Audio goes directly to the converters and is NOT affected by this setting.

Output 1 Level
Output 2 Level

-10dBV
+4 dBu

Output 1 Phase
Output 2 Phase
Output 3 Phase
Output 4 Phase

NORMAL, INVERT
Output 2 | Copy Output 1

OFF/ON

Output 3 | Copy Input 1
Output 4 | Copy Input 1

OFF/ON

The option "MUTE" allows for special use cases involving USB Input
monitoring. See the diagram on p. 20

These two parameters set the nominal levels of their respective outputs.
Use “-10 dBV" for consumer-grade equipment including many guitar products.
Use “+4 dBu“ with professional audio equipment.

The product manual for your connected device should indicate whether it
operates at +4 dBu or -10 dBV (Default). (Some devices are switchable.)

USB Audio levels ARE affected by this setting.

These four parameters determine whether signal at the corresponding output
ports will be normal or phase-inverted relative to its state at the output of
the grid. This lets you compensate for unwanted inversions elsewhere in the
signal chain.

USB Audio signals ARE affected by this setting.

Enabling this option creates a copy of the Output 1 signal at Output 2. Use this
for the convenience of having an extra copy of the Output 1 mix with separate
front panel level control—without the need to insert an additional output block.

This setting does NOT copy USB audio, and only works only when the Output 2
block is NOT present on the grid for the current preset!

Enabling either of these options creates a copy of the Input 1 signal at
Output(s) 3 or 4. Use this for the convenience of having an extra copy of the
Input 1 signal (for all-analog re-amping, for instance) without the need to
insert additional output block(s) on the grid.

This setting does NOT copy USB Audio and only works only when the
corresponding output block is NOT present on the grid for the current preset!
For example, Output 3 | Copy Input 1 will NOT copy Input 1 when the Output 3
block is on the grid.
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PARAMETER Description

Output 3 Boost/Pad These settings engage a boost/pad which can help lower the noise floor of
Output 4 Boost/Pad Output 3 or 4. This may be useful when outputting to a tube amp or modeler or
0/6/12/18 dB with the Four-Cable Method.

Boost/Pad helps optimize D/A performance without affecting levels, since a
boost at the converter’s input is paired with a corresponding cut at its output.
Be watchful, however, as boosting makes it easier to clip the converters.
Watch the meters and if clipping occurs, reduce levels within your preset or
turn this setting down.

1/0: USB/AES PAGE
The USB/AES page of the I/0 menu contains parameters to adjust the levels of USB and AES inputs.

USB 1/2, 3/4, 5/6, 7/8 - These parameters adjust USB Input levels from -40 to +20 dB. Remember that from the
perspective of the Axe-Fx, a “USB Input” is used for computer playback; audio is routed from the computer to a
USB input of the Axe-Fx, and levels can be cut or boosted here. Be careful not to boost overall levels to the point
of output clipping.

AES/SPDIF - This scales the levels of signals from the AES and SPDIF inputs. Recognize that this scaling occurs
at the output of the input; that is, after the input itself but prior to any processing on the grid.

1/0: PEDAL PAGE

The Pedal page of the I/0 menu contains parameters to set up and use an expression pedal or a switch through
the Pedal jacks on the rear panel of the Axe-Fx Ill. Expression pedals should have a linear resistance taper and
max resistance of 10kQ to 100kQ. The Fractal Audio Systems EV-1 and EV-2 expression pedals are recommended.
Expression pedals must be used with Tip-Ring-Sleeve (TRS) cables.

An external switch may also be used, as long as its contacts make and break the connection between tip and
sleeve. A regular 1/4" guitar cable can be used with switches.

Two meters show the readings for connected pedals both pre and post calibration. It is acceptable for the PRE-
CAL meter to not reach its full limit, but if the POST-CAL meter doesn't reach the top or bottom of its range, please
perform calibration again.
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PARAMETER

Description

Pedal # Type

CONTINUOUS, MOMENTARY,
LATCHING

Calibrate PEDAL #

Set this according to the physical type of the pedal or switch that is connected.
Use “CONTINUOUS" for expression pedals and “MOMENTARY” or “LATCHING"
for switches.

Calibrate expression pedals connected to an on-board Pedal jack.

First select this menu choice, then:
» Press ENTER.
» Move the pedal through its full range of motion several times.

» Press ENTER again when finished.

Switches, unlike pedals, do not need to be calibrated.

THE MIDI/REMOTE MENU

The MIDI/Remote menu contains global MIDI-related settings, and allows you to make assignments for Global
Controller functions including Block Bypass, Block Channel, the Looper, External Controllers, and more.

@& Reminder: You do not need to store settings in the SETUP menu. EXIT twice when finished.

LEARN MODE

The MIDI Remote menu features a hidden Learn Mode function. Rather than using the knobs to assign a pedal, switch,
or MIDI CC, you can use Learn Mode. This is quick and also potentially saves you from needing to know which MIDI CC
is assigned to a button or pedal on a remote device. Here's how it works:

Navigate to the entry you want to assign: for example, "External Control 1" or "“Tempo Tap".
1. Press ENTER to activate Learn Mode.

2. Move the remote pedal, knob, switch, etc. so Learn Mode can detect its activity.

3. The controller will be assigned automatically to your function.
If not, try again, troubleshooting the remote device as necesary, or press Exit to cancel.

MIDI/REMOTE: GENERAL PAGE

PARAMETER Description

MIDI Channel Sets the channel on which the Axe-Fx Ill will receive MIDI messages.

1-16, OMNI “OMNI” causes the unit to respond to incoming messages on any channel.
Display Offset (Also appears in the Global menu) Causes presets numbers to begin at 001
0.1 instead of 000. This only offsets the display, meaning that it does not change

which preset is actually loaded by a given footswitch or MIDI message.
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PARAMETER

Description

Scene Revert
ON/OFF

Effect Bypass Mode
VALUE/TOGGLE

Send Realtime Sysex
ON/OFF

Program Change
ON/OFF

Ignore Redundant PC

ON/OFF

Send MIDI PC

1-16
OMN|
OFF

Selects between two different ways for scenes to work when you change them
via a Footswitch or MIDI:

“OFF”" (Default): Scene edits are RETAINED across Scene changes as long as
you do not change PRESETS. So if you tweak Scene 1, switch to Scene 2, then
switch back to Scene 1, your tweaks will still be intact.

“ON": Scene edits are LOST if you change the Scene without saving. So if you
tweak Scene 1, switch to Scene 2, then back to Scene 1, Scene 1 will have
reverted to its previously saved state. This makes Scene changes feel more like
traditional preset changes.

This setting determines how MIDI messages set the Bypass State of a block.
When set to “Value” the bypass state is controlled by the CC value (0-63=0FF,
64-127=0N). When set to “Toggle” the bypass state toggles whenever the CC
message is received, regardless of the value (0-127).

This determines whether real-time MIDI SysEx messages for tuner and tempo
will appear at the MIDI OUT port.

Determines whether the Axe-Fx Il will process or ignore incoming MIDI Program
Change messages.

This setting determines whether the Axe-Fx Il should re-process or ignore

a Program Change message that corresponding to the current preset. With

this setting “OFF”, a preset will be reloaded—all changes discarded—when it

is selected again via PC. This allows you, for instance, to load a preset, use
various “Instant Access” switches to bypass effects, and then stomp the
footswitch that originally selected the preset to have it revert to its saved state.
With this setting “ON”, redundant PC messages are ignored. When PC mapping
is used, if the current Scene has changed, the preset will not reload but the
Scene will still revert to that set in the map.

Determines whether or not the Axe-Fx IIl will automatically transmit a MIDI
Program Change message at its MIDI OUT port when a new preset is loaded.

This is the easiest way for most people to operate a single connected MIDI
device while changing presets on the Axe-Fx Ill. Any custom MIDI mapping
is left to the downstream device. To use this feature you simply select which
channel you want the message to be transmitted on. The “OMNI” setting
transmits the message on all channels.
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PARAMETER

Description

MIDI PC Offset

PC Mapping

INITIAL VALUE:
External Control 1-16

Adds a specified value to all incoming MIDI Program Change requests before
they are processed. This makes it possible, for instance, to address alternate
presets in different “registers”. You might use the same MIDI messages to
access presets 1-16 for a gig with one guitar, and —by specifying an offset
of +16— use presets 17-32 for a different guitar without re-programming your
controller.

PC Mapping determines whether incoming MIDI Program Change messages
load presets 1-for-1, or load other presets and scenes instead. With PC
Mapping turned “OFF”", presets are loaded 1:1 based on incoming MIDI bank
Select and Program Change messages. With custom PC Mapping enabled,
incoming Program Change messages are re-mapped according to the values in
the table on the Custom page of the MIDI/Remote menu (see below).

These sixteen parameters specify the initial value to be used for each of the

16 External Controllers (p._61) when the Axe-Fx Ill is powered on. This value
persists until data is received from the MIDI controller. This is especially useful
when an external MIDI controller is absent. For example, if you normally use an
expression pedal to control the volume in your presets, a missing pedal might
make the preset get “stuck” in a muted position. Setting an initial value of 100%
for the External Controller mapped to that pedal would ensure that when the
pedal is not connected, the volume will stay at 100% instead of 0%. This setting
is only for controllers with a MIDI CC# assignment. It does not apply to local or
FC pedals or switches.

MIDI/REMOTE: MAPPING PAGE

With PC Mapping enabled (see above), incoming Program Change messages are re-mapped according to the
values in the table in this section.

PARAMETER

Description

Map to Preset
Map to Scene

When PC Mapping (above) is turned “ON”", the parameters in this table specify
which preset and scene are loaded for each incoming MIDI PC message.
See p. 47 for additional info on PC Mapping.

MIDI/REMOTE: BYPASS PAGE

The Bypass page of the MIDI menu allows you to map MIDI CC messages—or connected pedals and switches— to
bypass or engage blocks. CC messages can be sent by a MIDI controller or computer connected to the MIDI IN
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jack, or via the USB connection of the Axe-Fx lIl. Each of these settings is global. In every case, the method for
mapping a controller to one of these functions is the same:

1. Use the NAV knob to select the desired function.
2. Use the VALUE knob to assign a controller to the function:

1-127 to assign a MIDI CC#.

PEDAL 1 or PEDAL 2 to assign a pedal connected to the on-board expression jacks of the Axe-Fx Il

FC__ PEDAL 1-4 to assign a pedal connected to the corresponding pedal jack of the designated FC controller.
FC__ SW 1-4 to assign a switch connected to the corresponding switch jack of the designated FC controller.
NONE to remove all assignments from the selected item.

MIDI/REMOTE: CHANNEL PAGE

The Channel page works exactly like the Bypass page except the entries are used to set the Channel of each
block instead of its bypass state. The value of the CC message sets the channel as follows:

0 =Channel A 1=ChannelB 2=ChannelC 3 =ChannelD

The series continues, repeating A, B, C, D for values up to 127 (D).
For additional information, see "Channel Select’ on p. 46.

MIDI/REMOTE: EXTERNAL PAGE

Controller assignments for the sixteen External Controllers used in Modifiers (See Section 9: Modifiers).

MIDI/REMOTE: LOOPER PAGE

Controller assignments for the functions of the Looper.
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MIDI/REMOTE: OTHER PAGE

Controller assignments for various other functions of

the Axe-Fx III.
PARAMETER Description
Tempo Tap Provides the ability to tap the tempo using an external controller. Remember that
tempo is calculated using either the last two taps OR an average, as set in the
global Tempo configuration (p. 65). Learn more about Tempo in Section 10.
Tuner Provides a way to remotely enter or exit the Tuner (Section 11).

Preset Inc/Dec
Preset Inc/Dec Start/Stop

Scene Select

Scene Increment
Scene Decrement

Input 1,2,3,4 Volume
Output 1,2,3,4 Volume
Output 1 Volume Increment,
Output 1 Volume Decrement,

Output 2 Volume Increment,
Output 3 Volume Decrement

These allow you to step up or down through a sequence of presets with pre-
defined start and end/wrap points. Preset mapping and offsets are ignored.

Selects specific Scenes. The controller value (NOT the CC number) determines
which Scene is loaded:

2 =Scene 3 4 =Scene 5 6 = Scene 7
3 =Scene 4 5=Scene 6 7 =Scene 8

The series continues, cycling through scenes 1-8 for values up to 127 (Scene 8).

0 = Scene 1
1 =Scene 2

For more, see "Scene Select” on p. 46 or "CC Value to Scene" on p. 110

The Scene Increment and Decrement functions allow you to step up or down
through scenes. These functions are triggered by CC data values above 63.

Eight individual parameters allow you to globally control the levels of the
corresponding Input or Output blocks.

These options provide a convenient way to permanently increase or decrease the
MAIN output volume for the Out 1 or Out 2 Blocks in the currently loaded preset.
Each time Volume Increment is triggered, the MAIN is increased by 1.0 dB and
the preset is saved. This is the same for Volume Decrement, except it decreases
volume.

A IMPORTANT! Any unsaved changes such as altered effect parameters or
bypass states will also be stored when either of these functions is triggered!

A These functions are designed for use with momentary footswitches set up to
send a CC# value of 127 for “ON” and 0 for “OFF". Do not use an expression pedal
or you could inadvertently increase levels to +20 dB with a single sweep!
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THE UTILITIES MENU

UTILITY: DISPLAY PAGE

Provides a control to adjust brightness for the main LCD display. On the Axe-Fx Ill Mark I, there are additional
controls for the LED Brightness and Color of the main front panel logo.

UTILITY: ADC LEVELS

Shows Analog-to-Digital Converter levels for the four front panel Level knobs and rear panel Expression jacks for
troubleshooting. You can set the output level here at an exact percentage.

UTILITY: RESET PAGE

This page provides a tool to set parameters in the SETUP menu back to factory default values. Reset system
parameters is one of the first steps of troubleshooting. It never deletes or modifies your presets. You will be
prompted to press ENTER to confirm.

Be very careful with this option. Resetting system parameters is irreversible!

A second utility provides the ability to Clear all Presets. You will be prompted to press ENTER to confirm.

Be very careful with this option. Erasing presets is irreversible!

UTILITY: USB PAGE

This page meters the USB input and output FIFO buffers. Ideally these will be at around 50%. If the buffer
overflows or underflows, USB Buffer Size (p. 72) should be increased. Remember that you need to quit all
audio applications or remove and reconnect the USB cable to reset the buffer.

UTILITY: FIRMWARE PAGE

This page indicates which firmware version the Axe-Fx lll is running.

USB and FPGA firmware versions are also shown.

For more information, see "Tap Tempo" on p. 70.
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13 FC CONTROLLERS

The Fractal Audio FC-6 and FC-12 foot controllers are designed for use with the Axe-Fx Ill and other Fractal Audio
products. Every FC offers an impressive suite of features and capabilities, incorporating years of innovation and
customer feedback. They look great too, making an awesome addition to your stage or studio.

All aspects of the FC are set up through the Axe-Fx Il under SETUP: FC Controllers (p. 69).

The FC Owner’s Manual covers the FC hardware, how to connect, and basic operations.

Find it at http://fractalaudio.com/fcm

The Fractal Audio Footswitch Functions Guide covers the details of everything FC footswitches can do.

Find it at https://www.fractalaudio.com/fas-ffg

Scene 1
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Preset 1

72N

Scene 2

72

Preset 2

72
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14 IR CAPTURE

This section details the use of a built-in tool that allows you to capture you own Impulse Responses using the
Axe-Fx Il and some additional equipment.

Whether part of a combo or housed in its own cabinet, the speaker is a major part of the sound of any guitar or
bass amp. When you hear great tone on a recording or at a live show, this means someone somewhere has done a
great job of selecting and placing mics (even if the player is already using a Fractal Audio product!).

The Axe-Fx Ill uses Impulse Responses (“IRs") to faithfully reproduce the sound of a mic’d speaker, with over
2,048 Factory Cabs provided, and 2,048 more memory slots for User Cabs. Our store offers many professionally
produced Cab Packs, but you can also create your own IRs using the IR Capture utility in the Axe-Fx Ill. The
process is easy and requires only some common pro-audio gear.

Learn more about Impulse Responses in the Cab Block section of “The Fractal Audio Blocks Guide”

DECIDE ON A CAPTURE METHOD

There are two different methods of IR capture. Both methods require microphone(s) and preamp(s), and both
methods produce excellent results.

Method 1 requires a flat, neutral, full-range power amp. This will typically be a solid-state amp designed for pro-
audio applications (e.g. not a guitar-oriented amp, which would add tonal coloration).

Method 2 adds a speaker-level DI box — such as the Fractal Audio X-Load LB-2 — to “factor out” the power amp,
SO you can use any amp—even a regular guitar amp.

MONITOR YOUR AXE-FX III

When creating IRs, you'll probably want to test-drive the results right away. Connect your guitar to your Axe-Fx lI
and set up whatever you'd normally use for direct, full-range monitoring (headphones, studio monitors, powered
FRFR speakers, etc.). The capture process uses OUTPUT 2 LEFT, so please ensure that Output 2 | Copy Output 1
is set to “OFF” on the Audio page of the I/0 menu under SETUP.

MIC THE SPEAKER

= Before you can mic a speaker, you'll need to play through it. You can plug right in to the actual guitar amp
itself as you normally would, or you can use an Axe-Fx preset (with the Cab block bypassed or circumvented)
into a neutral power amp, into the speaker. One advantage of the latter method is that once you capture the
IR, you can use the same exact amp for testing, which should produce results remarkably close to the original.

= Once you've got a good guitar tone coming through the speaker, it is time to set up the mic(s).
Recording studios have control rooms isolated from the “live room”, making it easy to hear what
the microphone is picking up without interference from a loud amp. Having an assistant or
robot to adjust the mic is convenient. If this option isn't available to you, try using headphones
to let you focus on the mic'd tone. It might be loud, so take care not to damage your hearing."
You can also record the amp and listen back to make sure you are satisfied with the tone.

1 https://www.osha.gov/SLTC/noisehearingconservation/
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* The tone you get from a mic'd speaker depends on the type(s) and position(s) of the microphone(s). Select
a mic that is well-suited for guitar cab recording and position it according to your preference. Information
is widely available about mic placement, distance, angle, etc., but don't be afraid to experiment.

= Each mic needs to be connected to a preamp to bring the signal up to line level for processing. The
preamp also contributes to the tone, so a high-quality preamp (like an API or Neve) is generally preferred,
but even an inexpensive mixer can produce excellent results. Don't allow the mic preamp to distort.

= With an optional mixer, you can combine multiple microphones to capture a blend.
» EQis OK, but dynamics processign such as compression can cause the IR to misrepresent the source.
= |f the cab is loaded with multiple speakers, you should listen to each one to see how they compare.

SETUP 1: MIC ONLY

Method 1 (“MIC ONLY") requires a microphone, a preamp, and a flat, neutral power amp.

= Set up a preset with your preferred Amp block, and set its Cab block to “SCRATCHPAD 1" for instant auditioning.
» Connect the mic to the input of the preamp.

= Connect the output of the preamp (or mixer) to INPUT 2 LEFT of the Axe-Fx IIl.

= Connect OUTPUT 2 LEFT or OUTPUT 4 LEFT of the Axe-Fx Ill to the input of your power amp.

= Connect the power amp'’s speaker out to your speaker.

= Open the Config page of the IR Capture Utility under SETUP and set Capture Method to MIC ONLY.

*  Follow the Capture Instructions on p. 86

NOTE: IRs created using this method will include any S
tonal coloration imparted by the power amp. Cab-Lab H

can remove this effect using a separate “Reference IR”
of just the power amp created using a speaker-level to
line-level DI, but if you have this DI-box at the time of
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SETUP 2: MIC + DI

Method two requires a microphone, a preamp, and a DI Box with the special capability to convert speaker level
to line level. This method has an advantage in that it “factors out” the tonal Influence of the power amp, allowing
almost any amp to be used. A neutral power amp is still preferrable, but even a regular guitar amp can produce
excellent results, as the Axe-Fx is able to remove distortion, completely separate the speaker response, and
produce a pure and accurate IR.

= Connect the mic to the input of the preamp.
= Connect the output of the preamp to the IN 2 Left of the Axe-Fx.

= Connect OUTPUT 2 LEFT or OUTPUT 4 LEFT of the Axe-Fx to the FX Return of your guitar amp. If your
amp doesn't have an FX return, use the guitar input. Set the amp to as clean a setting as possible.

= Connect the amplifier's speaker out to the speaker level input of the DI box. Be sure
to use a DI box that is specifically designed to work with speaker level signals and
one that does NOT have any on-board cabinet emulation. You can also use a DI output
on your amp if it has one, as long as it is NOT a speaker emulated output.

= Connect the Speaker Out or Thru jack of the DI box to the input of your speaker.

= Connect the Line Level Output of the DI box to IN 2 Right of the Axe-Fx.

= QOpen the Config page of the IR Capture Utility under SETUP and set Capture Method to MIC + DI.
»  Open the Audio page of SETUP: I/0 and ensure that INPUT 2 MODE is set to “STEREQ".

= Follow the Capture Instructions on p. 86

=)
56 8.0 i3
- O 4090'
. Q0 C)?@
L FoacTAL

H

\ 4
IN2L J t IN2R OUT2LorOUT 4L
Mic Pre Line Out
D.I. Line Out
MIC To Amp Input 1
PRE GUITAR AMP or FX Return = 508 — SPEAKER
MicPre | (or any power amp) 7o | LevEL
ic Pre In — Y DI BOX
Amplifier Speaker In Speaker Thru
de 00O ¥ |
_— -
\ Amp Speaker Out
SREAKER AN
O ’
S S Speaker In
J

85



14 IR CAPTURE

CAPTURING IMPULSE RESPONSES

USING AXE-EDIT OR CAB LAB

Axe-Edit now includes a free IR Capture Utility which serves to control for the Axe-Fx Ill during IR capture.

Cab-Lab is an IR Mixer and Toolbox, available at https:/www.fractalaudio.com/cab-lab-3. It is strongly
recommended that you use Cab-Lab to capture IRs. The interface is easier to use, and you will also be able to
save the raw IR data to your computer for later remixing or re-processing.

FROM THE AXE-FX 11l FRONT PANEL

This section covers capturing from the Axe-Fx Ill front panel:

1. Make the connections for your chosen setup as detailed on the previous pages of this section.

2. Inthe Axe-Fx lll, create a preset with an Amp block set to an appropriate model and a Cab block with Cab 1
set to Bank: “SCRATCHPAD", Number: “1”. In that same Cab block, set Cabs 2, 3 and 4 to “MUTED". IRs are
automatically sent to this special location upon capture for instant auditioning.

3. Open SETUP, NAV to the IR Capture menu, and press ENTER.

4. 0On the Config page, you will typically want Capture Mode set to “ULTRA-RES" for close-mic'd IRs, though
“STANDARD” resolution is also available. “FULL-RES" can be used for longer IR captures (see inset, below)
Capture Method should be set to “MIC ONLY" or “MIC+DI" depending on which setup you are using.

5. On the Config page of the IR Capture utility, select a Bank and a Slot where you want the finished IR to be
saved. Enter a Name using the functions on the B,C, D and E knobs.

6. On the Config page, consider the following optional parameters as well:

= Deconvolution: In low-noise environments the conventional technique can provide slightly better
bandwidth and magnitude accuracy. In a higher-noise environment the reverse filter technique can provide
better results.

= IR Processing: This selects between “Minimum-Phase” which transforms the IR into a minimum-phase
version, “Auto-Trim" which removes the leading silence, and “None” which applies no processing at all.

= Delay Compensation: This allows compensating for excessive delays due to extreme mixer latency or
far-field mic distances. To use the compensation refer to the graph on the Capture page. Press E to
select “Graph (Time) and do a test sweep. Note the waveform delay and dial in the desired amount of
compensation. Note that the speed of sound is roughly 1 ft/ms so a mic that is 10 ft from the speaker
would incur roughly 10 ms of delay. Note that IR Capture Utility will automatically compensate for delays
up to approximately 20 ms (1K samples). Correction is only required for delays greater than 20 ms.

FAQ: WHAT IS FULL-RES ? “Fractal Audio introduced FullRes impulse response technology

in 2021. This new technique allows for IR up to 1.37 seconds (far longer than even UltrsRes™). These can

be used for realistic recreations of ambient spaces without the increased latency normally associated with
long IRs. Producers and engineers often use “Room Mics” to increase the depth and liveliness of recordings.
However, the typical live room has a reverb time of 500-700 ms, well beyond the 20-40 ms afforded by
typical IR processing. FullRes IRs can capture a typical live room and even small-to-medium halls and clubs,
and can even be used as a convolution reverb. As of this writing, only the Axe-Fx Ill supports FullRes IRs.
Any FullRes IRs you capture with this utility can be stored on the unit in “User Cab Bank 3 (FR)".
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10.

11.

12.
13.

14 IR CAPTURE

Press the TEST button (Push-knob A) to generate a test sweep for setting levels.

The OUTPUT LEVEL 2 knob on the front of the Axe-Fx Il sets the level of the sweep signals sent to the power
amp. Turn it — and your power amp — up until you hear the test through the speaker. It should be loud enough
to push the speaker to “optimal” levels and eliminate background noise interference, but not loud enough to
be uncomfortable or cause distortion.

The front panel INPUT 2 LED meter of the Axe-Fx Il indicates the signal level coming back to the Axe-Fx IlI
from the mic and preamp or mixer. Adjust the preamp output levels and use INPUT 2 level on the Input page
of the 1/0 menu to ensure that the signal is nice and hot without clipping. It is OK to “tickle the red” LED, as
this indicates a level of -6 dB, below actual clipping.

Once levels are set correctly, it is time to capture. Press the on-screen CAPTURE button (Push-knob B) and
wait quietly for the capture to complete (two sweeps, ~5 seconds).

If you set up the test preset in Step 2 correctly, you should hear the IR automatically and be able to audition it
at once.

Press SAVE to store your capture to the location you selected in Step 5.

Be sure to select a new location and name before performing any additional captures with the same setup.
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15 ADDITIONAL TOPICS
FRACTAL-BOT

Fractal-Bot is required for Backing up and Restoring sounds and settings (below),
Updating Firmware (p. 90) and can be used for Transmitting Presets, or
Installing User Cabs (p. 96).

The program is self-explanatory and has instructions built in.

To be able to use Fractal-Bot, Windows users will need to install a driver to enable
communication between the computer and the Axe-Fx Ill. The Windows driver is
available at https://www.fractalaudio.com/axe-fx-iii-downloads.

Computers running 0S X do not require a driver to communicate with the Axe-Fx Ill.
Download and install Fractal-Bot from our web site at http://fractalaudio.com/fractal-bot.php.

BACKING UP & RESTORING

Once Fractal-Bot is installed, you can use it for backing up or restoring or installing files.

BACKING UP

Fractal-Bot automates the backup process. Select the RECEIVE tab and follow the built-in instructions. Here are
some things to consider when using Fractal-Bot:

» The Axe-Fx Il doesn't emphasize this distinction, but its Presets are actually divided into banks of 128. To
backup all of your presets, backup all of the banks: A (0-127), B (128-255), C (265-383) and D (384-511).

» A backup of the SYSTEM includes all of the custom settings in the Setup
menu: Global, /0, MIDI/Remote, and Tuner settings.

» User Cabs are backed up in two individual banks.

» In Fractal-Bot, you will need to specify a location for the backup files. It is wise to prepare this in
advance. Many pros we work with use a consistent naming system for their backup folders: “yymmdd
- Axe-Fx I (two digit year, two digit month, two digit day). In addition to the backup files, create
a text file to remind you what firmware version was installed when the files were created.

RESTORING

Fractal-Bot is also used to restore backup files to your Axe-Fx IIl. In this case, the process is less automated
but still very easy. You will need to send over all of the files from your backup set individually. Once the first
file completes, send the next file over, and so on, until they are all finished. Remember to reboot the Axe-Fx IlI
immediately if a System file has been transmitted to it! (Fractal-Bot will remind you.)

You can use the same process to install presets or cab files you download.

MIDI

On the Axe-Fx llI, backup and dumping are not supported over 5-pin MIDI. You can transmit backup files to the unit
this way, but because the transfer rate is so slow, this can take a LONG time and is advised against.
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FIRMWARE UPDATES

Our products are upgradeable, and we are committed to continual improvement. These highly antipated updates
add new amps, cabs, effects and features, fix issues, and more. We recommend keeping the firmware in your Axe-
Fx Ill up to date as new versions are released. Firmware is technically software — the “operating system” of your
Axe-Fx Il — tracked using version numbers: 1.00, 1.01, 2.00, etc. Every Axe-Fx Ill is shipped from the factory with
the latest version installed. You can check your version any time by pressing the SETUP button (Push-knob E) on
the Home page. The version is displayed at the top left of the Setup menu.

UPDATING

Updating is safe, easy, and quick with Fractal-Bot (see previous page). Before you begin, please QUIT any other
applications which might interfere, including Axe-Edit and any DAW software or audio/MIDI applications.

1. Download the latest firmware for your Axe-Fx Ill from https:/www.fractalaudio.com/axe-fx-iii-downloads.

2. Unzip the download file. The archive may contain various documents in addition to the actual firmware file,
which is a MIDI System Exclusive or “SysEx” file. Extract the .syx file to a location you can easily find when
required. Do not double-click the .syx file. Fractal-Bot will prompt you for its location when it is needed.

3. Please read the Release Notes included with the firmware download. They'll et you know what'’s new and
alert you to anything you may need to be aware of before updating to the new version.

4. Before performing a major firmware update, it is not unwise to back up your Axe-Fx lll (see previous page).

5. Launch Fractal-Bot and proceed through three self-explanatory steps.

6. Firmware updates will occasionally be accompanied by new versions of the Axe-Fx Ill Factory Presets. These
will be available on our web site support page and can also be installed using Fractal-Bot.

FIRMWARE Q&A

Q: How do | know the upgrade worked?

A: Check your firmware version anytime by pressing the SETUP button (Push-knob E)
on the Home page. The version is displayed at the top of the Setup menu.

Q: Can | skip versions to go from a very old firmware version to a much newer one?

A: You can upgrade from any version to any other version. When you skip versions it is recommended that you
also read the Release Notes for all interim versions, all of which are included with every firmware release.

Q: Will updating my firmware erase, modify or “upgrade” my factory presets?

A: Firmware updates do not erase customized presets. However, firmware updates may
alter the sound of existing presets. Always read Release Notes before updating. Saving
presets after a firmware update can render them incompatible with previous versions. It
is always wise to create a full back up using Fractal-Bot before a major update.
Firmware updates do not upgrade Factory Presets. Updated Factory Presets, when offered, are released as a
separate update on our web site support page. Fractal-Bot can be used to transmit this update in the same
way it is used to update firmware.

Q: The firmware update failed mysteriously. What should | do?

A: If the Axe-Fx still boots normally, just try the update again. If successive failures occur, please delete and
re-download the update file before trying again. Trying a different USB port or cable can also solve issues.

Q: After updating, my Axe-Fx will no longer boot normally.

A: See “Recovery” on the next page.
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RECOVERY

PROBLEMS DURING/AFTER FIRMWARE UPDATE

The Axe-Fx Il has a built-in recovery system known as the “Emergency Boot Loader” to protect you against
mishaps during firmware update. To boot from the emergency boot loader:

1. Power down the unit and wait five seconds.

2. Power on holding both PAGE LEFT and PAGE RIGHT buttons until the Emergency Utility page appears.
3. Update as normal using Fractal-Bot.

PROBLEMS WITH A SINGLE PRESET

If your Axe-Fx Ill will not boot normally, the problem may just be the current preset. You can force the unit to load
an empty initialized preset as follows:

4. Power down the unit and wait five seconds.

5. Power on holding HOME until the boot-up progress bar first appears.

The Axe-Fx Ill will boot with an empty initialized preset in location “000”. You can STORE this to any other location
to overwrite a problematic preset.

PROBLEMS WITH GLOBAL SETTINGS OR PARAMETERS

In the very unlikely event that a problematic system parameter prevents the Axe-Fx Il from booting normally, you
may use the following procedure to recover:

1. Power down the unit and wait five seconds.

2. Power on holding EDIT until the boot-up progress bar first appears.

3. Enter SETUP, open the Utilities menu, and page to Reset.
4

Execute Reset System Parameters as indicated on-screen (Push-knob A followed by ENTER).
WARNING! Do NOT accidentally perform CLEAR ALL PRESETS!!!

5. Follow the on-screen instructions to execute. Press HOME when finished.

You can in fact hold both HOME and EDIT at once to reset the current preset and prevent the loading of
global settings and parameters.

GETTING HELP

Our forum is a source of great help ranging from product Q&A to tutorials and more. Fractal Audio staff
participate in the conversation, and response times can be very fast. Find it at https:/forum.fractalaudio.com.

Our wiki, maintained by members of the Fractal Audio community, is also an excellent resource:
https://wiki.fractalaudio.com.

You can get support directly from Fractal Audio Systems at: https://support.fractalaudio.com
or internationally via our dealers listed at https://www.fractalaudio.com/international-ordering.
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GLOBAL BLOCKS

Global Blocks provide a convenient way to synchronize parameter changes across multiple presets.

If you use multiple presets and want to keep certain sound settings the same in all of them, you might imagine
needing to repeat those changes into every preset, one by one. Another idea might be to use Axe-Edit to copy/
paste the desired blocks from one preset to another. Global Blocks eliminate these the need for such tedious,
repetitive tasks. Any change to any Global Block in one preset is made automatically across all other presets
where that Global Block is used.

Each block type that supports Global Blocks is backed with eight Global Blocks of its own. For example, there are
eight DIFFERENT Global “Amp 1" blocks and an additional eight DIFFERENT Global “Amp 2" blocks. Global blocks
are stored outside the preset area in “System Memory.” All parameters in all channels can be governed by Global

Blocks. All modifiers, however are stored in the preset itself and are NOT part of the Global Block.

GLOBAL BLOCKS SUPPORT

Most of the 40+ block types support the use of global blocks. (The following are NOT included: Crossover, FB
Send/Return, IR Player, Looper, Megatap, MIDI, Mixer, Multiband Comp, Multiplexer, RTA, Resonator, Synth, 10-tap
delay, Vocoder.)

GLOBAL BLOCKS EXAMPLE

Imagine a set of five different presets used for a live rig. Each of them has one amp block (AMP 1) with the same
settings, but this amp is surrounded by totally different effect chains. Now, depending on the venue, your guitar,
the backing band, the audience, the weather, you name it... You may want to make changes to your amp block,
just as you would any physical amp. Turn up the treble. Turn down the gain. Adjust the Graphic EQ. Using the
simple operations described on the next page, it becomes easy to link the amp blocks in these presets together,
so modifying any one of them changes all of them.

First, you would open one of the presets where the amp is dialed in nicely. Now, save that Amp's settings as a
Global Block by selecting Amp 1 and choosing LINK TO GLOBAL BLOCK. Let's say we choose “Global Block 1”.
Don't forget to save the preset!

Now, open each of the remaining presets, select AMP 1, and choose LINK TO AND LOAD FROM GLOBAL BLOCK,
selecting “Global Block 1”. The settings from Amp 1: Global Block 1 appear automatically, and the link is created.
Don't forget to save the preset! Repeat as needed for other presets.

Other applications for Global Blocks include using them to change gate threshold settings as you change from an
active guitar or bass to a passive one, globally adjusting the level of a volume block used as a “boost”, dialing in
individual effects that are used with different amps in different presets, and much more.
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Global Block Operations

Four different operations enable presets to interact with Global Blocks. You can find these operations on the Tools
page of the Layout menu (from the Grid, page right to “Tools”). To execute a function, select the desired grid
block using the NAV buttons, use the VALUE wheel to choose the desired Global Block function, turning the E knob
if indicated to select the desired Global Block number, and press ENTER or the “Execute” button (Push-knob C).

Using Axe-Edit makes working with Global Blocks even easier, and also provides a high level view of where they
are used in your preset.

LINKTO GLOBAL BLOCK

The Link to Global Block function “creates” a Global Block from a block in your preset, and then creates a link
between the two. This is always the first step when you want to begin using Global Blocks. Any existing settings
in the selected Global Block is over-written with the settings from the block in your preset. After a link is created,
any time you save changes, the Global Block is updated. Any time another linked preset is changed and saved,
this preset will be updated.

Always save your preset immediately after creating a link to a Global Block.

LOAD FROM AND LINKTO GLOBAL BLOCK

The Load from and Link to Global Block function loads existing Global Block data into the selected block in your
preset, and then creates a link between the two. You would normally use this function to link a set of presetsto a
Global Block that you first created using the Link to Global Block function (above). After a link is created, any time
you save changes, the Global Block is updated. Any time another linked preset is changed and saved, this preset
will be updated.

Again, always save your preset inmediately after creating a link to a Global Block!

LOAD FROM GLOBAL BLOCK

The Load from Global Block function loads existing Global Block data into the selected block in your preset, but
does NOT create a link between the two. This allows you to use Global Block data as a “template” for populating
local block settings without the usual link.

UNLINK FROM GLOBAL BLOCK
This operation totally disconnects the selected block from any Global Blocks.

UNLINK ALL BLOCKS FROM GLOBAL

This operation unlinks all blocks in the current preset from Global blocks to which they may be linked.
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PERFORMANCE CONTROL PAGES

INTRODUCTION

The two Performance Control pages of the Axe-Fx Ill provide a way for you to design and build your own custom
front panel menu pages, each with your choice of any ten knobs, switches, or parameters from any block.
Performance Control pages eliminate the need for menu-diving to find the controls for your favorite settings.
The ten on-screen knobs map directly to the front panel A, B, C, D, and E knobs of the Axe-Fx Ill. This creates an
experience very much like using a traditional amp or pedal where what what you see is what you get.

One of the Performance Control pages is “Global” meaning that the 10 parameters you place there remain the
same even as you change presets. The values of these controls change — for instance, if you place AMP 1/
TREBLE, you will see the Treble setting change from say, 6, to 3 to 10 as you switch presets, but the AMP 1/
TREBLE knob itself will always appear in the same place on the Global Performance Control page. Meanwhile,
the “Per Preset” Performance Control page allows you to choose up to ten different parameters in each and every
preset. One preset might show ten Amp controls, while the next shows ten effect controls, while the next shows
a mix of both. Each parameter on the page shows a 2-line text label. By default, these show the block name/
number, and the parameter name, but you can change these to custom values.

The two Performance Control pages are located in the HOME menu of the Axe-Fx lll. Press HOME, then PAGE
to either Per-Preset (“Perform-PP") or Global (“Perform-Gbl”) tabs. Use the NAV buttons to switch between the
controls. Use the A,B,C,D or E knobs or VALUE to make changes. Because these pages are designed for use
during a performance, the Axe-Fx Ill will not leave them if you change presets or scenes.

In summary, Performance Control pages represent a powerful way to design the perfect setup for quick changes,
such as during a soundcheck, or even (gasp) in the middle of a solo.

Axe-Fx Il =] Home | Perform-PP | Perform-Ghl
025: My Rig Preset Scene: 2
—< 4.98 )7
AMP1 AMP1 AMP1 AMP1 AMP1
Input Drive Bass Mid Treble Level
AMP1 Delay 1 Delay 1 Reverb 1 Inl
Presence Time Mix Mix Threshold
(__TuNer ) (C tavout ) (controLlers) ( amp 1 ) ( AMP2 )

A Sample Performance Control Page, showing a mix of Amp and Effect Controls
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PLACING CONTROLS ON PERFORMANCE PAGES

Performance Pages must be set up using Axe-Edit, the companion editor/librarian software for the Axe-Fx IIl. In
the following tutorial, we will set up a few examples.

1.

10.

11.

12.

Decide whether you want to set up the Global page or the Per Preset page. Remember: parameters placed on
the global page stay there as you change presets. Those on the Per-Preset page will be different from one
preset to another. The Global Page might contain your top ten “go to” parameters. Many players will place the
basic knobs of the AMP 1 block here: Drive, Bass, Mid, Treble, Presence, Depth, Master Volume, Level, etc.
Let’s get started with this in our tutorial.

Connect your Axe-Fx Ill over USB to a compatible Mac or Windows computer. You will need a driver if you are
running Windows. See Chapter X.

Install and Launch Axe-Edit Ill. Learn more about Axe-Edit on p. X.

To add Amp 1 controls to the Global Performance Control page, we need to begin in a preset containing the
Amp 1 block. Click the PRESETS button in Axe-Edit, then click the preset of your choice: 008: Plexi 50W for
example.

On the grid, click the AMP 1 block. Change the “Authentic” tab if it isn't already selected.

Switch to the Performance Control editor by clicking the Perform button above the grid.

Drag and Drop the Input Drive parameter by its label to the first slot of the Global Performance Controls.
IMPORTANT: You must drag controls by their LABEL! If you drag on the knob, you will change its value.
Don't panic if this happens, just UNDO by pressing Command + Z (Mac) / Control + Z (Win).

Continue drag-and-drop of parameters to desired locations. You can in fact drag ANY parameter from
anywhere in any block. You are limited to ten, and you don't need to fill all of the slots.

TIP: You do not need to exit the Performance Control editor to change blocks... use the shortcut menu found
to the left of the large block icon in Axe-Edit. It lists every block in the current preset.

You can use drag-and-drop to rearrange controls in Axe-Edit. To remove any control, select it and press
Delete/Backspace on your keyboard.

You can change the label for any control by double-clicking on the existing name. Type your desired text and
then press Enter/Return on your keyboard to confirm.

Since we are setting up the Global Performance Controls, there is no need to save. When working with Per-
Preset Performance Controls, however, you must save the preset after you finish drag-and-drop.

Check your work on the Axe-Fx Ill. Press HOME and then page to the Perform-Gbl tab.
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LOADING USER CABS

In addition to thousands of onboard cabs in its factory banks, the Axe-Fx Il allows you to store up to 2,048 cabs
in user memories. These “User Cabs” allow you to personalize your Axe-Fx IIl with unique tones.

User Cabs — also know as “Impulse Responses (IRs)” — may be transferred to the Axe-Fx Ill as follows:
1. First, you'll need an impulse response file in SysEx format (.syx).

» Fractal Audio Systems offers various professionally produced user Cab Packs at https://shop.fractalaudio.
com. These include creations by Fractal Audio as well as third-party producers.

= Axe-Change, our file sharing site, is a great resource for FREE cabs. https://axechange.fractalaudio.com
= Don't confuse the newer “.IR” file format, which is solely used for re-mixing in Cab-Lab (see below).

2. Using Fractal-Bot or Axe-Edit I, transmit the file to your Axe-Fx Ill, noting which User Bank and which
numbered Slot you are sending it to. (Example: User 1, #215.)

» Fractal-Bot - This basic utility can send individual cabs to any location or transmit entire banks. To import
a single IR, open a Cab block on the grid and set Cab 1 to the Bank and Number you want to transmit a cab
to. Then send the sysex file to the Axe-Fx Ill using Fractal-Bot and the unit will save the IR to that location.

= Axe-Edit lll - The Axe-Manage Cabs tool allows you to drag and drop user cab files into memory slots.
Don't forget to press SAVE! You can also manage entries already in the memory of the Axe-Fx Il with
operations like copy, paste, rename, and drag-and-drop re-ordering. When you purchase a Cab Pack, this is
the best and easiest way to load multiple IRs at once into your Axe-Fx Ill, audition the results, and organize
your favorites.

3. Once the IR has been transmitted to your Axe-Fx llI, select the Cab block in your preset and press EDIT.
4. Change the cab to the Bank and Number that your IR was transmitted to. (Example: “USER 1, #215").
You can even create your own cabs if you have some basic equipment. See ‘IR Capture” on p. 83.

NOTE: In comparison to older Fractal Audio systems products, user cabs are NOT included in a backup of the
SYSTEM area of the Axe-Fx Ill. Conversely, restoring a System backup will never overwrite user cabs.

Cab-Lab is a full-featured 8-channel
IR mixer and toolbox in standalone
and plug-in formats.

For decades, artists, producers

and engineers have crafted tone
using a mixer to blend the sounds
of different mics or speakers. While
the Axe-Fx Il provides four mixer
slots, Cab-Lab allows up to 8, and
has additional options and tools,
with the ability to export Cab files
and save mix sessions.

Learn more at:
www.fractalaudio.com/cab-lab-3
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AXE-CHANGE

Axe-Change is the official source for sharing Preset and Cab files for your Axe-Fx Ill and other Fractal Audio
Systems products. You can upload your own creations or browse what others have contributed including some
high profile artists (though regrettably many artists treat their Axe-Fx presets as guarded secrets).

Find Axe-Change at https://axechange.fractalaudio.com.
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INPUT SELECTION

Firmware 15 for the Axe-Fx Ill introduced a new way of selecting between analog and digital input sources. Each
of the available inputs has an option in settings for ANALOG or DIGITAL. The Analog inputs are “hard wired”,
meaning that when Input 1 is set to “ANALOG" it uses the Input 1 jacks, Input 2 uses the Input 2 jacks, and so on.
When any input is set to “DIGITAL" it uses a shared digital input source, which can be set globally to your choice of
AES, SPDIF, or USB. The concept is illustrated below.

All parameters for input selection can be found in SETUP: 1/0: Audio.
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SPILLOVER

Spillover allows delay and reverb tails to “ring out” when an effect is bypassed or when you change channels,
scenes, or presets. This section covers how to set up spillover in different scenarios.

WHEN BYPASSING A BLOCK (“IA” SWITCHES)...

Block spillover is easy and requires only a particular setting in the block. For tails to ring out when an individual
block is bypassed, set that block’s Bypass Mode to “MUTE FX IN”. If an effect is running in parallel, use “MUTE
IN" instead. Be aware that different channels share effect memory, so changes to time, size, etc, may cause a
“sweep” in the tail.

WHEN SWITCHING SCENES...

Switching Scenes provides one of the best ways for sound changes to have perfect spillover. Since Scenes simply
bypass or engage blocks one-by-one or in groups, just refer to the instructions above for all blocks in your preset.

WHEN CHANGING PRESETS...

Spillover across different presets is a bit more involved. The first step is to open SETUP: Global Settings:
Settings and set the Spillover parameter to determine whether “DELAY”, “REVERB”, or “DELAY&REVERB” or “ALL"
will spill over when you change presets. (“ALL" includes not only Delay and Reverb but also Plex Delay, Multitap
Delay, Megatap and Ten-Tap delay blocks.)

You must also ensure that the exact same blocks exist in each of the presets you want to switch between. These
need to be the same block and the same number (i.e. Delay 1 spills over only through Delay 1, Delay 2 through
Delay 2, etc.). These corresponding blocks must also have similar settings and placement on the grid or problems
could be heard. For example, if you change from a preset where Delay 1 has a TIME of 500 ms, to a preset where
Delay 1 has a TIME of 100 ms, the tails will suddenly be heard as 100 ms echoes instead. Similarly, you might
hear a big difference in the tail if a block is placed after the Amp in one preset, and before it in another!

For a simple preset spillover experiment, create a preset, then save an exact copy to a new location and
test spillover. Then begin making changes as needed to settings outside of those blocks that you want
to spill over. Axe-Edit Il also makes it easy to copy and paste a block from one preset to another.
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SENDING MIDI

MIDI Messages are transmitted at the MIDI OUT/THRU port of the Axe-Fx Ill. Connect a 5-pin MIDI cable from the
MIDI Out to the MIDI In of your other device.

SEND MIDI PC

The simplest MIDI capability of the Axe-Fx Ill is transmitting a single MIDI program change message (“PC") each
time a new Preset is loaded—whether via the front panel, using an FC Footswitch, or in any other way. To enable
this, open the SETUP | MIDI/Remote menu and page to the “General” tab. Set Send MIDI PC to the desired MIDI

channel.

THE SCENE MIDI BLOCK

A more sophisticated MIDI tool is the Scene MIDI Block. Once you place this block on the grid, it transmits MIDI
messages automatically whenever a new scene is loaded—whether via the front panel, with a footswitch, or by
any other means. The Scene MIDI block can transmit up to eight total custom PC or CC messages. Remember
that a “default scene” loads automatically when you select a new preset, so any footswitch that selects a new
Preset or a new Scene can also cause the Axe-Fx Il to send a burst of MIDI messages. See the “The Fractal Audio
Blocks Guide” for more on the Scene MIDI Block.

CONTROL SWITCH MIDI

Another way the Axe-Fx Ill can transmit MIDI messages is using Control Switches set up on an external Fractal
Audio FC-6 or FC-12 Controller. The primary function of a Control Switch is to operate as a Modifier source to
control sound parameters. Beyond this, however, each of the six Control Switches has the capability to transmit
a custom “payload” of MIDI data every time the switch is turned on ON or OFF. Because this isn't tied to another
event such as a Preset or Scene change, Control Switch MIDI is more flexible and dynamic.

Because Control Switches can be momentary or latching (and even mutually exclusive), the CS MIDI system
is very versatile. You might change a connected MIDI-controlled amp, manually operate a remote processor,
sequencer, lighting system, and more.

Here is a summary of the MIDI Capabilities of a Control Switch:
» Control Switches are placed into an FC Layouts as functions.

» Control Switches 1-6 appear in the list of Modifier sources on the Axe-Fx. The role of a switch
as a modifier source is not compromised if you also use it to transmit MIDI. The same switch can
simultaneously control the Axe-Fx and a connected device. See Section 9: Modifiers to learn more.

» Each Control Switch has its own global MIDI Payload containing up to four Program
Change (“PC") or Control Change (“CC) messages on any MIDI Channels, with custom
values from 0-127, or disabled (“-") for both the ON and OFF states of the switch.

» Each MIDI Payload also has a “master switch” allowing it to be enabled or disabled.
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SETTING UP THE MIDI PAYLOAD FOR A CONTROL SWITCH:

4
4
4

Open the SETUP | FC Controllers menu and page to the “CS MIDI” tab.
Use NAV buttons and the VALUE wheel to get around the page.

Select the desired control switch at the top of the menu. (CS1, CS2, etc.)
Make sure ENABLED is set to “YES" if you want the switch to send MIDI.

NAV through the table and create your desired MIDI Payload of up to

four commands, with different values for ON and OFF

= For each command, selecting whether you want a Program Change (PC) or Control Change (CC) message.
Set the MIDI Channel for that command as desired from 1-16.

If you chose a CC Command, set the CC Number.

Set the desired Values for when the switch is ON and when it is OFF.

= You can select values from 0-127, or “-" which means “send nothing.”

There is no need to save CS MIDI settings. They take effect immediately.

See your FC Owner’s Manual and Footswitch Functions Guide for more on Control Switches.

@ Remember, Control Switches can be switched manually using a footswitch, or automatically by Scenes.
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SHORTCUTS

The Axe-Fx Il has several shortcuts and hidden features. These are summarized below.

IN GENERAL
= To show the Layout Grid for the current preset, push the VALUE wheel.
= Press EDIT to jump to the Edit menu for the currently selected block.

ON THE HOME PAGE
= Press ENTER to show the Layout Grid for the current preset.

= Use NAV LEFT/RIGHT to select presets and press NAV UP/DOWN or turn knob A to select scenes.

IN THE AMP BLOCK
= Onthe Output EQ page, press ENTER to flatten the EQ.
= Onthe Output EQ page, press NAV UP/DOWN to change the number of bands.

IN THE CAB BLOCK
= NAV to the Cab Number field and press ENTER to enter the Cab Picker for the selected.

ON THE GRID

=  With any block selected, press-and-hold ENTER to create a series of shunts and cables to bridge
empty space to the right. This will also CLEAR existing connectors between a series of blocks.

IN THE EDIT MENU OF ANY BLOCK

= Press EDIT to skip to the Edit menu of the next block, or multiple times to step through all blocks.

TO OPEN THE CONTROLLERS MENU
= Press the TEMPO button once.

ON THE SEQUENCER PAGE OF THE CONTROLLERS MENU

= With any Stage selected, press ENTER to randomize the values of all stages.
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DOUBLE-TAP SHORTCUTS

Firmware 17.0 introduced new “double-tap” shortcuts to the front panel controls. These are listed here with other
shortcuts

HOME - You can double-tap the HOME BUTTON to open the Layout grid.

EDIT - You can tap the EDIT button sequentially to step through all blocks in the current preset (top-to-bottom, left-
to-right), or double-tap to step in reverse order.

STORE - You can double-tap STORE to skip directly to the final saving prompt without reviewing name or location
changes.

PUSH-KNOBS: From any page in the Home menu or Layout menu (except “Tools"),
double tap the A, B, C, D, and E knobs to jump directly to editing the following blocks:

A:Amp 1

B: Drive 1 (think “b for boost”)
C:Cab 1

D: Delay 1

E: Reverb 1 (think “E-verb)
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FREQUENTLY ASKED QUESTIONS

Q

o] o >R =R

Q

Q

Why all the technical terminology?

The language of the Axe-Fx Ill is for the most part the universal language of professional audio.
This allows the Axe-Fx Ill to serve very diverse communities from casual to pro players, to
producers, engineers, and beyond. The terminology and concepts you will use and learn are not
unique to the Axe-Fx Ill either. Understanding them will help you to master the craft of sound
and to communicate with other pros. At the same time, the Axe-Fx Il is easier than ever, with
dedicated controls and a clear interface that doesn’t distract or disrupt the creative flow.

What is “FRFR"?

FRFR stands for “full-range, flat response.” This acronym is used to describe a “neutral”
speaker or speaker system that is designed to reproduce the entire audible spectrum of
20 Hz - 20kHz without emphasis. Examples of FRFR systems would include high-quality
studio monitors and properly designed PA systems or monitors. Many manufacturers are
also now offering FRFR systems designed specifically for direct guitar applications.

How do | upgrade the firmware of my Axe-Fx III?
Use Fractal-Bot, available from www.fractalaudio.com.

Can | load my presets from the Axe-Fx II, AX8, or FX8 into the Axe-Fx Il (or vice versa)?

No, presets are not cross-compatible, but you can generally transfer parameter settings by hand
without unexpected results. As of this writing, all of the same amp models are present, and
“factory” speaker cabs of the Axe-Fx Il are present in the “Legacy” bank on the Axe-Fx Ill.

My expression pedal isn't working. What should | do?

Expression pedals need to be calibrated and assigned to a parameter, controller or
remote function. See “Connecting Pedals Directly” on p. 12 for a basic overview. Are
you using a TRS cable? Is it connected to the correct port on the Axe-Fx I11? Is it actually
an expression pedal? Did you set up a Modifier as described in Section 9?

My Axe-Fx Il seems much quieter than my Axe-Fx Il with similar settings.

By default, analog outputs 1 and 2 are now set to -10dBV. To change these to +4dBu, use the Output
Level parameters for Out 1 and Out 2 on the Audio page of the I/0 menu under SETUP. (See p. 73.)

My Axe-Fx Il won't start up correctly.
Please see “Recovery” on p. 91.

Can | use a computer or external MIDI controller to remote control the Axe-Fx I11?
Yes. The Axe-Fx Il has a rich MIDI spec which allows it to be remote controlled. Using a computer, you

can use the built-in USB connection for “MIDI-over-USB”, rather than relying on a third-party MIDI interface.
See “The MIDI/Remote Menu” on p. 75 and “MID| Implementation” on p. 113 for more on this.
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I'm hearing click and pops.

First, check all cables. You'd be surprised by how often a short can be found in a brand new or trusted cable.
Then, check to see whether you are clipping the Axe-Fx Il inputs or outputs (p. 5).

Excessive CPU usage may also be to blame. Is the CPU meter above 80%? If so, you may have overloaded
the current preset. Try removing one block and review “Preset CPU Limits” on p. 42 for useful tips.

One or more of my presets produces no sound.

This might be any one (or several) of a number of things. Is every other component in your rig working
correctly? Most of the time, the problem is a faulty or disconnected cable. Checking the Axe-Fx IIl with
headphones can help rule this possibility out. Using the DELETE button (Push-knob B), try changing each
block to a SHUNT, ending with the Amp and Cab blocks. Do some presets work? If so, have you double-
checked to ensure that each has a complete path from the input to the output? Does every preset begin and
end with Input and Output blocks corresponding to inputs and outputs connected to other equipment? Is
there a Modifier assigned to a volume or level control while the pedal or external switch is not present? You
may simply need to change the INITIAL VALUE for an external controller from 0% to 100% (see p. 77).

Does the preset require a USER CAB which is not loaded? Try changing the Cab block to a Factory cab.

See also http://wiki.fractalaudio.com/axefx2/index.php?title=No_sound.

Why would | place a certain effect before or after an Amp and Cab?

Sonically speaking, the main reason to care about effect placement is that a given
effect will sound different when placed before or after distortion.

How does this difference sound? If you've ever switched the sequence of traditional drive and wah pedals,
you've heard an excellent example. In the case of wah before overdrive, the resonant filter of the wah
“excites” the overdrive in a cool way while still retaining a natural overall tone. When the wah follows
distortion, you might hear a more dramatic sweep that almost sounds synth-like and might be considered
less “classic.” It's not surprising then that wah would traditionally be a run as a “pre” effect between
guitar and amp. The amp’s distortion follows the wah. Many other effects fall in this same category.

A different example is found in overdrive with reverb or delay. In the natural world, reverb and echo occur
because of open spaces around your guitar amp - like a club or concert hall. These effects would therefore
NOT be heard before a distorted amp, but after it. Recording studios often add these kinds of effects “post”,
i.e. at the console—after the mic has picked up the distorted sound from the guitar amp. If you wanted to
simulate this natural sounding reverb or delay these effects would likely be run “post.” This is not to say that
delay or reverb before distortion is a “no-no.” Many “legendary” tones came from echo units in front of an
amp—but this effect is very different from “post” delay—not only tonally, but also in terms of dynamics.

The good news is that the Axe-Fx Il allows you to experiment easily and find what combinations
of pre- and post-effects work best for you. Creativity begins where conformity ends.
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MIDI REFERENCE TABLES

MIDI BANK & PROGRAM CHANGE

The following table lists the MIDI Bank and Program Change messages required to select Axe-Fx Il presets.
MIDI Bank Select (CC#0) Value , Midi Program Change = Axe-Fx Ill Preset Number.

0,0 =0 0,42 = 42 0,84 = 84 0,126 = 126 1,40 = 168
0,1 =1 0,43 = 43 0,85 = 85 0,127 = 127 1,41 = 169
0,2 =2 0,44 = 44 0,86 = 86 1,0 = 128 1,42 = 170
0,3 =3 0,45 = 45 0,87 = 87 1,1 =129 1,43 = 17
0,4 =4 0,46 = 46 0,88 = 88 1,2 = 130 1,44 = 172
0,5 =5 0,47 = 47 0,89 = 89 1,3 = 131 1,45 = 173
0,6 =6 0,48 = 48 0,90 = 90 1,4 = 132 1,46 = 174
07 =17 0,49 = 49 0,91 = 9 1,5 = 133 1,47 = 175
0,8 =38 0,50 = 50 0,92 = 92 1,6 = 134 1,48 = 176
0,9 =9 0,51 = 51 0,93 = 93 1,7 =135 1,49 = 177
0,170 = 10 0,52 = 52 0,94 = 94 1,8 = 136 1,50 = 178
0,11 =M 0,53 = 53 0,95 = 95 1,9 = 137 1,51 = 179
0,12 = 12 0,54 = 54 0,96 = 96 1,10 = 138 1,52 = 180
0,13 = 13 0,55 = 55 0,97 = 97 1,11 = 139 1,53 = 181
0,14 = 14 0,56 = 56 0,98 = 98 1,12 = 140 1,54 = 182
0,15 = 15 0,57 = 57 0,99 = 99 1,13 = 1M 1,55 = 183
0,16 = 16 0,58 = 58 0,700 = 100 1,14 = 142 1,56 = 184
0,177 = 17 0,59 = 59 0,101 = 101 1,15 = 143 1,57 = 185
0,18 = 18 0,60 = 60 0,102 = 102 1,16 = 144 1,58 = 186
0,19 =19 0,61 = 61 0,703 = 103 1,17 = 145 1,59 = 187
0,20 = 20 0,62 = 62 0,104 = 104 1,18 = 146 1,60 = 188
0,21 = 21 0,63 = 63 0,105 = 105 1,19 = 147 1,61 = 189
0,22 = 22 0,64 = 64 0,706 = 106 1,20 = 148 1,62 = 190
0,23 = 23 0,65 = 65 0,107 = 107 1,21 = 149 1,63 = 191
0,24 = 24 0,66 = 66 0,108 = 108 1,22 = 150 1,64 = 192
0,25 = 25 0,67 = 67 0,709 = 109 1,23 = 151 1,65 = 193
0,26 = 26 0,68 = 68 0,110 = 110 1,24 = 152 1,66 = 194
0,27 = 27 0,69 = 69 0,111 = 111 1,25 = 153 1,67 = 195
0,28 = 28 0,70 = 70 0,112 = 112 1,26 = 154 1,68 = 196
0,29 = 29 0,71 =T 0,113 = 113 1,27 = 155 1,69 = 197
0,30 = 30 0,72 = 72 0,114 = 114 1,28 = 156 1,70 = 198
0,31 = 31 0,73 =73 0,115 = 115 1,29 = 157 1,71 = 199
0,32 = 32 0,74 = 74 0,116 = 116 1,30 = 158 1,72 = 200
0,33 = 33 0,75 =75 0,117 = 117 1,31 = 159 1,73 = 201
0,34 = 34 0,76 = 76 0,118 = 118 1,32 = 160 1,74 = 202
0,35 = 35 0,77 =77 0,119 = 119 1,33 = 161 1,75 = 203
0,36 = 36 0,78 = 78 0,120 = 120 1,34 = 162 1,76 = 204
0,37 = 37 0,79 =79 0,121 = 121 1,35 = 163 1,77 = 205
0,38 = 38 0,80 = 80 0,122 = 122 1,36 = 164 1,78 = 206
0,39 = 39 0,81 = 81 0,123 = 123 1,37 = 165 1,79 = 207
0,40 = 40 0,82 = 82 0,124 = 124 1,38 = 166 1,80 = 208
0,41 = 41 0,83 = 83 0,125 = 125 1,39 = 167 1,81 = 209
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1,82 = 210 2,6 = 262 2,58 = 314 2,110 = 366 3,34 = 418 3,86 = 470
1,83 = 21 2,7 = 263 2,59 = 315 2,111 = 367 3,35 = 419 3,87 = 471
1,84 = 212 2,8 = 264 2,60 = 316 2,112 = 368 3,36 = 420 3,88 = 472
1,8 = 213 2,9 = 265 2,61 = 317 2,113 = 369 3,37 = 421 3,80 = 473
1,86 = 214 2,10 = 266 2,62 = 318 2,114 = 370 3,38 = 422 3,90 = 474
1,87 = 215 2,11 = 267 2,63 = 319 2,115 = 371 3,39 = 423 3,91 = 475
1,88 = 216 2,12 = 268 2,64 = 320 2,116 = 372 3,40 = 424 3,92 = 476
1,8 = 217 2,13 = 269 2,65 = 321 2,117 = 373 3,41 = 425 3,93 = 477
1,90 = 218 2,14 = 270 2,66 = 322 2,118 = 374 3,42 = 426 3,94 = 478
1,91 = 219 2,15 = 271 2,67 = 323 2,119 = 375 3,43 = 427 3,95 = 479
1,92 = 220 2,16 = 272 2,68 = 324 2,120 = 376 3,44 = 428 3,96 = 480
1,93 = 221 2,17 = 273 2,69 = 325 2,121 = 377 3,45 = 429 3,97 = 481
1,94 = 222 2,18 = 274 2,70 = 326 2,122 = 378 3,46 = 430 3,98 = 482
1,95 = 223 2,19 = 275 2,71 = 327 2,123 = 379 3,47 = 431 3,99 = 483
1,96 = 224 2,20 = 276 2,72 = 328 2,124 = 380 3,48 = 432 3,100 = 484
1,97 = 225 2,217 =271 2,73 = 329 2,125 = 381 3,49 = 433 3,101 = 485
1,98 = 226 2,22 = 278 2,74 = 330 2,126 = 382 3,50 = 434 3,102 = 486
1,99 = 227 2,23 =279 2,75 = 331 2,127 = 383 3,51 = 435 3,103 = 487
1,100 = 228 2,24 = 280 2,76 = 332 3,0 = 384 3,52 = 436 3,104 = 488
1,101 = 229 2,25 = 281 2,77 = 333 3,1 = 385 3,53 = 437 3,105 = 489
1,102 = 230 2,26 = 282 2,78 = 334 3,2 = 386 3,54 = 438 3,106 = 490
1,103 = 231 2,27 = 283 2,79 = 335 3,3 = 387 3,55 = 439 3,107 = 491

1,104 = 232 2,28 = 284 2,80 = 336 3,4 = 388 3,56 = 440 3,108 = 492
1,106 = 233 2,29 = 285 2,81 = 337 3,5 = 389 3,57 = 441 3,109 = 493
1,106 = 234 2,30 = 286 2,82 = 338 3,6 = 390 3,58 = 442 3,110 = 494
1,107 = 235 2,31 = 287 2,83 = 339 3,7 = 391 3,59 = 443 3,111 = 495
1,108 = 236 2,32 = 288 2,84 = 340 3,8 = 392 3,60 = 444 3,112 = 496
1,109 = 237 2,33 = 289 2,85 = 341 3,9 = 393 3,61 = 445 3,113 = 497
1,110 = 238 2,34 = 290 2,86 = 342 3,10 = 394 3,62 = 446 3,114 = 498
1,111 = 239 2,35 = 291 2,87 = 343 3,11 = 395 3,63 = 447 3,115 = 499
1,112 = 240 2,36 = 292 2,88 = 344 3,12 = 39 3,64 = 448 3,116 = 500
1,113 = 241 2,37 = 293 2,89 = 345 3,13 = 397 3,65 = 449 3,117 = 501
1,114 = 242 2,38 = 294 2,90 = 346 3,14 = 398 3,66 = 450 3,118 = 502
1,115 = 243 2,39 = 295 2,91 = 347 3,15 = 399 3,67 = 451 3,119 = 503
1,116 = 244 2,40 = 296 2,92 = 348 3,16 = 400 3,68 = 452 3,120 = 504
1,117 = 245 2,41 = 297 2,93 = 349 3,17 = 401 3,69 = 453 3,121 = 505
1,118 = 246 2,42 = 298 2,94 = 350 3,18 = 402 3,70 = 454 3,122 = 506
1,119 = 247 2,43 = 299 2,95 = 351 3,19 = 403 3,71 = 455 3,123 = 507
1,120 = 248 2,44 = 300 2,96 = 352 3,20 = 404 3,72 = 456 3,124 = 508
1,121 = 249 2,45 = 301 2,97 = 353 3,21 = 405 3,73 = 457 3,125 = 509
1,122 = 250 2,46 = 302 2,98 = 354 3,22 = 406 3,74 = 458 3,126 = 510
1,123 = 251 2,47 = 303 2,99 = 355 3,23 = 407 3,75 = 459 3,127 = 511
1,124 = 252 2,48 = 304 2,100 = 356 3,24 = 408 3,76 = 460

1,125 = 253 2,49 = 305 2,101 = 357 3,25 = 409 3,77 = 461

1,126 = 254 2,50 = 306 2,102 = 358 3,26 = 410 3,78 = 462

1,127 = 255 2,51 = 307 2,103 = 359 3,27 = 411 3,79 = 463

2,0 = 256 2,52 = 308 2,104 = 360 3,28 = 412 3,80 = 464

2,1 = 257 2,53 = 309 2,105 = 361 3,29 = 413 3,81 = 465
2,2 = 258 2,54 = 310 2,106 = 362 3,30 = 414 3,82 = 466
2,3 =259 2,55 = 311 2,107 = 363 3,31 = 415 3,83 = 467

2,4 = 260 2,56 = 312 2,108 = 364 3,32 = 416 3,84 = 468
2,5 = 261 2,57 = 313 2,109 = 365 3,33 = 417 3,85 = 469
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Entries on this page and the next are used only by the Axe-Fx Il Mark I, which has a total of 1,024 presets.

4, 0=512 4, 43 = 555 4, 86 =598 5 1=641 5, 44 =684 5, 87=727
4,1=513 4, 44 = 556 4, 87 =599 5, 2=642 5, 45=1685 5, 88=728
4,2=514 4, 45 =557 4, 88 =600 5 3=643 5, 46 = 686 5 89=729
4, 3=515 4, 46 = 558 4, 89 =601 5 4=644 5, 47 =687 5, 90=730
4, 4=516 4, 47 = 559 4, 90 = 602 5 5=645 5, 48 =688 5, 91 =731
4, 5=517 4, 48 = 560 4, 91=603 5, 6 =646 5, 49 =689 5, 92=732
4, 6=518 4, 49 = 561 4, 92 = 604 5 7=0647 5, 50 =690 5, 93=733
4,7=519 4, 50 = 562 4, 93 =605 5, 8=648 5, 51 =691 5, 94 =734
4, 8 =520 4, 51 =563 4, 94 =606 5, 9=649 5, 52 =692 5, 95=735
4, 9=521 4, 52 =564 4, 95=607 5, 10 = 650 5, 53=693 5, 96 =736
4, 10 = 522 4, 53 =565 4, 96 =608 5, 11 =651 5, 54 =694 5, 97=737
4, 11=523 4, 54 = 566 4, 97 =609 5, 12 =652 5, 65=695 5, 98 =738
4,12 =524 4, 55 =567 4,98=610 5, 13=653 5, 56 = 696 5, 99=739
4, 13 =525 4, 56 = 568 4,99=611 5 14=654 5, 57 =697 5, 100 = 740
4, 14 =526 4, 57 =569 4, 100=612 5 15=655 5, 58 =698 5, 101 =741
4, 15=1527 4, 58 =570 4, 101=613 5, 16 = 656 5, 59=699 5, 102 =742
4, 16 =528 4, 59 =571 4,102=614 5, 17 = 657 5, 60 =700 5, 103 =743
4, 17 =529 4, 60 = 572 4,103=615 5 18 =658 5, 61=701 5, 104 =744
4, 18 =530 4, 61=573 4, 104=616 5, 19=659 5, 62 =702 5, 105 =745
4, 19 =531 4, 62 =574 4, 105=617 5, 20 = 660 5, 63=703 5, 106 = 746
4, 20 = 532 4, 63 =575 4, 106=618 5, 21 =661 5, 64 =704 5, 107 =747
4, 21 =533 4, 64 =576 4, 107=619 5, 22 = 662 5, 65=705 5, 108 =748
4, 22 =534 4, 65=1577 4, 108 =620 5, 23=663 5, 66 =706 5, 109 =749
4, 23 =535 4, 66 =578 4, 109 = 621 5, 24 = 664 5, 67 =707 5, 110 =750
4, 24 = 536 4, 67 =579 4, 110 =622 5, 25=665 5, 68 =708 5 111=751
4, 25= 1537 4, 68 =580 4, 111 =623 5, 26 = 666 5, 69 =709 5, 112 =752
4, 26 = 538 4, 69 = 581 4, 112=624 5, 27 =667 5 70=710 5, 113 =753
4, 27 =539 4, 70 = 582 4, 113 =625 5, 28 =668 5 71=T711 5 114=754
4, 28 = 540 4, 71 =583 4, 114 =626 5,29 =669 5 72=712 5 115=755
4, 29 =541 4, 72 =584 4, 115=627 5, 30=670 5 73=713 5, 116 = 756
4, 30 = 542 4, 73 =585 4,116 =628 5, 31 =671 5 74=714 5, 117 =757
4, 31=543 4, 74 = 586 4, 117 =629 5, 32=672 5 75=715 5, 118 =758
4, 32 =544 4, 75 =587 4, 118 =630 5, 33=673 5 76=716 5, 119=759
4, 33 =545 4, 76 = 588 4, 119 =631 5 34=674 5 77=717 5, 120 =760
4, 34 = 546 4, 77 =589 4, 120 =632 5, 35=675 5 78=718 5, 121 =761
4, 35= 1547 4, 78 =590 4, 121 =633 5, 36=676 5 79=719 5, 122 =762
4, 36 = 548 4, 79 =591 4,122 =634 5, 37=677 5, 80=720 5, 123=763
4, 37 =549 4, 80 =592 4,123 =635 5 38=678 5, 81 =721 5, 124 =764
4, 38 =550 4, 81=1593 4, 124 =636 5, 39=679 5, 82=722 5, 125=765
4, 39 = 551 4, 82 =594 4, 125=637 5, 40 = 680 5 83=723 5, 126 =766
4, 40 = 552 4, 83 =595 4, 126 = 638 5, 41 =681 5 84=724 5, 127 =767
4, 41 =553 4, 84 =596 4, 127 =639 5, 42 =682 5, 85=725

4, 42 = 554 4, 85=1597 5, 0=640 5, 43 =683 5, 86 =726
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6, 0=768 6, 43 =811 6, 86 = 854 7, 1=2897 7, 44 =940 7, 87 =983

6, 1=769 6, 44 =812 6, 87 =855 7, 2=898 7, 45=941 7, 88 =984

6, 2=770 6, 45=813 6, 88 =856 7, 3=899 7, 46 = 942 7, 89=985

6, 3=771 6, 46 =814 6, 89 =857 7, 4=900 7, 47 =943 7, 90 = 986

6, 4=772 6, 47 =815 6, 90 = 858 7, 5=901 7, 48 =944 7, 91 =987
6, 5=773 6, 48 =816 6, 91 =859 7, 6 =902 7, 49 =945 7, 92 =988

6, 6=774 6, 49 = 817 6, 92 = 860 7, 7=903 7, 50 = 946 7, 93 =989

6, 7=775 6, 50 =818 6, 93 =861 7, 8=904 7, 51 =947 7, 94=990

6, 8=776 6, 51 =819 6, 94 = 862 7, 9=905 7, 52 =948 7, 95=991

6, 9=777 6, 52 =820 6, 95=2863 7, 10 =906 7, 53 =949 7, 96 =992

6, 10=778 6, 53 = 821 6, 96 = 864 7, 11 =907 7, 54 =950 7, 97 =993

6, 11=779 6, 54 = 822 6, 97 = 865 7, 12=908 7, 55 =951 7, 98 =994

6, 12=780 6, 55=2823 6, 98 = 866 7, 13=909 7, 56 =952 7, 99=995

6, 13 =781 6, 56 = 824 6, 99 = 867 7, 14=910 7, 57 =953 7, 100 = 996
6, 14 =782 6, 57 =825 6, 100 = 868 7, 15=911 7, 58 =954 7, 101 =997
6, 15=783 6, 58 = 826 6, 101 =869 7, 16 =912 7, 59 =955 7, 102 =998
6, 16 =784 6, 59 = 827 6, 102 = 870 7, 17=913 7, 60 =956 7, 103 =999
6, 17 =785 6, 60 = 828 6, 103 = 871 7, 18=914 7, 61=957 7, 104 =1000
6, 18 =786 6, 61=2829 6, 104 =872 7,19=915 7, 62 =958 7, 105=1001
6, 19 =787 6, 62 =830 6, 105 =873 7, 20=916 7, 63 =959 7, 106 = 1002
6, 20 =788 6, 63 =831 6, 106 = 874 7, 21 =917 7, 64 =960 7, 107 = 1003
6, 21 =789 6, 64 =832 6, 107 =875 7, 22=918 7, 65=961 7, 108 = 1004
6, 22=790 6, 65 =833 6, 108 = 876 7, 23=919 7, 66 =962 7, 109 =1005
6, 23 =791 6, 66 = 834 6, 109 = 877 7, 24 =920 7, 67 =963 7, 110 = 1006
6, 24 =792 6, 67 =835 6, 110 =878 7, 25=921 7, 68 =964 7, 111 =1007
6, 25=793 6, 68 = 836 6, 111 =879 7, 26 =922 7, 69 =965 7, 112=1008
6, 26 = 794 6, 69 =837 6, 112 = 880 7, 27 =923 7, 70 = 966 7, 113 =1009
6, 27=795 6, 70 = 838 6, 113 = 881 7, 28 =924 7, 71 =967 7, 114=1010
6, 28 =796 6, 71 =839 6, 114 = 882 7, 29 =925 7, 72 =968 7, 115=1011
6, 29 =797 6, 72 = 840 6, 115=3883 7, 30 =926 7, 73 =969 7, 116 =1012
6, 30 =798 6, 73 = 841 6, 116 = 884 7, 31=927 7, 74=970 7, 117=1013
6, 31=799 6, 74 =842 6, 117 =885 7, 32=928 7, 75=971 7, 118 =1014
6, 32 =800 6, 75=843 6, 118 = 886 7, 33=929 7, 76 =972 7, 119=1015
6, 33 =801 6, 76 = 844 6, 119 = 887 7, 34=930 7, 77=973 7, 120=1016
6, 34 =802 6, 77 =845 6, 120 = 888 7, 35=931 7, 78 =974 7, 121 =1017
6, 35=803 6, 78 = 846 6, 121 =889 7, 36 =932 7, 79=975 7, 122=1018
6, 36 = 804 6, 79 = 847 6, 122 = 890 7, 37=933 7, 80=976 7, 123=1019
6, 37 =805 6, 80 =848 6, 123 = 891 7, 38=934 7, 81=977 7, 124 =1020
6, 38 =806 6, 81 =849 6, 124 = 892 7, 39=935 7, 82=978 7, 125=1021
6, 39 = 807 6, 82 =850 6, 125=3893 7, 40 =936 7, 83=979 7, 126 = 1022
6, 40 =808 6, 83 =851 6, 126 = 894 7, 41 =937 7, 84 =980 7, 127 =1023
6, 41 =809 6, 84 =852 6, 127 =895 7, 42 =938 7, 85=981

6, 42=810 6, 85=2853 7, 0=896 7, 43 =939 7, 86 =982
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15 ADDITIONAL TOPICS

CC VALUE TO SCENE

When selecting Scenes using the global options found on the Other page of the MIDI/Remote menu under SETUP,
the value of the designated CC# determines the Scene:

0........ 1 16....... 1 32....... 1 48....... 1 64....... 1 80....... 1T 96....... 1T 1M2...... 1
T 2 17....... 2 33....... 2 49....... 2 65...... 2 81....... 2 97....... 2 1M3...... 2
2........ 3 18....... 3 34....... 3 50....... 3 66....... 3 82....... 3 98....... 3 114...... 3
3. 4 19....... 4 35....... 4 51....... 4 67....... 4 83....... 4 99....... 4 115...... 4
4........ 5 20....... 5 36....... 5 52....... 5 68....... 5 84....... 5 100...... 5 116...... 5
S5 ... 6 21....... 6 37....... 6 53....... 6 69....... 6 85...... 6 101...... 6 117...... 6
6........ 7 22....... 7 38....... 7 54....... 7 70....... 7 86....... 7 102...... 7 118...... 7
7.0 .. 8 23....... 8§ 39....... 8 55....... 8 T71....... 8 87....... 8§ 103...... 8 119...... 8
8........ 1T 24....... 1 40....... 1 56....... 1 72....... 1 88....... 1 104...... 1 120...... 1
9........ 2 25....... 2 4. 2 57....... 2 T73....... 2 89....... 2 105...... 2 121...... 2
10....... 3 26....... 3 42....... 3 58....... 3 T4....... 3 90....... 3 106...... 3 122...... 3
Mmoo 4 27....... 4 43....... 4 59....... 4  T75....... 4 91....... 4 107...... 4 123...... 4
12....... 5 28....... 5 44 ... 5 60....... 5 76....... 5 92....... 5 108...... 5 124...... 5
13....... 6 29....... 6 45....... 6 61....... 6 77....... 6 93....... 6 109...... 6 126...... 6
14....... 7 30....... 7 46....... 7 62....... 7 78....... 7 94....... 7 110...... 7 126...... 7
15....... 8 31....... 8 47....... 8 63....... 8 79....... 8 95...... 8 111...... 8 127...... 8
CC VALUE TO CHANNEL

When changing Channels using the global options found on the Channel page of the MIDI/Remote menu under
SETUP, the value of the designated CC# determines the Channel:

0........ A T6....... A 32....... A 48....... A 64...... A 80....... A 96....... A 112...... A
T B 17....... B 33...... B 49....... B 65....... B 81....... B 97....... B 113...... B
2. C 18....... C 34...... C 50....... C 66....... C 82....... C 98...... C 14...... C
3. D 19....... D 35...... D 51....... D 67....... D 83...... D 99....... D 15...... D
4........ A 20....... A 36....... A 52....... A 68....... A 84....... A 100...... A 116...... A
S B 21....... B 37....... B 583....... B 69....... B 85...... B 101...... B 117...... B
6........ C 22....... C 38...... C b54...... C 70....... C 86....... c 102..... C 18...... C
7........ D 23....... D 30....... D 55...... D 71....... D 87....... D 103...... D 119...... D
8........ A 24...... A 40....... A 56....... A T72....... A 88....... A 104...... A 120...... A
9........ B 25....... B 41....... B 57....... B 73....... B 89....... B 105...... B 121...... B
10....... C 26....... C 42....... C 58...... C 74...... C 90....... C 106...... C 122...... C
M. D 27....... D 43....... D 59....... D 75....... D 91....... D 107...... D 123...... D
12....... A 28....... A 44....... A 60....... A T76....... A 92....... A 108...... A 124...... A
13....... B 29....... B 45....... B 61....... B 77....... B 93....... B 109...... B 125...... B
14....... C 30....... C 46....... C 62....... C 78....... C 94...... C 110...... C 126...... C
15....... D 31....... D 47....... D 63....... D 79....... D 95....... D 11...... D 127...... D
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16 SPECIFICATIONS

INSTRUMENT INPUTS

Connectors:
Impedance:
Max. Input Level:

ANALOG INPUT 2

Front and rear 1/4" phone jacks, unbalanced (front automatically overrides rear)

1 MQ (less if “Auto-Z" is active)
+16 dBu

Connectors:
Impedance:
Max. Input Level:

ANALOG INPUT 3

(2) XLR-F + 1/4" phone “combo jack” balanced
1 MQ
+20 dBu

Connectors:
Impedance:
Max. Input Level:

ANALOG INPUT 4

(2) 1/4" phone jack balanced (TRS)
1MQ
+20 dBu

Connectors: (2) 1/4" phone jack balanced (TRS)
Impedance: 1 MQ

Max. Input Level: +20 dBu

A/D CONVERSION

Bit Depth: 24 bits

Sample Rate: 48 kHz

Dynamic Range: 114 dB

Frequency Response:
Crosstalk:

20 - 20kHz, +0 /-1 dB
< -60 dB over full bandwidth

ANALOG OUTPUT 1
Connectors: (2) XLR balanced with Ground Lift
(2) 1/4" phone jack unbalanced (hum-canceling)
Selectable between -10 dBV and +4 dBu in software
Impedance: 600 Q
Max Output Level: +20 dBu
ANALOG OUTPUT 2
Connectors: (2) XLR-M balanced with Ground Lift
Selectable between -10 dBV and +4 dBu in software
Impedance: 600 Q
Max Output Level: +20 dBu
ANALOG OUTPUT 3
Connectors: (2) 1/4" phone jack unbalanced (hum-canceling)
Impedance: 600 Q
Max Output Level: +20 dBu
ANALOG OUTPUT 4
Connectors: (2) 1/4" phone jack unbalanced (hum-canceling)
Impedance: 600 Q
Max Output Level: +20 dBu
HEADPHONE OUTPUT
Connector: 1/4" stereo phone jack

Impedance:
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16 SPECIFICATIONS

D/A CONVERSION

Dynamic Range:
Frequency Response:

114 dB
20 - 20kHz, +0 /-1 dB

DIGITAL I/0

Connectors: RCA Coaxial Type for S/PDIF, XLR for AES (selectable in software)
Format: Uncompressed PCM

Sample Rate: 48 kHz fixed

USB AUDIO

Format: USB 2.0 Class compliant

Channels: 16 (8 in, 8 out, each mapped to a specific source or connector)
USB Audio Clock: 48 kHz fixed

MIDI INTERFACE

Input Connector:
Output Connector:
Thru Connector:

PEDAL INTERFACE

(1) 5-pin DIN
(1) 5-pin DIN
(1) 5-pin DIN

Connectors:
Format:

FASLINK Il INTERFACE

(2) 1/4" TRS phone jack
Pedal: 10-100 kQ max
Switch: make/break; momentary or latching

Connectors: (1) XLR-F
WARNING: Connect ONLY to the FASLINK Il connector on a Fractal Audio FC Series controller
GENERAL
Finish: Powder coated steel chassis with anodized aluminum faceplate
Controls: 12 buttons, 10 knobs (6 with additional “push” functions)
Display: 800x480 high contrast color LCD
Dimensions: 19.00" W. x 5.16" H. x 11.53" D.
482.6mm W. x 131.1Tmm H. x 292.87mm D.
(including front handles and rear jacks)
Weight: 15Ibs 2.4 0z (6.87 kg)
Input Voltage: 90-264 VAC, 47 - 63 Hz (universal input)
Power Consumption: <40 W
Backup Battery Life: >10 years
Backup Battery Type: CR-2032
ENVIRONMENTAL
Operating Temperature: 3210122 °F (0 to 50 °C)
Storage Temperature: -22t0 167 °F (-30 to 70 °C)

Humidity:

Max. non-condensing
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MIDI IMPLEMENTATION

The Axe-Fx Il features a robust MIDI implementation detailed below.

16 SPECIFICATIONS

Function Tx Rx | Remarks
Basic Channel Default 1 1
Changed 1-16 | 1-16
Note Number True Voice X X
Velocity Note ON X X
Note OFF X X
After Touch Keys X X
Channels X X
Pitch Bend X X
Control Change X 0 Receivable CCs are globally soft-assigned to
functions via the MIDI/Remote menu under SETUP.
These include Input and Output volumes, Tap Tempo,
Tuner, 16 “External Controllers” (assignable as
modifiers to one or more parameters on a per-preset
basis), some Scene functions, all Looper functions,
and all block BYPASS and CHANNEL switches.
Program Change True Number 0 0 [ The Axe-Fx Il can transmit CC and PC messages.
Bank Select X 0
System Exclusive Fractal Audio 0 0 | SysExis used extensively for Axe-Edit IIl.
Real time 0 X
Non-Real time X X
System Common Song Position X X
Song Select X X
Tune Request X X
System Real time Clock X 0 [ Axe-Fx Il Global Tempo syncs automatically to MIDI
Commands X X Beat Clock. Axe-Fx Il does not transmit MIDI clock.
Auxiliary Messages | Local ON/OFF X X
All Notes OFF X X
Active Sense X X
Reset X X
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WARRANTY

Fractal Audio Systems warrants that your new Fractal Audio Systems product shall be free of defects in materials
and workmanship for a period of one (1) year from the original date of purchase.

During the warranty period, Fractal Audio Systems shall, at its sole option, either repair or replace any product that
proves to be defective upon inspection by Fractal Audio Systems.

Fractal Audio Systems reserves the right to update any unit returned for repair and to change or improve the
design of the product at any time without notice. Fractal Audio Systems reserves the right to use reconditioned
parts and assemblies as warranty replacements for authorized repairs. This warranty is extended to the original
retail purchaser for units purchased directly from Fractal Audio Systems or one of its authorized distributors or
resellers.

This is your sole warranty. Fractal Audio Systems does not authorize any third party, including any dealer or sales
representative, to assume any liability on behalf of Fractal Audio Systems or to make any warranty for Fractal
Audio Systems. Fractal Audio Systems may, at its option, require proof of original purchase date in the form of a
dated copy of original authorized dealer’s invoice or sales receipt. Service and repairs of Fractal Audio Systems
products are to be performed only at the Fractal Audio Systems factory or a Fractal Audio Systems authorized
service center. Fractal Audio Systems may require advanced authorization of repairs to authorized service
centers. Unauthorized service, repair or modification will void this warranty.

DISCLAIMER AND LIMITATION OF WARRANTY

THE FOREGOING WARRANTY IS THE ONLY WARRANTY GIVEN BY FRACTAL AUDIO SYSTEMS AND IS IN LIEU OF
ALL OTHER WARRANTIES. ALL IMPLIED WARRANTIES, INCLUDING WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR ANY PARTICULAR PURPOSE, EXCEEDING THE SPECIFIC PROVISIONS OF THIS WARRANTY ARE
HEREBY DISCLAIMED AND EXCLUDED FROM THIS WARRANTY. UPON EXPIRATION OF THE APPLICABLE EXPRESS
WARRANTY PERIOD (1 YEAR), FRACTAL AUDIO SYSTEMS SHALL HAVE NO FURTHER WARRANTY OBLIGATION OF
ANY KIND, EXPRESS OR IMPLIED. FRACTAL AUDIO SYSTEMS SHALL IN NO EVENT BE LIABLE FOR ANY SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES SUFFERED BY THE PURCHASER OR ANY THIRD PARTY, INCLUDING
WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS OR BUSINESS, OR DAMAGES RESULTING FROM USE OR
PERFORMANCE OF THE PRODUCT, WHETHER IN CONTRACT OR IN TORT. FRACTAL AUDIO SYSTEMS SHALL NOT
BE LIABLE FOR ANY EXPENSES, CLAIMS, OR SUITS ARISING OUT OF OR RELATING TO ANY OF THE FOREGOING.
Some states do not allow the exclusion or limitation of implied warranties so some of the above limitations and
exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have other rights,
which vary, from state to state. This warranty only applies to products sold and used in the USA and Canada.
Fractal Audio Systems shall not be liable for damages or loss resulting from the negligent or intentional acts of
the shipper or its contracted affiliates. You should contact the shipper for proper claims procedures in the event
of damage or loss resulting from shipment.
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EULA

BY ACCEPTING, INSTALLING OR USING ANY PART OF THIS PRODUCT YOU ARE CONSENTING TO ALL OF THE TERMS AND CONDITIONS OF THIS ENTIRE END USER LICENSE AGREEMENT (“EULA"). IF YOU
DO NOT AGREE TO ALL THE TERMS AND CONDITIONS OF THIS ENTIRE AGREEMENT, ARE UNABLE OR UNWILLING COMPLY WITH THESE TERMS AND CONDITIONS, YOU MUST DISCONTINUE USE OF THE
PRODUCT IMMEDIATELY AS YOU HAVE NO AUTHORITY OR LICENSE TO USE THE PRODUCT.

TERMS AND CONDITIONS
1) GRANT OF LICENSE FOR PRE INSTALLED OR USER UPGRADED FIRMWARE (“THE SOFTWARE")

Subject to the terms and conditions set forth herein, Fractal Audio Systems, (“FAS”) grants you an individual, personal, non-sub licensable, nonexclusive license to use this product in accordance with the
applicable end user documentation, if any (the “License”). The user will not, directly or indirectly, reverse engineer, decompile, disassemble or otherwise attempt to discover the source code or underlying
ideas or algorithms of the Software; modify, translate, or create derivative works based on the Software; or copy (except for archival purposes), rent, lease, distribute, assign, or otherwise transfer rights to the
Software (except as expressly authorized by this Agreement); remove any proprietary notices, comments, terms and conditions and or labels on or in the Software. As between the parties, you acknowledge
that FAS and its licensors retain their respective ownership of the Software, any portions or copies thereof, and all rights therein throughout the world. Upon termination of this Agreement for any reason, the
License and all rights granted to you under this Agreement will terminate and you will cease to use the Software. You may permanently transfer the limited rights of use of the Software granted to you under
this Agreement only as part of a permanent sale or transfer of the hardware device containing the software, and only if the recipient agrees to be bound by the terms and conditions of this Agreement. You
acknowledge that you have no rights in or to, and may not transfer or otherwise authorize the use of, any “beta” or “preview” software of FAS and its licensors. THIS LIMITED LICENSE TO USE AND TRANSFER
THE SOFTWARE IS PROVIDED AS-IS AND IS SUBJECT TO THE RESTRICTIONS, INDEMNITY AND WARRANTY DISCLAIMERS AND LIMITATIONS OF LIABILITY SET FORTH BELOW.

2) RESTRICTIONS, WARRANTY DISCLAIMERS AND INDEMNITY OBLIGATION AGREED TO BY YOU IN EXCHANGE FOR LIMITED GRANT OF LICENSE.

YOU WILL ONLY USE THE SOFTWARE FOR LAWFUL PURPOSES AND IN COMPLIANCE WITH ALL APPLICABLE LAWS. YOU HEREBY AGREE TO DEFEND AND INDEMNIFY FAS AND ITS LICENSORS AGAINST ANY
CLAIM OR ACTION THAT ARISES FROM YOUR USE OF THE SOFTWARE IN AN UNLAWFUL MANNER (INCLUDING, WITHOUT LIMITATION, ANY CLAIM OR ACTION ALLEGING INFRINGEMENT OF ANY PATENT,
COPYRIGHT, TRADEMARK, TRADE SECRET, OR OTHER INTELLECTUAL PROPERTY; UNFAIR COMPETITION; VIOLATION OF GENERAL BUSINESS LAWS; OR VIOLATION OF ANY OTHER LAWS OR RIGHTS) OR ANY
OTHER USE OF THE SOFTWARE NOT EXPRESSLY AUTHORIZED PURSUANT TO THIS AGREEMENT.

3) IMPULSE RESPONSE EXPORT FOR COMMERCIAL USE

Offering for sale any Impulse Response data (e.g. “Tone Match Export/Save/Dump”, “User Cab Export/Save/Dump”) created, converted or modified using Fractal Audio Systems hardware and/or software
requires a commercial use license. Recording studios, consultants, and other commercial entities may use these features in conjunction with work performed for their commercial customers, but the resulting
data files created may not be offered for sale or gifted to their commercial customers or other third parties without a commercial license from FAS and its licensors where applicable. Contact sales@
fractalaudio.com to obtain a commercial license.

4) IMPULSE RESPONSE DATA EXPORT FOR NON-COMMERCIAL USE

You are free to export Impulse Response data for non-commercial use. This includes producing, converting, or modifying Impulse Response data for yourself, or offering/distributing such data at no charge to
third parties. Files created without a commercial license cannot be included for free with another product or package that is offered for sale. Contact sales@fractalaudio.com to obtain a commercial license.

5) SUPPORT

Subject to the terms hereof, FAS will provide you with e-mail support services for the Software. Under no circumstances will FAS have any obligation to provide you with hard-copy documentation, upgrades,
enhancements, modifications, or telephone support for the Software.

6) TERMINATION

This Agreement is effective until terminated. Either party may terminate this Agreement upon written notice to the other party. FAS may also terminate this Agreement immediately, without prior notice or
liability, if you breach any of the terms or conditions of this Agreement. All sections of this Agreement which by their nature should survive termination will survive termination, including, without limitation,
warranty disclaimers and limitations of liability and limitations of use and transfer of the Software.

7) WARRANTY DISCLAIMER

The software is provided as is without warranty of any kind. FAS disclaim all warranties, expressed or implied, including but not limited to implied warranties, fitness for a particular purpose, and non-
infringement. Some states do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you.

8) LIMITATION OF LIABILITY

NOTWITHSTANDING ANYTHING CONTAINED IN THIS AGREEMENT OR OTHERWISE, YOU AGREE THAT FAS AND ITS LICENSORS WILL NOT BE LIABLE WITH RESPECT TO THE SUBJECT MATTER OF THIS
AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY, INFRINGEMENT OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY INCIDENTAL, CONSEQUENTIAL, EXEMPLARY OR PUNITIVE
DAMAGES OF ANY KIND. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE MAY NOT APPLY TO YOU.

9) EXPORT RESTRICTIONS

You acknowledge that the Software, or any part thereof, or any process or service that is the direct product of the Software (the foregoing collectively referred to as the “Restricted Components”) are of U.S.
origin. You agree to comply with all applicable international and national laws that apply to these products, including the U.S. Export Administration Regulations, as well as end-user, end-use and destination
restrictions issued by U.S. and other governments.

10) MISCELLANEOUS

The failure of either party to exercise in any respect any right provided for herein will not be deemed a waiver of any further rights hereunder of FAS and or its licensors. If any provision of this Agreement

is found to be unenforceable or invalid, that provision will be limited or eliminated to the minimum extent necessary so that this Agreement will otherwise remain in full force and effect and enforceable.

This Agreement will be governed by and construed in accordance with the laws of the state of New Hampshire without regard to the conflict of laws provisions thereof. You agree that this Agreement is the
complete and exclusive statement of the mutual understanding of the parties and supersedes and cancels all previous written and oral agreements, communications and other understandings relating to the
subject matter of this Agreement, and that all modifications to this EULA, or any commercial license that you may have obtained from FAS and or its licensors must be in a writing signed by you, FAS and or its
licensors, where applicable, except as otherwise provided herein. No agency, partnership, joint venture, or employment is created as a result of this Agreement and you do not have any authority of any kind to
bind FAS and or its licensors in any respect whatsoever. In any action or proceeding to enforce rights under this Agreement, the prevailing party will be entitled to recover costs and attorneys’ fees. All notices
under this Agreement will be in writing and will be deemed to have been duly given when received, if personally delivered; when receipt is electronically confirmed, if transmitted by facsimile or e-mail; the day
after it is sent, if sent for next day delivery by recognized overnight delivery service; and upon receipt, if sent by certified or registered mail, return receipt requested.
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